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About This Guide

Document Overview
This guide provides detailed instructions on configuring the 6510 UM server after
you have installed the software. Detailed information is provided on modifying the
PBX, creating a company, mailboxes, and feature groups. In addition, this
document also contains information on setting the different configuration
parameters.
Note: Some screen captures in this document may not reflect the Mitel Networks™
6510 UM software exactly. All screens will be updated in the next release of
the 6510 UM documentation.

Intended Audience
This guide is intended for anyone responsible for maintaining the 6510 UM server.

Before You Begin
Before you configure the 6510 UM system, make sure that you have read the Server
Installation Guide.
This guide provides detailed instructions on installing 6510 Unified Messaging (UM)
software.

Conventions
This guide contains three types of help:
Note: contains additional information about the task you are
performing.
Hint: contains an alternative method of performing the task or
offers a solution if you run into a problem.
Warning: contains critical information relating to the task.

10

6510 UM Server Configuration Guide

About This Guide

Contacting Mitel Networks
Contact us by mail at:
Mitel Networks Corporation
350 Legget Drive
Ottawa, ON K2K 2W7
Contact us by phone:
Tel: 613-592-2122
Fax: 613-592-4784
Contact us on the Web:
www.mitel.com
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CHAPTER 1

Introduction to Server Configuration

In This Chapter . . .
What is 6510 UM? on page 14
Before You Begin on page 14
Basic System Maintenance on page 14
Problem Reporting on page 15
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What is 6510 UM?
6510 UM is a voice processing system that functions with the existing telephone
system to enhance an organization's overall telecommunications environment.
6510 UM acts as a unified messaging solution offering call and voice messaging
control from the user's desktop PC. System Administrative functions may also be
performed either by using a touchtone telephone or the Windows interface from
the Voice Mail server.

Before You Begin
The Supervisor plays a key role in the everyday operation of the 6510 UM. It is
important that the Supervisor understands at least the basics of how 6510 UM
operates. The Supervisor should be familiar with all features available to users and
completely understand the User Guide before covering the material in this manual.

Basic System Maintenance
The Supervisor performs a key role in the operation of 6510 UM. The following are
some examples of the basic duties as a Supervisor:

• Add a new user to the 6510 UM system
• Record an audiotex announcement
• Generate reports showing basic system administration such as call
counts, port use, message counts

• Understand how to record the system greetings

Questions and Answers
The Supervisor is responsible for answering questions from users and having a
working knowledge of how the system operates. The Supervisor will also help new
or inexperienced users become accustomed to using the system. Answers can be
found in a variety of sources, including the following documentation:

• Server Installation Guide
• Server Configuration Guide
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• Client Application Installation Guide
• Client Application User Guide
• Phone User Guide

Problem Reporting
In the event that a user or caller reports a problem with the system, the Supervisor
and/or the vendor's technical personnel work to determine the cause of, and the
solution to the problem. The cause of a problem may be one or more of the
following:

• User error
• Insufficient training
• Incorrect system configuration
• Faulty hardware
• Faulty software
The Supervisor plays a central role in separating those issues that can be addressed
within the organization (for example, training or user error), and those issues that
need to be addressed by the vendor's technical personnel. A complete description
of the situation is vital in determining the problem and the solution. Information
should be gathered regarding when the situation occurred, who was involved
(caller and/or User), what occurred, and how the system was being used at the
time.

6510 UM Server Configuration Guide
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CHAPTER 2

Configuring the 6510 UM Server

In This Chapter . . .
Logging on to 6510 UM on page 18
Navigating the Administration Console on page 19
Using the Toolbar Buttons on page 25
Using the Scroll Buttons on page 27
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Logging on to 6510 UM
Before you can configure the system, you must log in. Make sure that you have a
valid user name and password.

To log on to 6510 UM:
1.

Click Start>Programs>Mitel Networks 6510 UM>6510Admin.

Note: You can also double-click the 6510Admin icon on the
desktop.
2.

The Login Information dialog appears.

3.

In the User Name field, enter your user name.

4.

In the Password field, enter your password.

Note: The default user name is Administrator.
The default password is 1111.
The password is not case sensitive.
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5.

From the UM Server Name (IP Address) drop-down list, enter the IP
address or the name of a remote computer that you want to access and
click OK. You may also click Browse to search for a remote computer.

6.

The Administration Console of the remote computer appears.
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Navigating the Administration Console
The Administrative Console allows you to configure, add, modify and delete
information on the PBX, Company, Mailboxes, Feature Groups, Call Routing Table,
Voice Menus and Customized Mailboxes. You can also specify the system
configuration settings for both the voice mail and optional applications such as
external add-on devices and maintenance utilities.

Viewing an Item’s Properties
Each component has one or more items associated with it. For example,
highlighting the Mailbox displays all mailboxes associated with that company. By
highlighting a mailbox and right-clicking the mouse, you can either delete an
individual mailbox or display its properties.

To view and delete properties:
1.

Highlight the component from the Administration Console.

2.

Highlight an item and right-click. The All Tasks drop menu appears.

3.

Click All Tasks. The following drop-down menu appears.
6510 UM Server Configuration Guide
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Using the Action Drop-down List
The Action drop-down list allows you to perform particular tasks based on where
you are in the program. For example, if you highlight the PBX and click Action, you
can perform various tasks, including displaying information about the PBX and
software, or creating a new company.

20
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You can also display this menu by selecting an option and clicking the right mouse
button.
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Modifying Columns
You can change how 6510 UM displays information on the screen.

To change the display:
1.

In the 6510 Admin, right-click 6510 Unified Messaging, select
View>Choose Columns. The Modify Columns dialog appears.

2.

To hide a displayed pane, highlight it in the Displayed panes and click
Remove.

Note: You cannot remove the PBX Number column.
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3.

To display a hidden pane, highlight it in the Hidden panes and click Add.

4.

To change the order of the columns, highlight the column and click
Move Up or Move Down.

5.

To cancel all of your changes, click Reset.
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Selecting a Language
6510 UM allows you to change the language of the information displayed on the
Administration Console.
Note:

The 6510 UM Administrator supports English and Spanish.

To change the language:
1.

Click Language. The Language drop-down menu appears.

2.

Select a language. The system changes the Administration Console to the
language you have selected.

Displaying Contact Information
You can display the 6510 UM version information by highlighting the PBX and
clicking Action>About.
The screen also displays the contact information that you enter in the Dealer Info
section. For more information, refer to Appendix C – Configuration Settings.

6510 UM Server Configuration Guide
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Connecting to a Remote Server
The 6510 Unified Messaging system allows you to connect to a remote server from
within the system itself. This is useful if you want to connect to a remote system
from within your voicemail system.

To connect to a remote server:
1.

In the 6510 Admin, right-click 6510 Unified Messaging and select
Connect to. The Connect dialog appears.

2.

From the UM Server Name (IP Address) drop-down list, enter the IP
address or the name of a remote computer you want to access and click
OK.

Exporting the List
This function is part of the Microsoft Management Console. For more information,
refer to the product documentation.

Refreshing the Display
At any time during your 6510 Administration session, you can refresh your screen
to display the most updated settings.
1.

24

In the 6510 Admin, click Action>Refresh. The screen refreshes to show
the most updated settings.
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Changing the Display
You can change the screen display for any 6510 UM component from two panes
(the default setting) to one pane.
Note: The Administration Console defaults to a two pane display.

To change the display
1.

Highlight a component.

2.

Click Show/Hide Console Tree/Favorites button. 6510 UM displays
information about the component in a single pane.

Using the Toolbar Buttons
There are 15 buttons that allow you to perform various tasks within the
Administration Console.
Button

Name

Function

Backward

Move backwards through the
components that you have used

Forward

Move forward through the
components that you have used

Up One Level

Up the tree by one level

Show/Hide Console Tree/
Favorites

Changes the display from two panes
(the default setting) to one pane.

Refresh

Refreshes the display

Export List

This function is part of the Microsoft
Management Console. For more
information, refer to the product
documentation.

Help

Displays the Administrator help
contents.

Add New Mailbox

Adds a new mailbox

6510 UM Server Configuration Guide
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Add New Feature
Group

Adds a new Feature Group

Add New AMIS

Adds a new remote site

Add New Voice Menu

Adds a new Voice Menu

Add New Customize
Mailbox

Adds a new customized mailbox

Open

Opens a Mailbox, feature Group,
Remote Site, Routing Table, Voice
Menu, or Customize Mailbox

Delete

Deletes a Mailbox, Feature Group,
Voice Menu, Remote Site, and
Customized Mailbox.

Add Range

Creates a range of mailboxes

6510 UM Server Configuration Guide
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Using the Scroll Buttons
Scroll buttons are used throughout 6510 UM to scroll through existing records.
Clicking a scroll button selects the record and makes it current.
Scroll buttons can be found in the Company, Mailbox, Feature Group, Remote Site,
Routing Table, Voice Menu, and Customize Mailbox components.

Button

Name

Function

First Record

Scrolls to the first record

Previous Record

Scrolls to the previous record

Next Record

Scrolls to the next record

Last Record

Scrolls to the last record

6510 UM Server Configuration Guide
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CHAPTER 3

Maintaining the Configuration Files

In This Chapter . . .
Overview on page 30
Advanced Settings Configuration on page 32
Custom Interface Settings on page 35
Dealer Info Configuration on page 36
Device Management Configuration on page 38
Fax Settings Configuration on page 51
Global Parameters Configuration on page 54
Log Settings Configuration on page 57
SMTP Settings Configuration on page 58
MSS Settings Configuration on page 59
Remote Site Settings Configuration on page 60
Reorg Settings Configuration on page 62
User Manager Settings Configuration on page 63
Voice Board Settings Configuration on page 65
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Overview
Configuration tables contain system configuration settings for optional applications
such as speech, fax, e-mail configuration, external add-on devices, maintenance &
unified messaging.
After the software has been installed, the configuration will display the
configuration settings. You can then modify or fine-tune these default settings.

Maintaining Configuration Settings
The 6510 UM Administrator has 12 types of configuration settings.
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Configuration

Function

Advanced

Specifies advance settings such as fine tune board settings,
turning logs on or off for debugging, speech configuration,
date format, path for the system, and other options activation.

Custom Interface
Settings

Allows the configuration of custom interface settings, enabling
the integration of a third party database.

Dealer Info

Specifies the installing dealer information.

Device
Management

Third party devices connect to the COM port such as Caller ID
boxes, SMDI, LAP, or CTI devices.

Device
Management
Settings

Allows you to configure device settings that are added.

Fax Settings

Specifies fax on demand and fax mail settings

Global

Specifies the Global Parameters settings.

Log

Specifies report logging on all the system components

SMTP

Allows the configuration of the Simple Mail Transfer Protocol
settings.

MSS

Allows the configuration of your voicemail system for MSS
support.

Remote Site
Setting

Specified both AMIS & VPIM settings

Reorg

Allows the specifying of the time when the reorg function is to
run.
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User Manager

Allows the administrator to add and edit user settings including
access rights to the system.

Voice Board
Settings

Allows the configuration of compression formats of the
telephone system and voice board types that are used by the
system.
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Advanced Settings Configuration
The Advanced settings allow you fine-tune your 6510 UM system. Available settings
include board settings, enabling logs on or off for debugging, speech, and other
specific and detailed options.
Note: In order for the changes made to the advanced settings to
take effect, it is required that you stop and restart the 6510
UM service.

To configure advanced settings:
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1.

In the 6510 Admin Tree, click Configuration>Advanced. The Advanced
settings appear in the right window.

2.

For information on configuring these settings, refer to the table below.
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Setting

Function

Alternate Pound

Alternate DTMF tone for #. Used for phone
systems that reserve the key for other
functions

Alternate Star

Alternate DTMF tone for *. Used for phone
systems that reserve the key for other
functions

Date Format

Defines the playback format of the date
format for messages

Days to Keep Report Logs

Enter the number days the system is to keep
report logs in the database.

Debug Level

Sets the level of information sent to a log file
when Debug mode is activated.

Debug Mode

Defines the type of debug mode to be used
EVENT writes to the EVENT.LOG file
DEBUG writes to the Status screen
NOTIFY writes all outcall activity (message
lights, beeper, outcall) to OUTCALL.LOG

Disable Fax Detection

Prevents the voice board from recognizing
the fax tone

Disable Fax Detection 1

Value is a frequency. Used for
troubleshooting

Disable Fax Detection 2

Value is a frequency. Used for
troubleshooting

Extension Length

Determines the extension length

Fixed Extension

Determines if the extension length is fixed

Function Time Out

Maximum time for a function to wait

Log Lan Activity

Determines to log all LAN activity

Log Mailbox Activity

Determines to log all mailbox activity

Log Mass Recall

Logs activities of mass recall

Log Queue Activity

Logs the call queuing activities

Log Record Termination

Logs the record termination event when the
recording a conversation function is in use

Log Speech Engine

Logs all activity of the speech engine

6510 UM Server Configuration Guide
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Log System Statistics

Logs all activity of the voice mail system

Log Wakeup Calls

Logs all wakeup calls

Logo URL

Allows you to choose the logo URL

Loop Current on In Dial

Indicates whether or not to disable loop
detection during dialing

Loop Current On In Record

Indicates whether or not to disable loop
current detection during recording

Mass Recall Installed

Determines if mass recall is installed

Messages Temp. Folder

Allows you to specify a different path for
receiving messages

Path for System

Allows you determine the path of the system

Print Wakeup Calls

Allows you enable the printing of wakeup
call activity

Proxy IP Address

Allows you to declare the proxy address

Queue Debug Mode

Defines whether or not to queue the debug
mode

Queue Mode

Defines whether or not to queue the mode.

Record with AGC

Indicates whether or not to use Automatic
Gain Control during recording

Status Log Level

Determines the level of the log information
(the higher the level, the more detailed the
log)

Trace Log Level

Determines the level of information to be
recorded in logs

Transfer Timeout

WITH TAPI – This value indicates the amount
of time the system will wait after dialing an
outside call over an analog CO line before
playing the prompt.
WITH ANALOG VOICE BOARDS – if no
connect or busy signal is received by the end
of the timer, the system will assume a not
busy state and release the call

34

Trim Digit

Enables the elimination of unnecessary digits
at the beginning of a string

Trim From End of File

Enables the elimination of digits from the
end of a file

TTS Mode

Allows you to choose the application to be
used for TTS
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Use Mailbox Language as Default

Indicates whether or not to use the mailbox’s
defined language as the system language
when a caller returns to the automated
attendant from the mailbox

Use Port Monitor

Indicates whether or not the system will
return a port to idle mode after a fixed time
period

Web Site URL

Allows you to declare your web site URL

Custom Interface Settings
The Custom Interface settings allow you to specify the configurations that deal with
integrating a third party databse into the 6510 UM.

To configure Custom Interface parameters:
1.

In the 6510 Admin Tree, click Configuration>Custom Interface
Settings. The Custom Interface Settings parameters appear in the right
window.
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2.

For information on configuring these settings, refer to the table below:

Setting

Function

Database Object Name

Enter value of 1 or 2.

Forced Popup From
Database

Select True to enable the forcing of pop ups from
the database. Select False to disable this
parameter.

Get Destination From
Database

Select True to enable the retrieving of the folder
destination from the database. Select False to
disable this parameter.

On Max Errors

Select Hang Up to instruct the system to
disconnect from the third party database in
situations where too many errors occur. Select
Operator switch to the operator in situations
where too many errors occur.

Dealer Info Configuration
The Dealer Information settings allow you to specify the information of the dealer
who has installed 6510 UM.

To configure dealer info:
1.

36

In the 6510 Admin Tree, click Configuration>Dealer Info. The dealer
information settings appear in the right window.
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2.

For information on configuring these settings, refer to the table below.

Setting

Function

Contact Name

Shows the dealer representative contact name

Dealer Email

Shows the dealer contact e-mail address

Dealer Fax

Shows the dealer contact fax number

Dealer Name

Shows the dealer company name

Dealer Website

Shows the dealer company website

Technical Support
Number

Shows the dealer technical support phone number

6510 UM Server Configuration Guide
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Device Management Configuration
Unlike other configuration settings, Device Management is made up of devices and
settings. You can add a Serial Integration Device, CTI Serial Integration Device, Local
Area Paging Device, and a Caller ID Device. After you add devices, you can
configure its settings, such as CTI Settings, Serial Integration Setting, or Caller ID
settings. This allows you to manage the settings and integration with these specific
devices that communicate to the application over a COM port.

To open Device Management settings:
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1.

In the 6510 Admin Tree, click Configuration>Device Management.
The Device Management (Device) settings appear in the right window.

2.

Follow the steps below to configure each device type.
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Specifying Local Area Paging
Local Area Paging is a module that allows you to use the pager function that will
notify you when a call or message is received. In the Local Area Device tab, you can
specify the settings associated to your paging device.
Note: The device settings must match the hardware settings of your
pager.

To specify a local area paging parameter:
1.

In the 6510 Admin Tree, expand Configuration, right-click Device
Management and select New>Local Area Paging. The Local Area
Paging dialog appears.

Note: You can also click Action>New>Local Area Paging.

2.

From the COM Port Number drop-down list, select the port that the
device is connected to.

3.

From the Baud Rate drop-down list, select the baud rate of the device.
The default is 9600.

4.

From the Parity drop-down list, select the appropriate device setting. The
default is None.

6510 UM Server Configuration Guide
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5.

From the Data Bits drop-down list, select the bit configuration of the
device. The default is 8.

6.

From the Stop Bits drop-down list, select the device settings for stop bit.
The default is 1.

7.

From the Padding drop-down list, select any padding that may be
needed for connecting. The default is None.

8.

In the Carrier Detect field, enter the control signal indicating that the
modem is detecting a "live" carrier.

9.

In the Clear to Send field, enter the time to wait.

10.

In the Data Set Ready field, enter the delay time.

11.

In the Request to Send field, enter the time to wait for the request.

12.

In the Validation Time field, enter the period of time to wait for
validation.

13.

Select Integration With LAP to select this if it is a local area paging
device you are integrating to.

14.

Click OK.

Specifying Serial Integration Device
The Serial Integration device and settings specify the settings for a Serial integration
to a PBX. Most setups are defined as Telco standard SMDI, or a proprietary switch
standard like NEC’s MCI.

To specify a serial integration device:
1.

In the 6510 Admin Tree, expand Configuration right-click Device
Management and click New>Serial Integration Device. The Device
dialog appears.

Hint: You can also click Action >New>Serial Integration.
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2.

In the Switch Data Packet Length field, enter the max digit length of
the packets being sent through.

3.

From the Protocol drop-down list, select the type of serial integration
standard it is sending (SMDI, MCI or User Defined).

4.

From the Hand Shaking drop-down list, select the protocol to use to
precede the telephone connection.

5.

Click Settings to define the SMDI properties. The SMDI Settings dialog
appears.

Note: Defining the SMDI settings being sent by the switch enables
you to define serial integration on the fly to further enhance
the PBX integration.

6510 UM Server Configuration Guide
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6.

Setting

Purpose

SMDI Always No Answer

Treats all busy no answer conditions as
no answer

Use Message Desk as C.O. Line
Number

Used for multi-tenanting configuration*
message desk configuration must be
programmed on the phone system

Use Short Mailbox No as C.O.
Line Number

Used for multi-tenanting purposes.

SMDI Debug Mode

Reports the log of all the SMDI events

Use Office Codes

Used for Central office integration in a
centralized voice mail setup

7.
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Select one or more of the following options:

Note: This option must be programmed
on the phone system

In the Number of Digits in SMDI field, enter the maximum number of
digits in a SMDI string for the calling and called parties. The standard
setting is 7 or 10 digits.
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8.

Click OK.

Note: After configuring the settings, you can always return to
reconfigure them by double-clicking the device in the Device
Management window.

Specifying the Caller ID Device
The Caller ID Device indicates the specifications of the Caller ID Device you are
using.

To specify a caller ID device:
1.

In the 6510 Admin Tree, expand Configuration, right-click Device
Management and select New>Caller ID Device. The caller ID Device
dialog appears.

Hint: You can also click Action > New > Caller ID Device.

2.

In the No of C.O. Lines field, enter the number of CO lines the device is
monitoring.

3.

From the Protocol drop-down list, select the type of caller ID device that
will be used to track and send caller ID. (Rochelle, Zeus, TCI).

4.

Click Settings to fine-tune the caller ID device settings. The Caller ID
Settings dialog appears.
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Note: The Caller ID Settings allows you to custom define and finetune the settings for monitoring and sending caller ID
information within the system.

5.

Caller ID Setting

Function

Caller ID Installed

A third party device installed for passing
caller ID.

Ask for Phone Number when No
Caller ID

Prompts the caller for a number when
device fails to detect one.

Keep Caller ID in Forwarded
Messages

When forwarding a message, maintain and
attach original caller ID information with
the message.

Play Caller ID if PlayDate Active

Time and date stamp is requested and also
plays back the caller ID information.

Pop CTI Events Only

Only perform screen popups on events
driven by the CTI Link.

Use PIN Number as Caller ID

Treat PIN number inputs as caller ID
information.

Fake Caller ID

Define a fake number to use on all calls.

6.
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Select the settings you want activated or fine-tuned.

In the Caller ID Type field, enter the type of device connected for
tracking caller id such as Rochelle, Zeus or TCI.
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7.

In the Caller ID Mode field, enter the mode in which the system receives
the caller ID information, such as inband, SMDI, or CTILink.

8.

In the Caller ID Length field, enter the maximum digits that can be sent
for caller ID packets.

9.

In the Pad Short Caller ID with field, enter any prefixes such as area
code when only 7 digits are sent. It will pad the number to ensure a
proper lookup in a database.

10.

In the Max Items in Caller ID List field, indicate the max list view for the
system administration.

11.

In the Fake Caller ID Name field, define a name that you want to
appear on the screen pops.

12.

In the Fake Caller ID Number, enter the number you want to appear on
the caller ID screen pops and messages.

13.

Click OK.

Note: After configuring the settings, you can always return to
reconfigure them by double-clicking the device in the Device
Management window.
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Specifying CTI Serial Integration
The CTI Serial Integration allows you to define the type of CTI integration for CSTA
integration that you are receiving through a serial link.

To specify CTI Serial Integration;
1.

In the 6510 Admin Tree, expand Configuration, right-click Device
Management and select New>CTI Serial Integration Device. The CTI
Serial Integration dialog appears.

2.

For information on filling out the fields, refer to Specifying Local Area
Paging on page 39.

3.

Click Settings. The CTI Settings dialog appears.

Note: The CTI Integration settings allow you to fine-tune the
information you will be receiving via the CTI link data.
4.
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Perform the following steps to configure CTI settings:
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• Select CTI Installed to indicate that a CTI link from the PBX is active
and available for monitoring.

• Select CTI Debug Mode to monitor and log the CTI events.
• Select CTI Debug File to enable the creation of a debug file from CTI
event monitoring.

• Select CTI Object Debug to enable object debug.
• Select Pop Caller ID When Event to enable the activation of screen
popups on station-to-station and internal dialing.

• Select CTI Message Lights to use the CTI serial link to light the message lights.

• In the CTI Message Light Button field, enter the numeric digit on the
phone keypad that will enable the message light option. This is an
optional setting for lighting lights through the link.

• In the CTI Message Light Ports field, indicate the ports on the switch
where the lights are located.

• In the CTI Mode field, enter the type of CTI events that the system is
to look for (for example, Iwatsu).
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• In the CTI Server Name field, enter the server machine or phone system on the network that will be sending the CTI events.

• In the CTI Version field, enter the version description of the CSTA or
CTI link on the switch.

• In the CTI VM Group field, enter the VM ports that are to be monitored for events.

• In the CTI First Trunk field, enter the first VM port to monitor.
• In the Paging Zone from field, enter the From port used for paging
that the system should ignore events for screen pops.

• In the Paging Zone to field, enter the To port used for paging that the
system should ignore events for screen pops.

• In the PAD Extension with field, enter the numerical digit that will
pad the unused number spaces in the screen pop up when you receive
an incoming call that contains a string of digits less than the maximum
that is specified.
5.
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Click OK.
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Specifying TCP/IP Integration
The TCP/IP Integration allows you to specify CTILINK or CSTA integration over TCP/
IP.

To specify TCP/IP Integration Device:
1.

In the 6510 Admin Tree, expand Configuration, right-click Device
Management and select New>CTI TCP/IP Integration Device. The
Device dialog appears.

2.

In the TCP/IP Address field, enter the IP address of the phone system
that the CTI data is coming from.

3.

In the TCP/IP Port field, enter the IP port the system will use to access
the CTI Link.

4.

Click Settings. The CTI Settings dialog appears.

• Select CTI Installed to indicate that a CTI link from the PBX is active
and available for monitoring.

• Select CTI Debug Mode to monitor and log the CTI events.
• Select CTI Debug File to enable the creation of a debug file from CTI
event monitoring.

• Select CTI Object Debug to enable object debug.
• Select Pop Caller ID When Event to enable the activation of screen
popups on station-to-station and internal dialing.

• Select CTI Message Lights to use the CTI serial link to light the message lights.
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• In the CTI Message Light Button field, enter the numeric digit on the
phone keypad that will enable the message light option. This is an
optional setting for lighting lights through the link.

• In the CTI Message Light Ports field, indicate the ports on the switch
where the lights are located.

• In the CTI Mode field, enter the type of CTI events that the system is
to look for (for example, Iwatsu).

• In the CTI Server Name field, enter the server machine or phone system on the network that will be sending the CTI events.

• In the CTI Version field, enter the version description of the CSTA or
CTI link on the switch.

• In the CTI VM Group field, enter the VM ports that are to be monitored for events.

• In the CTI First Trunk field, enter the first VM port to monitor.
• In the Paging Zone from field, enter the From port used for paging
that the system should ignore events for screen pops.

• In the Paging Zone to field, enter the To port used for paging that the
system should ignore events for screen pops.

• In the PAD Extension with field, enter the numerical digit that will
pad the unused number spaces in the screen pop up when you receive
an incoming call that contains a string of digits less than the maximum
that is specified.
5.

Click OK.

Device Management Settings
Device Management Settings allow you to configure the settings of the devices that
are available. Refer to Device Management Configuration on page 38 for details on
configuring device settings.
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Fax Settings Configuration
Fax Settings allow you to specify the information required for a user to be able to
receive a fax into the Auto Attendant. Fax On Demand can be used to forward the
fax to an appropriate mailbox or location.

To configure fax settings:
1.

In the 6510 Admin Tree, click Configuration>Fax Settings. The Fax
Settings appear in the right window.

2.

For information on configuring the settings, see the table below.

Setting

Function

Allow Printing of Faxes

Indicates whether or not users can print received
faxes via the telephone.
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Ask for Extension Number

Indicates whether or not to ask the caller for an
extension number to put on the received faxes
when using the fax on demand module.

Default Fax Mailbox

Defines the mailbox that incoming faxes will be
delivered to if no destination is given.

Default Fax Number

Defines the default number to dial to print received
faxes.

Dialing Suffix

The long distance account code required in order to
make toll calls from the Phone system. This will
apply if the default fax number is an external toll
call.

Fax Board Type

Identifies the fax board that is integrated with the
system.

Fax Busy Timer

Indicates the number of seconds to wait after
initiating a transfer to the fax port before reverting
back to an idle state.

Fax Directory

Specifies the path for the directory that contains the
fax documents.

Fax Inband

Not used in this version.

Fax Mail Installed

Indicates whether the Fax mail option is enabled for
receiving faxes.

Fax On Demand

Indicates if the Fax on Demand option is enabled.

Fax Resolution

Sets the resolution type for fax transmissions.

File and Path for Fax Viewer

The path to the directory containing the fax viewer
application.

Local and Toll Area Code 1

The area code(s) in your region that covers both
local and toll calls

Local and Toll Area Code 2

The area code(s) in your region that covers local digit
calls.
Note: Code Number 1 for both entries is for 7-digit
dialing. Code Number 2 and higher is for 10-digit
dialing.

Local Area Code 1
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The first local Area Code for the country.

Local Area Code 2

The second local Area Code for the country.

Local Area Code 3

The third local Area Code for the country.

Log Fax Activity

Indicates to create a log file for all fax activity

No of Digits in Area Code

Indicates how many digits to view from the entered
number as the Area Code.
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No of Digits in Phone No

Indicates how many digits to view from the entered
number as the Phone Number.

Number of Log Entries to delete

Sets the housekeeping rules for deleting old fax log
entries starting from the oldest record.

Outside Line Access

This sets the code for line access to out dial a fax-ondemand call.

Path for Fax Drivers

Indicates the path to the directory that stores the fax
drivers.

System CSID

Specifies the fax header information.

Toll Line Access Code

Defines the code for Alternate Carrier Access
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Global Parameters Configuration
Global parameters allow for the configuration of specific boards and pulse
detection.

To configure global parameters:
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1.

In the 6510 Admin Tree, click Configuration>Global. The Global
parameters appear in the right window.

2.

For information on configuring the settings, see the table below.

Setting

Function

Digitization Rate

The value used for digitization

Flash Character

Character used in a dial string to indicate a hook flash to
occur

Flash Duration

The value of the duration of the hook flash in 10msec
intervals
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Loop Current Time

The value of the minimum time that loop current must be
off before Loop Current CST can be generated in 10msec
intervals

Offhook Delay

The value for the offhook delay time in 10msec intervals

Pause Duration

The value of the length of a pause used in a dialing string
in 10msec intervals

Pulse Break Interval

The value of the break interval for pulse dialing in 10msec
increments

Pulse Inter Digit Delay

The value of the inter-digit interval for pulse dialing in
10msec increments

Pulse Make Interval

The value of the make interval for pulse dialing in 10msec
increments

Pulse Maximum Make

The value of the maximum make pulse time for pulse
dialing in 10msec increments

Pulse Minimum Break

The value of the minimum break interval for valid loop
pulse dialing in 10msec increments

Pulse Minimum Inter-digit

The value of the minimum inter-digit interval for pulse
dialing in 10msec increments

Pulse Minimum make

The value of the minimum make interval for pulse dialing in
10msec increments

Record Tone Edge

The value for the Record DTMF filter time in 10msec
increments

Record Tone length

Indicates the event edge to use for record tone
1=event detection on trailing edge of tone
2=event detection on leading edge of tone

Ring delay

The value of the wait delay after which the ring count is
reset in 100msec increments

Ring Off

The value of the minimum Ring Off interval to detect an
incoming ring in 100msec increments

Ring On

The value of the minimum Ring On interval to detect an
incoming ring in 100msec increments

Scheduler Time

The value of the Scheduler Time Slice, expressed as the
maximum number of timer ticks (expressed in 1/20 sec),
before the driver must return control to the program in
50msec increments

Silence Debounce

The value of the Silence message debounce interval in
10msec increments.
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Tone Duration

The value of the duration of dialed DTMF tones in 10msec
increments

Tone Inter-Digit Delay

The value of the inter-digit tone dialing delay in 10msec
increments.
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Log Settings Configuration
Log settings allow you to specify report logging on all system components.

To configure log settings:
1.

In the 6510 Admin Tree, click Configuration>Log. The Log settings
appear in the right window.

2.

For information on configuring these settings, see the table below.

Settings

Function

Log MSS

This will create a log file for the Message
Synchronization Service

Log System Statistics

This will create a log file for all system statistics

Days to Keep Report Logs

Defines the number of days log files will be stored

Log Queue Activity

This will create a log file for all Queue activity
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Log Lan Activity

This will create a log file for all LAN activity

Trace Log Level

This indicates the level of activity of the logs
created

Status Log Level

This indicates the status of logs created

Log Wakeup Calls

This will create a log file for all Wakeup Call activity

Log Mailbox Activity

This will create a log file for all Mailbox activity

Log Record Termination

This will create a log file for all Record termination
activity

Admin Log Level

This will create a log file for all Admin activity

Business Object Log Level

This will create a log file for all EE Application
Manager activity

UMST Log Level

This will create a log file for all UMST activity

Log Fax Activity

Logs all fax activity

Log Message Lights

Logs all Message Light activity

Log SMDI

Logs all SMDI activity

SMTP Settings Configuration
SMTP settings allow you to specify settings related to the Simple Mail Transfer
Protocol connection. SMTP settings can be defined using the VPIM Tools
application. Refer to VPIM Tools Overview on page 328 for more information.
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MSS Settings Configuration
Message Synchronization Servive (MSS) allows you to synchronize all of your
messaging servers with the 6510 UM. The MSS settings allow you to configure the
voicemail system for MSS support.

To configure MSS settings:
1.

In the 6510 Admin Tree, click Configuration>MSS. The MSS settings
appear in the right window.

2.

For information on configuring these settings, see the table below.

Setting

Function

Log MSS

This will create a log file for the Message
Synchronization Service.
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MSS Client Name

Sets the MSS client name.
Note: This name must be entered without any
spaces in it.

MSS Log Level

Sets the level of MSS logs to be created.

MSS Server Name

Sets the MSS server name.

Use MSS

Enables the use of MSS.

Remote Site Settings Configuration
Remote Site settings allow you to specify both AMIS and VPIM settings.

To configure remote site settings:
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1.

In the 6510 Admin Tree, click Configuration>Remote Site Setting. The
Remote Site settings appear in the right window.

2.

For information on how to configure these settings, see the table below.
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Setting

Function

AMIS Initial delay

The value of the delay, in seconds, that the system
will use to ignore the C tone sent by AMIS. This is
required only if there is a C tone sent via the
Inband signaling from the PBX. Set to zero if no
delay is needed.

Remote Site Installed

Indicates whether Remote Networking is installed.
Required for AMIS or VPIM.
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Reorg Settings Configuration
Reorg settings allow you to specify the rules to run and activate the Reorg function
that cleans and compacts the database.

To configure reorg settings:
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1.

In the 6510 Admin Tree, click Configuration>Reorg. The Reorg settings
appear in the right window.

2.

For information on configuring these settings, see the table below.

Setting

Function

Backup Files Before Reorg

Indicates whether or not to back up the database files
before initiating the reorg
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Batch Files to Run at Reorg
Time

Defines a batch file, if required, to initiate before the
reorg is performed. (i.e. network or tape drive backup)

Reorg Time

Sets the time of day (24 hour military) to initiate the
reorg function. Select the Disable Reorg checkbox to
disable the reorg function

User Manager Settings Configuration
The User Manager configuration setting allows you to specify one or more
Administrators and the system properties that they can control. The Administrators
can have control over the entire 6510 UM system, ranging from selected functions
(for example, Edit PBX) to Full Access.

To configure user manager settings:
1.

In the 6510 UM Admin Tree, click Configuration>User Manager. The
list of users appears in the right window.

2.

Right-click User Manager and select New>User Manager to add a
new user or right-click an existing user and select All Tasks>Properties.
The User Properties dialog appears.

• In the User Name field, enter the name of the administrator.
• In the Full Name field, enter the administrator’s full name.
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• In the Description field, enter the title or purpose of this administrator.
• In the Password field, create a password.
• In the Confirm Password field, re-enter the password.
• From the Language drop-down list, select the language preference for
this administrator.

• From the Related Company drop-down list, select the companies this
administrator has administrative rights over.

• Select the Account Disabled checkbox to disable the account.
3.

Click the following checkboxes to indicate what tasks the administrator
can perform.

Task

Function

Full Access

Allows a user full access to the system.

Edit System Configuration

Allows the administrator to edit system
configuration files.

Edit PBX

Allows the administrator to edit the PBX.

Add/Edit/Delete Company,
Feature Group, Remote Site,
Routing Table, Voice Menu,
Customized Mailbox

Allows the administrator to add, edit, and delete
a company, feature group, remote site, and
routing table, voice menu, customized mailbox

Create Range of Mailboxes

Allows the administrator to create a range of
mailboxes.

Create/Edit/Delete Mailbox

Allows the administrator to create, edit, and
delete a mailbox.

Log Management

Allows the administrator to set and define logs.

Backup Management

Allows the administrator to perform and define
backup management.

Report Management

Allows the administrator to define and create
reports and run the Web Reporter utility.

4.

.

Click OK.

Note: You must be logged in as an administrator to be able to edit
and delete user manager settings.
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Voice Board Settings Configuration
Voice Board settings allow you to specify the technical settings that dictate the
functionality of the voice boards.

To configure voice board settings:
1.

In the 6510 Admin Tree, click Configuration>Voice Board Settings.
The Voice Board settings appear in the right window.

2.

For information on configuring these settings, see the table below.

Setting

Function

Accucall External
filename

Indicates the external filename used.

Accucall File Name

Indicates the accucall filename used.

Accucall Internal
filename

Indicates the internal filename used.
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Accucall other filename

Indicates the other filename used.

Norstar 7310 Dialing

Allows for out dialing to be performed on the virtual set
dial pad rather than via the voice boards (Dialogic)

Norstar Busy Timeout

Used to set timer for Busy Transfer

Number of Channels

Indicates the total number of voice channels installed

Number of Digits in
Message Count for
Display

This value sets the number of digits used to send to a
display pager or a supported display PBX telephone
indicating the number of the message sending the
notification

Phrase Format

Indicates the format of the system prompts used by the
system if to be different than the VOX format.

Pulse Detection Enabled

Indicates whether or not to use pulse detection. Requires
the correct hardware.

Refresh Ports Interval

Indicates the time interval between generating an
offhook/onhook sequence on each port. Used to keep
ports listed as active in certain PBXs.

Silence Truncation

Removes silence from recordings. (used for Rhetorex
only)

Telephone System Name Indicates the make of the telephone system
Voice Board Type

Indicates the type of voiceboard used (Rhetorex,
Rhetorex Direct, Dialogic, TAPI, Aculab)

VOX Format

Indicates the format of all recordings in the system (for
example, WAV)

3.
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Double-click on the parameter you want to configure. The Edit String
dialog appears.
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4.

The Value Name field displays the parameter you are configuring. In the
Value Data drop-down list select True to enable the setting or select
False to disable the setting.

5.

Click OK. The setting is configured.
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CHAPTER 4

Maintaining a PBX

In This Chapter . . .
Overview on page 70
Using the Toolbar Buttons on page 70
Modifying the PBX on page 72
Specifying Area Code Rules on page 104
Deleting a PBX on page 107
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Overview
When you configure the 6510 UM for the first time, it is pre-configured for the
6510 UM phone system. If you are configuring the UM for another phone system,
you must first run the configuration wizard to select the manufacturer and model of
the company’s phone system. This integrates 6510 UM to the current switching
device. Once the setup is complete, you can go back and modify the existing PBX
settings.
Note: You must have Dialogic or Brooktrout boards installed prior
to connecting to a PBX other than the 6510 UM. For more
information, refer to the Server Installation Guide.
Make sure that you have completed the configuration section before modifying the
PBX.

Using the Toolbar Buttons
There are three buttons that allow you to perform various tasks within the PBX
application.
Button

Name

Function

Save PBX

Saves the revised details of the PBX.

Refresh PBX

Refreshes the screen.

PBX Templates

Uses information from another PBX
configuration.
Note: When you choose another PBX, 6510
UM pastes this information to the appropriate
tab. For more information, refer to Appendix D
- PBX Template.

Add New PBX
Template
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Allows you to specify new PBX configuration.
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To Add a New PBX Template
You can add a new PBX configuration so that it can be readily used as a template.

To add a new PBX template:
1.

In the PBX dialog, click the Add New PBX Template button. The New PBX
Template dialog appears.

2.

Select Add New Model to Manufacturer and select the manufacturer
in the drop-down list. (Only if you want to add a new model to an
existing manufacturer).
Or

3.

Select Add New Manufacturer.

4.

Click OK. The PBX General tab appears.

5.

In the Manufacturer field, enter the new manufacturer you want to
add.

Note: If Add New Model to Manufacturer was selected, then this
field is automatically populated.
6.

In the Model field, enter the new model.

7.

In the Version field, enter the model version.

8.

fixed length.

9.

In the PBX Extension Max Length field, enter the length of the
extension. If you have decided that the length of the PBX Extension is to
be a fixed, the number that you enter specifies that all extensions must
be that length.
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Note: The default settings for the 6510 UM switch are configured to
have the Fixed Length checked off with an Extension length
of 3.
10.

If you have not selected the PBX Extension Length Fixed field, the
number that you enter into this field determines the variable length of
the PBX extensions. For example, if you enter 5, the PBX extension can be
from one to five numbers in length.

11.

Click Save PBX.

Modifying the PBX
6510 UM allows you to modify the existing PBX settings.

To modify the PBX:
1.
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In the Tree, click the PBX so that it becomes highlighted, right-click and
select Properties. The PBX General dialog appears.
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Specifying General Options
The General Options dialog allows you to change the Manufacturer, Model, and
Version of your PBX.

To specify general options:
1.

Click the PBX Templates button to change the Manufacturer, Model,
and Version of the PBX in use. The PBX Templates dialog appears.

2.

From the Manufacturer drop-down list, select the manufacturer of your
PBX.

3.

From the Model & Version drop-down list, select the model and version
of the PBX that you are using and click OK. The Warning dialog appears.

4.

Click OK. The General dialog displays the information that you selected.

5.

Select PBX Extension Length Fixed if you want the extension to be a
fixed length.

6.

In the PBX Extension Max Length field, enter the length of the
extension. If you have decided that the length of the PBX Extension is to
be a fixed, the number that you enter specifies that all extensions must
be that length.

Note: The default settings for the 6510 UM switch are configured to
have the Fixed Length checked off with an Extension length
of 3.
7.

If you have not selected the PBX Extension Length Fixed field, the
number that you enter into this field determines the variable length of
the PBX extensions. For example, if you enter 5, the PBX extension can be
from one to five numbers in length.

8.

Click Save PBX.
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Specifying the Channel Parameters
When you install 6510 UM, the system automatically preloads the required settings
if you are using a voice board other than what is recommended by Mitel Networks.
Channel Parameters allow you to change one or more of these predetermined
settings.
You can also configure the 6510 voice mail to integrate with other PBX systems.
Note: The system supports both Dialogic and Brooktrout voice
boards.

Setting Dialogic Channel Parameters
When you install 6510 UM with a Dialogic voice board, the system automatically
preloads the required settings. The Dialogic dialog allows you to change one or
more of these preinstalled parameters.

To change a channel parameter:
1.

74

Click Channel Parameters. The Dialogic dialog appears.
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2.

Select Internal, External, or Other to indicate the source of the call and
the strength of the signal.

3.

Change one or more of the displayed fields.

6510 UM Server Configuration Guide

75

Maintaining a PBX

Field

Function

Start Delay

The delay after dialing has been completed and
before starting analysis for Cadence Detection,
Frequency Detection, and Positive Voice Detection
in 10 msec increments.
The default is 250.

Continuous No Signal

The maximum time of silence (no signal) allowed
immediately after Cadence Detection begins. If
exceeded, a no ringback is returned in 10 msec
increments.
The default is 40000.

Loop Current Delay

The delay after dialing has been completed and
before beginning Loop Current Detection. A value
of –1 indicates to Disable Loop Current Detection in
10 msec increments.
The default is 4000.

Loop Current Delay 1

The delay after Loop Current Delay detects a
transient drop in loop current and before Call
Analysis returns a connect to the application in 10
msec increments.
The default is 100.

Hello Edge

The point at which a connect will be returned to the
application.
Valid Range 1 (rising edge – immediately when a
connect is detected) or 2 (falling edge – after the
end of the salutation.
The default is 2.

Continuous NonSilence

The maximum length of the first or second period
of nonsilence allowed. If exceeded, a no ringback is
returned in 10 msec increments.
The default is 6500.

Reserved
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Reserved. This must be set to zero.
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Intercept Mode Flag

This parameter enables or disables SIT-Frequency
Detection, Positive Voice Detection (PVD), and/or
Positive Answering Machine Detection (PAMD), and
selects the mode of operation for Frequency
Detection.
The default is 4.

Reserved

Reserved. This must be set to 1.

Maximum Answer

The maximum allowable length of Answer Size.
When Answer Size exceeds Maximum Answer, a
connect is returned to the application in 10 msec
increments.
The default is 10000.

Answer Deglitcher

The maximum silence period allowed between
words in a salutation. This parameter should be
enabled only when you are interested in measuring
the length of the salutation.
A value of –1 indicates to disable this condition in
10 msec increments.
The default is –1.

Dial Tone Present

The length of time that a dial tone must be
continuously present. Specified in 10 msec units.
The default is 1000.

Dial Tone Not Present

The maximum length of time to wait before
declaring dial tone failure in 10 msec increments.
The default is 3000.

Dial Tone Debounce

The maximum gap allowed in an otherwise
continuous dial tone before it is considered invalid.
Specified in 10 msec increments.
The default is 100.

PAMD Fail Time

Maximum time to wait for Positive Answering
Machine Detection or Positive Voice Detection after
a cadence break in 10 msec increments.
The default is 4000.

Minimum PAMD Ring

Minimum allowable ring duration for Positive
Answering Machine Detection in 10 msec
increments.
The default is 1900.
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No Answer

Length of time to wait after first ringback before
deciding that the call is not answered in 10 msec
increments.
The default is 30000.

Maximum Inter-ring Delay

Maximum time to wait between consecutive
ringback signals before deciding that the call has
been connected in 10 msec increments.
The default is 8000.

4.

Click OK.

Setting Brooktrout Parameters
When you install 6510 UM, the system automatically preloads the required settings
if you are using a voice board other than Mitel’s recommendation. Channel
Parameters allow you to change one or more of these predetermined settings.
You can also configure the 6510 voice mail to integrate with other PBX systems.
Note: The system supports both Dialogic and Brooktrout voice
boards. Brooktrout and Rhetorex are identical voice boards.

To change a channel parameter:
1.
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Click Channel Parameters. The Brooktrout dialog appears.
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2.

Select Internal, External, or Other to indicate the source of the call and
the strength of the signal.

3.

Change one or more of the displayed fields.
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Field

Function

Max Start
Silence

Specifies the duration of the longest valid silence period
that PCPM waits for at the beginning of an outbound
analysis. If the initial silence duration exceeds this value,
PCPM considers that no tone is present on the line.
This value should be greater than the value for Sound
Dropout and also greater than the maximum silence period
of any tone in the tone table.
Valid Range is 1 through 524272 in milliseconds.
The default is 40000 (16-msec units)

Max Start
Sound

Specifies the duration of the longest valid sound period
that PCPM waits for at the beginning of an outbound
analysis. If the initial sound duration exceeds this value,
PCPM considers that no tone is present on the line.
This value should be greater than the value for Sound
Spike and also greater than the maximum silence period of
any tone in the tone table.
Valid Range is 1 through 524272 in milliseconds.
The default is 4992.

Min Speech

Specifies the minimum duration of voice that must be
present on the line for PCPM to consider the call answered.
The default is 48.

PCPM Delay

Specifies the amount of time that PCPM waits after
outbound PCPM starts before it begins to analyze tones.
This parameter allows the application to specify an amount
of time tat PCPM waits for the audio on the line to
stabilize.
For example, some switches send a few spurious signals
before the ringback (or busy) signal starts. In such cases,
set the PCPM Delay value to a non-zero value to avoid
detecting false answer conditions that the spurious signals
can trigger.
Valid Range is 1 through 1048560 in milliseconds.
The default is 0.
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Start
Segment

Specifies the deglitched segment that PCPM analysis starts
on. A segment is either a period of silence or a period of
sound on the line. It is considered deglitched once its
duration exceeds the threshold specified by the value in the
Sound Dropout or Sound Spike field.
PCPM analysis normally starts as soon as the function is
called. However, older switches can generate some signals
on the line during an outbound call that is not part of the
ringback tone. If this happens, you should increase this
segment value to a value greater than zero.
If a value other than zero is specified for Start Segment, the
PCPM algorithm considers the first segment to be the first
sound segment it receives. This eliminates the uncertainty
caused by not knowing whether there will be a silence
period preceding the first tone.
The default is 0.

Max Rings

Specifies the number of ringback cycles that PCPM waits
for before it terminates analysis and returns this tone’s ID.
If the number of ringback cycles exceeds this value, PCPM
considers the call unanswered.
Ringback tones differ from non-ringback tones in that
PCPM must wait several cycles after detecting a ringback
tone before it terminates to give the called party a chance
to answer the call. Non-ringback tones, on the other hand,
must be detected as fast as possible.
The default is 4.

Min Cycles

Specifies the minimum number of full cycles of a nonringback-type tone that PCPM must detect before it
terminates analysis and returns this tone’s ID.
Ringback tones differ from non-ringback tones in that
PCPM must wait several cycles after detecting a ringback
tone before it terminates to give the called party a chance
to answer the call. Non-ringback tones, on the other hand,
must be detected as fast as possible.
The default is 2.
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Sound Spike

Specifies the maximum duration of a sound signal that
PCPM analysis considers a glitch (or spike) on the line. If
the amount of time PCPM detects sound on the line does
not exceed the value for this parameter, this sound signal is
considered a spike (noise) and PCPM ignores it. The
duration of the spike is added to the duration of the silence
that PCPM was previously detecting.
The value for Sound Spike should be less than the duration
of all sound elements that are a part of frequency-only
tones.
The default is 112.

Sound
Dropout

Specifies the maximum duration of a silence signal that
PCPM analysis considers a glitch (dropout) on the line. If
the amount of time PCPM detects the absence of sound
(silence) on the line does not exceed the value for this
parameter, this absence of sound is considered a
temporary and unexpected loss of signal (a dropout) and
PCPM ignores it. The duration of the dropout is added to
the duration of the sound that PCPM was previously
detecting.
This value should be less that the duration of all silence
elements in the tone table.
The default is 112.

PVC Spike

Specifies the maximum duration of a voice signal that
PCPM analysis considers a glitch (spike) on the line. If the
amount of time PCPM detects voice on the line does not
exceed the value for this parameter, this voice signal is
considered a spike (noise) and PCPM ignores it. The
duration of the spike is added to the duration of the
absence of voice segment that PCPM was previously
detecting.
This value should be less than the value for Min Speech.
The default is 16.
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PVC Dropout

Specifies the maximum duration of a voice signal that
PCPM analysis considers a glitch (spike) on the line. If the
amount of time PCPM detects the absence of voice on the
line does not exceed the value for this parameter, this
absence of sound is considered a temporary and
unexpected loss of signal (a dropout) and PCPM ignores it.
The duration of the dropout is added to the duration of the
sound that PCPM was previously detecting.
The default is 16.

Term Spike

Specifies the maximum duration of a frequency signal that
PCPM considers a glitch (spike) during background PCPM.
This PCPM analysis operates while other voice processing
activities (play, record, or wait for digit) are ongoing to
determine whether the line receives any user-specified
tones.
If the amount of time PCPM detects a certain frequency on
the line does not exceed the value for this parameter, the
frequency is considered a spike (noise) and PCPM ignores
it. The duration of the spike is added to the duration of the
silence that PCPM was previously detecting.
This value should be less than the duration of all sound
elements of terminating tones in the tone table.
The default is 32.

Term Dropout Specifies the maximum duration of a loss of frequency that
PCPM analysis considers a glitch (dropout) on the line. If
the amount of time PCPM detects a loss of frequency on
the line does not exceed the value for this parameter, this
loss of frequency is considered a temporary and
unexpected loss of signal (a dropout) and PCPM ignores it.
The duration of the dropout is added to the duration of the
frequency that PCPM was previously detecting.
The value for Term Dropout should be less than the
duration of all silence elements of terminating tones in the
table.
The default is 160.
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Frequency
Lock

Specifies the length of time for the detection algorithm to
detect a frequency and determine that it is the tone’s main
frequency. It uses this frequency to analyze a segment’s
characteristics.
The value for Frequency Lock needs to be less than the
duration of all sound elements in the tone table that
contain a frequency (excluding cadence-only and
frequency-only tones). This value also needs to be less than
the value of Sound Spike.
The default is 32.

Max
Frequency
Shifts

Defines the maximum number of times that the receive
frequency can change before PCPM detects another valid
frequency (or silence). If PCPM detects more than this
number of frequency shifts, it considers that voice is
present on the line and assumes the call is answered. The
frequency shift count is reset every time a frequency (or
silence) becomes valid (exceeds the spike or dropout
threshold).
The default is 5.

Max
Frequency
Drops

Defines the maximum number of times that a frequency
can drop before PCPM detects another valid frequency (or
silence). If the number of frequency drops exceeds this
value, PCPM considers the call answered.
The PCPM algorithm defines a frequency drop as the
detection of a silence sample (16 msec) that turns out to be
part of a glitch (meaning the silence period does not
exceed the duration specified by Sound Dropout). The
frequency drop count is reset every time a frequency (or
silence) becomes valid (exceeds the spike or dropout
threshold).
The default is 5.

Max
Unmatched
Seq.

Specifies the maximum number of segments that can be
received that do not match any part of a tone in the tone
table. A segment is a period of sound or a period of silence
of certain duration. Unlike the frequency shift and
frequency drop counters, the unmatched segment counter
is not reset when a valid frequency or silence period is
detected.
The default is 3.
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Frequency
Cover

Specifies the percentage of a segment duration that a
frequency must cover for PCPM analysis to consider the
segment valid. PCPM analysis compares the duration of the
sound segment with the duration of the detected
frequency, if any. When the frequency covers less than the
specified percentage of segment duration, PCPM analysis
considers the call answered.
The default is 70.

PCPM
Optimize

Specifies a value that determines whether to optimize
PCPM analysis for voice or tone detection. When this value
is set to optimize PCPM analysis for voice detection, the
algorithm becomes much more sensitive to detecting a
voice signal and considers most deviations from a clear
signal as a potential voice signal. In particular, PCPM
analysis uses the values for Frequency Cover, Max
Frequency Drops, Max Frequency Shifts, and Max
Unmatched Segments to detect voice and does not use
these values when PCPM is optimized to detect tones.
If PCPM analysis is performed on noisy lines, or cadenceonly tones are present in the tone table, set this
parameter’s value to 0 to avoid detecting false answer
indications. If there is a cadence-only tone in the tone
table, PCPM Optimize must be set to 0.
The default is 0.

Ignore
Frequency
Dev.

Specifies a value that determines whether PCPM disregards
or considers small frequency deviations. Setting this
parameter to True (1) is equivalent to dynamically adjusting
the PCPM filter parameters. This value allows PCPM to still
consider samples good even though they do not satisfy
specified criteria. When this parameter is set to False (0),
deviations are counted as frequency shifts.
This value makes PCPM analysis much more sensitive to
noise on the line and can lead to false reports of callanswered conditions for noisy lines.
The default is 1.
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Enable
Ringback
Tracking

Specifies a value that allows the outbound PCPM function
to detect call-answered conditions faster based on changes
in the characteristics of ringback tones.
When PCPM detects a ringback tone and the parameter’s
value is set to True (1), PCPM assumes that any change in
this tone signals a call-answered condition. PCPM
constantly monitors the signal on the line to identify any
change in the signal (change of cadence, break in cadence
or change of frequency) and reports a call-answered
condition as soon as it detects a change. Setting this value
to False (0) causes PCPM to wait for other events (voice or
unmatched segments) before it considers the call
answered.
The default is 1.

Enable PVC

Specifies a value that determines use of a proprietary PVC
algorithm to detect the presence of a human voice on the
line. Enabling this feature provides a faster and more
reliable method of detecting call-answered situations.
The default is 1.

Enable
Answer
Analysis

Specifies a value that enables analysis of answer
characteristics. When enabled, this type of analysis returns
parameters that allow the application to distinguish
different types of greetings (for example, a greeting
spoken by a live person, a business receptionist, or an
answering machine). If enabled, the greeting (answer) is
analyzed until a termination condition is met.
Answer analysis only starts if the PCPM algorithm
determines that the call has been answered due to
presence of voice on the line. If answer analysis is disabled
(the parameter is set to False), PCPM returns an indication
of answer as soon as it identifies one.
The default is 0.

Max Answer
Analysis

Specifies the maximum amount of time to run answer
analysis. If answer analysis runs for this amount of time
without detecting the amount of voice or silence specified
by Max Answer Voice or Max Answer Silence (below), it
terminates.
The default is 125.
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Max Answer
Voice

Specifies the maximum amount of continuous voice that
answer analysis can accept. If the voice duration exceeds
this value, PCPM terminates.
Caution: The value for Max Answer Voice should be less
than the value for Max Answer Analysis.
The default is 496.

Max Answer
Silence

Specifies the maximum amount of continuous silence that
answer can accept. If the silence duration exceeds this
value, PCPM terminates.
Caution: The value for Max Answer Silence should be less
than the value for Max Answer Analysis. Do not use 0.
The default is 496.

WbEnergy

Minimum amount of energy that a signal (wide band) must
have for PCPM analysis to consider it a sound sample. If the
signal level does not meet this minimum value, PCPM
analysis considers the sample a silence. This parameter,
together with the values for Sound Spike and Sound
Dropout, dictate how PCPM identifies tone cadences.
For lines with a low noise level, you can adjust this
parameter value to avoid detecting false answer
indications. Lines that experience a significant noise level
might require additional adjustments in the tone table to
avoid false detection.
Each time you double this value, you add 3 dB to the
energy threshold. Each time you halve this value, you
subtract 3 dB from the energy threshold. The value for –15
dB is an exception to these rules: the value for –15 dB is 1
less than twice the value for –18 dB.
The default is 32.

4.

Click OK.
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Specifying Fax Board Extensions
Specifying a fax board extension allows you to match a port number to an extension
number. When a fax is received by the voice mail system, the fax call will be
transferred to the specified extension.
Note: Fax board settings must be configured only if you have either
fax mail or fax on demand software installed, as well as a fax
board installed on the fax server.

To specify an extension:
1.

Click Fax Board Extensions. The Fax Board Extensions dialog appears.

2.

In the Port Number field, enter the fax port on the installed fax card.

Note: You must enter the port numbers in sequential order. If you
are specifying more than one fax port, they must be specified
in order.
3.
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In the Extension Number field, enter the analog extension connected to
the associated port.
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4.

Click OK.

Specifying Caller ID Lines
While 6510 UM supports caller ID, some PBX systems require that all calls first go
through a third-party caller id device (for example, Rochelle), which then passes
them to the PBX.

To specify a call ID extension:
1.

Click Caller ID Lines. The Caller ID Lines dialog appears.

2.

In the Port Number field, enter the number of the first port. When you
click on the next Line Number field, the system prompts you to confirm
the auto adding of all line numbers.

3.

Click Yes to let the system add the rest of the line numbers or click No to
enter the rest of the line numbers manually.

4.

When all of the line numbers have been specified, click OK and Save
PBX.
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Specifying Voice Mail Extensions
In the 6510 UM system, you must match the port number with the line number
declared in the PBX Configuration.
Note: These are predefined during installation of the 6510 switch.
For more information, refer to the TAPI guide.

To specify a voice mail extension:
1.

In the PBX General tab, click Voice Mail Extensions. The Voice Mail
Extensions dialog appears and displays the number of ports that have
been installed in the system.

Note: If you are using inband integration, these extensions do not
have to be populated. If you are using SMDI, Ericsson MD 110,
or MCI integration, the extensions must be populated.

• In the Extension Number field, enter the number of the first extension. When you click on the next Extension Number field, the system
prompts you to confirm the auto adding of all line numbers.
2.
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Click Yes to let the system add the rest of the extension numbers or click
No to enter the rest of the extension numbers manually.
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Note: The extension numbers must be entered in sequential order
(for example, 301, 434, 536).
If an extension number changes, you must specify the new
Port Number/Extension Number combination.
3.

When all of the extension numbers have been specified, click OK and
Save PBX.

Specifying the Actions Required for a Transfer
The Transfer dialog allows you to specify the actions required to perform a transfer
generated by the voice board.

To specify transfer parameters:
1.

Click the Transfer tab. The Transfer dialog appears.
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2.

Change one or more of the displayed fields.

Action

Function

Blind Transfer Code

A transfer that is done blindly without supervision.

Supervised Transfer
Code

Sequence to place caller on Hold and perform a
supervised transfer. This parameter instructs 6510 UM
on the sequence it should follow to place a caller on
hold before attempting a transfer.
The following Special Characters may be used (& Flash Hook and , - Pause).

No Answer Release Code

Sequence to return to caller in the event of a noanswer. This parameter instructs 6510 UM on the
sequence it should follow to get a caller back when it
encounters a no-answer condition.
The following Special Characters may be used (& Flash Hook and , - Pause).

Busy Release Code

Sequence to get caller back in the event of a busy
signal. This parameter instructs 6510 UM on the
sequence it should follow to get a caller back when it
encounters a busy condition.
The following Special Characters may be used (& Flash Hook and , - Pause).

Connect Code

Sequence to connect a call. If your telephone switch
requires a connect code (a code that must be dialed
when connecting a transferred call), here is where you
would define it.
The following Special Characters may be used (& Flash Hook and , - Pause).

Hands Free Announce
Code

Sequence to connect a call. If your telephone system
requires a connect code (a code that must be dialed
when connecting a transferred call), here is where you
would define it.
The following Special Characters may be used (& Flash Hook and , - Pause).
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Call Pickup Code

Code to initiate the pick up of a call from another
station.

Conference Code

Code to establish a conference call to record the
conversation. For 6510 UM, the deafult code is S.
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Centrex Transfer Code

Code to release a Centrex transfer call. For example,
the transfer code for a Norstar System is KN71.

Centrex Release Code

Code to release a Centrex transfer call

Centrex Recall Code

Indicates the code to dial to recall a Centrex
transferred call.

Default Rings

The number of rings before system returns a no
answer.

Barge In

Code to enable the function that allows a third party
to enter into an existing conversation.

Transfer Type

Select transfer type, NET1, NET2, or Flash Hook.
Note: Only available if Aculab voice board is being
used.

3.

Click Save PBX.

Specifying the Disconnect Parameters
The Disconnect dialog allows you to define the parameters sent to the 6510 UM
system indicating that a call has been terminated.

To specify the disconnect parameters:
1.

Click the Disconnect tab. The Disconnect dialog appears.
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• In the Hangup Code field, enter the DTMF code supplied by the PBX
to signal a disconnect.
Note: This information is necessary only if required by the PBX.

• In the Hangup Delay Time field, enter the length of time the system is
to wait before hanging up after receiving the hangup code.

• In the Silence Detection field, enter the maximum length of silence
that the system is to consider a disconnect.

• In the Noise Detection field, enter the maximum length of noise (such
as dial tone) that the system is to consider a disconnect.
2.

Click Save PBX.

Editing the Disconnect Tone
6510 UM allows you to define the type of signal used as the disconnect tone for the
PBX. This tone is transmitted from one end of a user line or trunk to indicate to
the other end that the established connection should be disconnected.
94
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Note: There is no disconnect code for the 6510 UM.

To edit a disconnect tone:
1.

Click Edit. The Disconnect dialog appears.

• In the Frequency 1 field, enter the frequency.
• In the Frequency 2 field, enter the second frequency.
• In the Cadence On field, enter the amount of time that the signal is
on.

• In the Cadence Off field, enter the amount of time that the signal is
off.

• In the No of Cycles field, enter the number of cycles that 6510 UM
analyses before reporting the disconnect signal.
Note: Mitel Networks recommends 2 as the number of cycles.
2.

Click OK.
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Modifying the DTMF Message Light On/Off Code
The Message Light dialog allows you to activate or deactivate message waiting
lights after a message has been sent to a mailbox.

To modify the message light code:
1.

Click the Message Light tab. The Message Light dialog appears.

• In the On Code field, enter the code to turn on the message light. If
this field is left blank, 6510 UM uses the code contained in the system
parameters for activating message waiting lights.

• In the Off Code field, enter the code to turn off the message light. If
this field is left blank, the 6510 UM system uses the code contained in
the system parameters for deactivating message waiting lights.
Note: You must ensure that the letter ’E’ is included in the On and
Off Codes. The letter ’E’ signifies ’extension’.
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• In the Interval Time field, enter the frequency that the system will
check ports set to notify. 6510 UM checks to see if there is an outcall
event to be performed.

• Select the Wait for Dial Tone checkbox to instruct the system to
check for the dial tone. If set to 1, when the system goes off hook, it
checks for dial tone first. If no dial tone is detected, it returns to the
company greeting.

• Select the On Hook checkbox to instruct the system whether or not to
go off hook to send the message light codes to the telephone system.

• Select Dial Digits and indicate in the enabled field which port to use to
enable lighting of the message waiting light.

• In the Channels field, enter the channels assigned to perform the Message Waiting Light.

• Select Send Through COM if the Message Waiting Light is performed
by a serial port.

• From the Device drop-down list, select the COM port.
• Select CTI for integration with the 6510 UM.
2.

Click Save PBX.

Selecting Inband Parameters
If your telephone system does not have C.O. Line identification, 6510 UM allows
you to simulate this feature.
Note: Set up the C.O. Lines to ring into real extensions that are
programmed to forward all calls to 6510 UM. On the "Inband
Parameters" screen, enter the inband that you would
normally receive from a forwarded extension into the
Parameter 190 - "Inband Outside C.O. Call". On the company
screen, enter the extension number of this forwarded
extension in the C.O. Lines field.

To select inband parameters:
1.

Click the Inband tab. The Inband dialog appears.

2.

The Integration drop-down list displays TAPI as the default, with the rest
of the fields inactive.
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Depending on the switch that was selected when you configured the
PBX, all of these fields are populated. If your PBX uses a Serial
Integration, the Inband tab will display it. If your integration is Inband,
the Inband dialog displays both the Options and the Definition tab.
Note: The Serial Integration Device field becomes active if you select
MD110, MCI, CTI, or ASCOM.
For the Mercator and Matra PBX:

• From the Integration drop-down list, select PBX you want to use.
• Select the Verify Inband Length checkbox to verify that all inband
codes are the same length. This ensures that the inband codes being
sent from the PBX are correct and is applicable to Mercator and Matra
switches.

• Select the Confirm Inband Signals checkbox to indicate that the system must confirm the inband signals. This is applicable to Mercator and
Matra switches.
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• Select the Inband Use Invalid Sender as C.O. checkbox to indicate
that the system is to use an invalid sender as a C.O. This is applicable to
Mercator and Matra switches.

• In the Inband Signaling Delay field, enter the delay (in milliseconds)
between packets.

• In the Maximum Inband Digits field, enter the maximum inband digits that the system can accept.

• In the C.O. Digits Length field, specify the numerical digit length of
the C.O. that is accepted by the system.

• In the Caller ID Length field, enter the numerical digit length of the
phone number that the caller ID receives.
Note: These options are used for Inband integration.
For the Nitsuko PBX.

• Select the Variable Length Inband Caller ID checkbox to the system
that it can receive calls from numbers stings of variable length.
Note: These options must be selected for the Mercator PBX.
3.

Click Save PBX.
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Specifying and Confirming Inband Definitions
Following the configuration of PBX options, you can view, specify and confirm
inband definition codes. When you click the PBX Templates button to add a PBX,
the wizard will generate default definitions. You can also view and fine-tune your
inband definitions by using the Definitions tab.
Note: Definitions are only available for inband protocols. The 6510
UM uses the SMDI protocol and does not use definitions. The
Definitions area can only be used if you are using a different
PBX such as an Iwatsu.

To specify and confirm inband definitions:
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1.

In the right window, double-click the PBX you want to use. The PBX
dialog appears.

2.

Click the Inband tab, and then click the Definition tab. The Definition
tab appears.
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3.

All definitions will be listed, indicating the Code and Type. You can make
the appropriate changes by entering the new code in the Code field, or
choosing a new type in the Type drop-down list.
The following table illustrates the available Inband Definition Codes:

4.

Code

Definition

E

Called Party

S

Calling Party

C

Outside Co. Line

I

Caller ID

X

Ignore Character

Click Save PBX when all changes are made and confirmed.
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Specifying the Dial Plan
The Dial Plan dialog is used to specify the local, toll area, and long distance codes
required so that the system can dial out.

To specify the dial plan:
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1.

Click the Dial Plan tab. The Dial Plan dialog appears.

2.

In the Country Code field, enter the appropriate country code required
to dial long distance.

3.

In the Dialing Suffix field, enter the symbol for pauses.

4.

In the No of Digits in Phone No field, enter the max number in the
phone number dial string (for example, 7 or 10).

5.

In the No of Digits in Area Code field, enter the number of digits in the
local area code (for example, 3 for 247-677-9700).

6.

In the Local Area Code 1 to 4 fields, enter up to four area codes. For
each local area code, click the ... button. The Local Area Code dialog
appears.
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7.

In the Local Area Code Prefix field, enter the prefix (first three numbers
of the telephone number) that belongs to the area code specified in the
Local Area Code (1,2,3,4) fields. Additional prefixes can be entered by
separating each with a comma (,). For example, 888, 947, 660 and so on.

8.

Select the All Local checkbox to indicate that all calls belonging to that
prefix are local.

9.

Click OK. You are returned to the Dial Plan tab.

Note: By adding prefixes to the specified local area codes, the
system will recognize any numbers beginning with the
specified local area codes and assigned prefixes as local calls.
10.

Click Save PBX.
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Specifying Area Code Rules
After specifying the area codes in the Dial Plan tab, you must ensure that your
Phone and Modem Options in Windows is configured to handle local dialing that
requires the inputting of an area code.

To specify area code rules:
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1.

In the Windows Task Bar, click Start>Settings>Control Panel>Phone
and Modem Options, The Dialing Rules tab appears.

2.

Click New. The General tab appears.
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3.

In the Location Name field, enter the location name that the system will
be dialing to.

4.

In the Country/region drop-down list, select the Country/Region that
this location is in.

5.

In the Area Code field, enter the area code.

6.

Click the Area Code Rules tab. The Area Code Rules tab appears.
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7.
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Click New. The New Area Code Rule dialog appears.
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8.

In the Area code field, enter the local area code that the system is
required to dial.

9.

Select the Include the area code checkbox.

10.

Click OK.

Deleting a PBX
If you are running a single PBX, 6510 UM does not allow you to delete it. However,
in the future, the software will be able to support more than one PBX.
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Overview
Using 6510 UM, you can create single or multiple companies with multiple
configurations on a single system.
Note: The number of companies that you can create is determined
by the terms of your Sentinel license.
You must enter at least one company in order for 6510 UM to
work properly.

Displaying Summary Information
The Administration Console displays a summary of the details for each company
associated with the PBX. These details include the company name, company
number, and status.
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The Status indicates whether the company is open (business hours) or closed
(after office hours or closed).
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Using the Toolbar Buttons
There are 18 buttons that allow you to perform various tasks within the Company
application.
Button

Name

Function

Add Company

Add a company

Copy

Copy the configuration of one
company to another company.
Note: If a single company exists,
clicking this button creates a new
company.

Delete Company

Delete a company

Save Company, Distribution List, or
Schedule

Save the company, distribution list,
or schedule

Refresh Company

Refresh the display

Find Sub Menu

Find a sub menu within a voice
menu

Start Voice Menu Schedule

Start a voice menu schedule

Start Voice Menu Schedule (Enabled)

The Menu Schedule has been
enabled.

Schedule Report
Open Voice Menu

Open a voice menu

Add Voice Menu
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Delete Sub Menu or Schedule Item

Delete a sub menu or a schedule
item

Add Sub Menu/Schedule Item

Add a sub menu or schedule item

Key Mapping

Allows for key mapping
configuration.
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Send Message Menu

Allows configuration of message
menu that is used by outside callers
who want to leave a message to a
mailbox

Distribution List

Allows you to define distribution
lists

Business Hours

Allows you to define company
business hours

Holidays

Allows you to define company
holidays
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Opening a Company
You can open a company from the Administration Console.

To open a company:
1.

Highlight the PBX. All associated companies appear in the right pane.

2.

Right-click on the company that you want to open and select Properties.
The Company dialog appears.

Hint: Once you have opened a company, you can open another
company by clicking on the scroll buttons.

Creating a Company
6510 UM allows you to create additional companies under a single PBX. Each
company can be made up of multiple feature groups, remote sites, voice menus,
and customized mailboxes.
Note: The number of companies that you can create depends on
your licensing agreement.

To create a company:
1.

Highlight the PBX on the Administration Console.

2.

Click Add New Company. The General dialog appears.

Editing a Company
You can change all of the information associated with a company.

To edit a company:
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1.

Open a company from the Administration Console. The General dialog
appears.

2.

Make the required changes and click Save Company.
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Deleting a Company
You can delete a company from either the Administration Console or from a
Company dialog.

Deleting from the Administration Console
6510 UM allows you to delete one or more companies from the Administration
Console.

To delete a company:
1.

In the Tree, click the PBX so that it becomes highlighted. All associated
companies appear in the right pane.

2.

In the right window, right-click the Company that you want to delete and
select All Tasks>Delete. A message appears, prompting you to confirm
the deletion.

3.

Click Yes. A dialog appears informing you that the deletion of the
company cannot be undone once it is performed.

4.

Click Yes. The company is deleted.

Caution: Mitel Networks does not recommend the deletion of the Default
company. The deletion of the Default company (or the last existing company in your configuration) will make all default mailboxes, customized mailboxes, and feature groups irretrievable.

Deleting from a Dialog
You can delete a company from any dialog within a company.

To delete a company:
1.

Open the company that you want to delete.

2.

Click Delete Company. A message appears, prompting you to confirm
the deletion.

3.

Click Yes. A dialog appears, warning you that you are about to delete
the selected Company.

4.

Click Yes. The following message appears:
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5.

Click Yes. The General Dialog displays information about the next
company if it exists.

Caution: Mitel Networks does not recommend the deletion of the Default
company. The deletion of the Default company (or the last existing company in your configuration) will make all default mailboxes, customized mailboxes, and feature groups irretrievable.

Specifying General Options
The General dialog allows you to specify general information about the company,
including name, phone number, and company mailbox. You can also create a new
company within a company.

To specify general options:
1.
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Click the General tab. The General dialog appears.
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2.

The Company Number field is entered automatically when you save the
company.

• In the Company Name field, enter the name of the company.
Note: The company name is used to associate users to a particular
company when there are two or more companies sharing the
same 6510 UM system. If the system is configured for only
one company, this field will not affect any function of the
system.

• In the Domain name /IP Address field, enter the domain name that
you established for the UM server or the IP address of the computer.
6510 UM Server Configuration Guide
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• In the Phone Number field, enter the company’s phone number.
• In the Account Code field, enter the company Long Distance Account
Code.

• Select the Prefix checkbox if you want the prefix to be used before the
phone number. Leaving the Prefix checkbox unchecked indicates that
the prefix is to be used after the phone number.
Caution: This information must be specified if you want to create a VPIM
address.

• From the Fax Extension drop-down list, select the mailbox that the fax
extension is associated with.

• From the Admin Mailbox drop-down list, select the administrator’s
mailbox.

• From the Country drop-down list, select the country 6510 UM is
installed in.

• From the Salutation Format drop-down list, select the format that
you want to use.
Note: 6510 UM uses the WAVE format.

• In the Collaboration URL field, enter the URL of the collaboration service that your company is using. (Collaboration services are enabled in
the Web Client).

• Select Relate Company to C.O. Line if C.O. Lines are being used for
the company.

• Select Relate Company to Port if you are using ports to identify the
companies.
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3.

Click Save Company.

4.

Click Add Company to add another company.
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Customizing a Mailbox
For information on customizing a mailbox, refer to Chapter 10, Customizing a
Mailbox.
The system has its own customized mailbox. The user can create, modify or restore
a new customized mailbox but cannot delete the default customized mailbox.

Specifying Advanced Features
The Advanced dialog allows you to specify a variety of options, including the paging
code for the company, business and holiday hours, and company-wide distribution
lists.

To specify advanced feature:
1.

Click the Advanced tab. The Advanced dialog appears.
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2.

Select one or more advanced features:

Feature

Function

Allow Sequential
Directory

Indicates whether or not to allow callers to access the
sequential directory when they select the directory
option by pressing **.
The default is selected.
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Add Number of
Messages to Beeper
Number

Indicates whether or not to indicate the number of
new messages in the mailbox when outcalling to a
beeper. This is shown with an asterisk (*), followed
by the number (for example, 201 *3 indicates 3 new
messages in mailbox 201).
The default is selected.

Play Mailbox Greeting
for Express Voice Mail

Indicates whether or not to play the mailbox greeting
when callers are sent to Express voice mail, or just the
name prompt.

Drop Messages Less
than Max Silence

Messages that are less than the specified Maximum
Silence parameter will not be delivered (if selected).

Allow Dialing Extension
Starting with 0

This allows you to create extensions that lead with
digit 0 (for example, 033).

When Transferring, Play
Prompt

This plays the “Thank You. Please Hold” prompt
when transferring calls from the automated
attendant.

Allow Barge-In in
Confirm Names

Allows a third party to interrupt name confirmation.

3.

Click Save Company.

Enabling the Intercom Paging System
The 6510 UM system allows a caller to have the 6510 UM page the internal user via
the PBX paging feature. As this feature is PBX dependent, you must specify a
paging access code.

Note: The default settings are passed on your PBX codes and
integration.
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To specify a paging option:
1.

In the Paging Access Code field, enter the sequence that will place the
caller on hold and access the intercom paging system.

2.

In the Paging Release Code field, enter the sequence that the system is
to dial to get the caller back after intercom paging.

3.

In the Paging Delay Time field, enter the time that the system is to wait
after paging before transferring to extension.

4.

Click Save Company.

Adding Business Hours
The Business Hours dialog allows you to designate your company's office hours.
These business hours are used in conjunction with the Greeting Times to play the
appropriate greeting.

To specify office hours:
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1.

In the Company Advanced tab toolbar, click the Business Hours button.
The Business Hours dialog appears.

2.

From the Closed Greeting drop-down list, select the phrase that you
want to play when callers call outside of business hours.
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Note: For information on recording a closed greeting, refer to
Recording a Company Greeting on page 323.

• In the From field, scroll to the time (hours and minutes in military format) that the greeting is to start or enter the time in the field.

• In the To field, scroll to the time (hours and minutes in military format)
that the greeting is to end or enter the time in the field.
Note: Select the All Day checkbox if you want the greeting to play
for the entire day. If no time is entered, the system will
assume all hours.
A value of From 13:00 to no value indicates 1:00 PM to
midnight. The maximum value is 23:59 and the minimum
value is 0:00.
Other than a no value, the From field cannot be greater than
the To field.

• Select the days of the week that you want the greeting to run.
• If you want the message to run every day, select Every day.
3.

From the Greeting drop-down list, select the greeting that is to play
during the specified time.

4.

Click Save Schedule.

Adding a Holiday
The Holidays parameter allows you to specify holidays so that an appropriate
greeting can be played on that day. You can enter as many holiday dates as you
require.
Note: When the Company starts with a Voice Menu, the Holidays
phrase will only take effect if the Phrase field says “Company
Active Greeting” in the Voice Menu. This tells the system to
use the Phrase defined on the Greetings tab of the Holiday
screen, and to check if the current day is a Holiday.

To add a holiday:
1.

Click Holidays. The Holidays dialog appears.

6510 UM Server Configuration Guide

123

Maintaining a Company

2.

Click Add Item. The Holiday Prompt and Voice Menu fields become
active. Holiday

Hint: You can also double-click on the date.
3.

From the Month drop-down list, select the month that the holiday
appears in.

4.

From the Year drop-down list, select a year.

5.

Leave All day selected if you want the prompt to play all day. If you want
the prompt to begin playing at a particular time, clear the check box and
enter the time in the Start Time field.

6.

In the Holiday Prompt field, enter the appropriate prompt that
corresponds to the holiday in question.

Note: You must record a new prompt for each holiday that you add
to reflect the appropriate holiday’s greeting. To record these
greetings, refer to Recording a Company Greeting on
page 323.
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7.

From the Voice Menu drop-down list, select the voice menu that you
want the system to use.

8.

Click OK.
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Viewing a Schedule Report for Holidays
The Schedule Report lists all of the holidays and associated voice menus that have
been created for the company.

To view a schedule report:
1.

Click Holidays. The Schedule Report (Holidays) dialog appears.

2.

Close the window.
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Specifying Key Mapping
Single digit access (Key Mapping) fields are used in conjunction with the company
greetings to allow callers to transfer to a desired department or individual by
pressing a single digit (1 through 9). For example, the company greeting might say,
“Good morning, you have reached ABC Company...for the sales department press
one (1)...for technical support press two (2).”
In the key mapping field, enter the appropriate mailbox number. For example, if the
Sales department is Mailbox 101, enter 101 in single digit number one (1). If you do
not want to use this function, leave these fields blank.

Using the Company Default Keys
If you use the Key Mapping feature, make sure that you are aware of the following
company default keys:

• * Directory
• # Login
• 0 Operator
• D Default
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Special Keys
There are two special values that may be entered in the key mapping fields to offer
other additional options to callers: pound (#) and asterix (*). The # enables the user
to log into the system, and the * enables the caller to access the company directory.
Note: Some telephone systems may have predefined features
programmed to the <#> and <*> keys.

To map the keys:
1.

In the Company tab toolbar, click the Key Mapping button. The Key
Mapping dialog appears.
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• In the Description field, enter a description of what this key mapping
is doing.

• Select Extension Dialing to allow callers that are in this menu to enter
an extension that they will be directly transferred to.
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• The Actions field displays a list of predefined actions you can configure
in the automated attendant. The following actions are available for key
mapping:
Action

Function

Disconnect

Hang up the call.

Recall Caller

Recalls the caller out of the voice menu of a defined
mailbox.
Note: The DTMF Key assigned to this action cannot be
the same as the first number of the user’s mailbox
number. For example, if a user has the mailbox number
255, the Recall Caller action cannot be assigned to
DTMF key 2.

Send to Company
Operator

Sends the caller to the company operator.

Send to Directory

Sends the caller to the company directory.

Send to Fax Mail

Transfers the call to the fax board extension to receive a
fax.

Send to Login

Allows the caller to log into the system as a user.

Send to Mailbox

Transfers the caller to a defined mailbox.

Send to Sequential
Directory

Lists the company directory to the caller name by name.

Send to Voice Mail

Sends the caller to the MBX that was entered.
Note: This action works in the same way as if you had
pressed # E# (for example, 7#E#).

Send to Voice Menu

This transfers the call into a custom voice menu for
further processing.

• The Actions list box displays a list of action commands that you can
define in a voice menu. Highlight an action, press the right mouse button and click Send Action To. The DTMF key drop-down list appears.
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• Select a DTMF key to match the action to. For example, to transfer a
caller to the Operator if they either press 0 or do nothing, highlight
Send to Mailbox and select 0 and Default.
Hint: You can also drag and drop an action to a key.
A mailbox for the Operator must exist before you can assign
an action to 0.

• A dialog box appears if additional information is required. For more
information, refer to Appendix H – Key Mapping.
2.
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Click Save Key Mapping.
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Creating a Key Mapping Sub Menu
Creating a key mapping sub menu allows the user to create a series of different key
mapping definitions based on different times and days of the week. For example, if
a caller presses 1 in the morning, they are transferred to Sales. However, if they
press 1 when the company is closed, the system transfers the call to the west coast
office where operations are still open to handle the call.

To create a sub menu:
1.

In the Company toolbar, click the Key Mapping button.

2.

Click Add Sub Menu. The Sub Menu number will increment by one.

You can create as many key mapping sub menus as you need. You can also
associate a schedule to play the sub menus at predefined dates and times.
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3.

Click Start Menu Schedule to associate the new sub menu to a time to
be active. The Start Menu Schedule dialog appears.

4.

From the Default Start Menu drop-down list, select the sub menu that
should be active during default hours.

5.

In the FromYear/Month/Day/Time fields, enter the time (in military
format) that the sub menu is to become active.

6.

In the To Year/Month/Day/Time fields, enter the time (in military
format) that the sub menu is to become inactive.

Note: If no time is entered, the system will assume all hours.
Select All day if the sub menu is to run all day.
A value of From 13:00 to no value indicates 1:00 PM to
midnight.
The maximum value is 23:59 and the minimum value is 0:00.
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7.

Select the days of the week that you want the message to run.

8.

If you want the message to run every day, select Everyday.

9.

From the Start Menu drop-down list, select the sub menu that will run
at the times specified.

10.

Click Save Schedule.

Configuring the Send Message Menu
The Send Message Menu allows you to configure a message menu that will be used
by outside callers who decide to leave messages to mailboxes within your company
system.

To configure the send message menu:
1.

In the Company toolbar, click the Send Message Menu button. The
Send Message Menu dialog appears.

2.

In the Menu Name field, enter a name for the sub menu.
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3.

In the Play Method drop-down list, select the play method to use.

4.

In the Sub Menu Phrase drop-down list, select the phrase to use for the
sub menu.

5.

In the Description field, enter a description for the sub menu.

6.

In the No. of Retires field, enter the maximum number of retries that a
caller is allowed to commit within the sub menu.

7.

In the Timeout field, enter the amount of time (in milliseconds) that is
allowed for inaction before the system times out.

8.

From the Actions list, drag and drop the selected actions into the DTMF
key of choice. By designating actions to specific keys, outside callers will
be presented with the actions that you have defined.

Action

Function

Append to Recorded
Message

Adds another message to the already recorded
message.

Cancel Message and
Exit

Cancels the message and exits.

Rerecord Message

Allows for the rerecording of the message.

Review Recorded
Message

Plays the recorded message for review.

Send Recorded
Message

Sends the message to the destination.

Send to Sub Menu

Sends message to the sub folder.

Toggle Certified Flag

Flags message as certified.

Toggle Mass Recall

Enables mass recall.

Toggle Private Flag

Flags the message as private.

Toggle Urgent Flag

Flags the message as urgent.

Transfer to Operator

Sends the caller to the company operator.

9.
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After dragging and dropping an action, the Parameters dialog appears.
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10.

For each action, in the Next Sub Menu drop-down list, enter the sub
menu number that is to follow the current action.

11.

After defining all actions, click Save.
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Creating a Distribution List
6510 UM allows you to create a distribution list consisting of one or more
mailboxes. This enables you to send a voicemail, e-mail, or fax to more than one
user at the same time.
When creating the distribution list you can add internal UM users, users on a site
that is networked via AMIS to the UM, users on a site that is networked via VPIM to
the UM, and external e-mail users. This allows you to send a voice message to any
user with one of these profiles on your list.
Each mailbox has the capability of holding all the distribution lists that you need,
each consisting of an unlimited number of mailboxes.

To create a distribution list:
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1.

In the Company toolbar, click the Distribution Lists button. The
Distribution List dialog appears.

2.

In the List Number field, enter the distribution list number.

3.

In the List Name field, enter a name for the distribution list.
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Note: The List Name can be any combination of numbers and
characters found on a telephone keypad. If you require the
voice mail system to read your distribution lists to you, it will
read the characters that you have entered in this field
through the telephone handset using the Text to Speech
feature.
4.

To add a mailbox to the distribution list, highlight it and click Add.

5.

To add all mailboxes to the distribution list, click Add All.

6.

To remove a mailbox from the distribution list, highlight it and click
Remove.

7.

To remove all mailboxes from the distribution list, highlight it and click
Remove All.

8.

Click Save Distribution List.

9.

To add another distribution list, click Create Distribution List.

Editing a Distribution List
You can edit any distribution list associated with a company.

To edit a distribution list:
1.

Click Distribution Lists. The Distribution List dialog appears.

2.

From the Go to drop-down list, select the distribution list that you want
to edit.

3.

Make the appropriate changes and click Save Distribution List.

Deleting a Distribution List
You can delete any distribution list associated with a company.

To delete a distribution list:
1.

Click Distribution Lists. The Distribution List dialog appears.

2.

From the Go to drop-down list, select the distribution list that you want
to delete.

3.

Click Delete Distribution List. The following message appears:
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4.

Click Yes. The system removes the distribution list from the display.

Adding an AMIS Site
AMIS (Audio Messaging Interchange Specification) is a communications standard
that enables voice-messaging systems produced by different vendors to network or
inter-network together. Specifying an AMIS user allows 6510 UM to integrate with
voice processing systems from other vendors.

To add an AMIS Site:
1.

Highlight an AMIS site and click Add. The Remote Site dialog appears.

2.

In the Address field, enter the remote user’s mailbox number and click
OK.

3.

Click Save Distribution List.

Adding a VPIM Site
Voice Profile for Internet Mail (VPIM) is an International Telecommunications Union
(ITU) standard that allows different types of messaging servers to pass voice and fax
messages between each other over the Internet. For information on adding a VPIM
user to the system, refer to Adding a VPIM Site on page 259.

To add a VPIM Site:
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1.

Highlight a VPIM site and click Add. The Remote Site dialog appears.

2.

In the Address field, enter the remote user’s mailbox number and click
OK.

3.

Click Save Distribution List.
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Adding an E-mail User
You can add either an internal or external e-mail address to the distribution list.

To add an e-mail user:
1.

In the E-mail field, enter the user’s SMTP e-mail address and click Add.
6510 UM pastes the address into the Distribution List pane.

2.

Click Save Distribution List.
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Specifying Call Options
The Call Options default settings are loaded when you first install the system. The
Call Options tab allows you to change the settings.

To specify call parameters:
1.

Click the Call Options tab. The Call Options dialog appears.

• In the Outcall Access Code field, enter the code required for the system to access an outside line.
140
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• In the Outcall Retry Time field, enter the period of time that the system is to wait before attempting another outside call. The default is 2.

• In the Minimum Message Length field, enter the minimum length of
messages in seconds. If set to 0, all messages will be recorded. The
default is 2.

• In the Caller Number of Retries field, enter the number of invalid
attempts the user is allowed while in the voice mail system before disconnecting the call. The default is 3.

• In the User Number of Retries field, enter the number of invalid
attempts when the user is in the voice mail system to allow the user
before disconnecting the call. The default is 3.

• In the Maximum Call Time field, enter the maximum number of minutes that an incoming call can last. A value of 0 indicates unlimited
time. The default is 30 minutes.

• In the Inter-Digit Delay Time field, enter the maximum time interval
that the system should wait between in-band digit strings before reading. The default is 3000.

• In the Number of Rings During Business Hours field, enter the number of rings before the Auto Attendant answers during business hours.
A value of one (1) intercepts calls quickly.

• In the Rings After Business Hours field, enter the number of rings
before the Auto Attendant answers when the Company is closed. A
value of one (1) intercepts calls quickly.
2.

Click Save Company.
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Specifying Mailbox Options
The Mailbox Options dialog allows you to specify the options for all mailboxes
associated with this company, including the mailbox length (the number of digits
representing the mailbox), the length of the directory list, and the method used to
sort the mailboxes.

To specify mailbox options:
1.
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Click the Mailbox Options tab. The Mailbox Options dialog appears.
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2.

Select the Mailbox Length Fixed checkbox to indicate whether or not
the mailboxes associated with this company will be a fixed length
(Selected), or a variable length (not Selected).

3.

In the Mailbox Max Length field, enter the maximum number of digits
that mailboxes can be.

4.

Select the Refresh Mailbox Message Lights checkbox to automatically
audit all mailbox statuses and reset mailbox lights based on power
failures and computer reboots. This by default is turned off and only
activated when the PBX does not have the capability to store message
light status in memory.

5.

Select the Show Mailbox Password checkbox to show the mailbox
passwords in the administration screen of a mailbox.

6.

Click Save Company.
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Using AMIS
Audio Messaging Interchange Specification (AMIS) is a standard that enables voicemessaging systems produced by different vendors to network or inter-network.
6510 UM is AMIS compatible. The AMIS specification calls for the use of DTMF
tones to convey control information and transmission of the message itself in
analog form. This means that the 6510 UM system can be networked to other 6510
UM systems or with other vendors’ voice messaging systems that are also AMIS
compatible. With AMIS networking, users from different locations can
communicate as if they are all on the same voice mail system, whether they are in
different buildings, different cities, or different countries.
This feature is especially useful for companies that have multiple locations. A user
that wants to send a message to the head office can do so as if they are sending an
internal message from one mailbox to another. Distribution lists can include entire
AMIS sites, or specific mailboxes from different AMIS sites.
A user at one location can set up a mailbox in another location (referred to as a
virtual mailbox, as it has no physical extension), and then set up Message
Forwarding to point to the mailbox on the original site. This ensures that messages
can be sent to this user easily by sending it directly, through a virtual mailbox, or
through a distribution list.

Specifying AMIS Parameters
The AMIS Parameters tab allows you to specify the settings that apply to the
remote AMIS site, such as Timeout Digits and Packet information.

To specify the parameters:
1.
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In the Company dialog, click the AMIS Parameters tab. The AMIS
Parameters dialog appears.
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2.

Select the Auto Add New Sites checkbox to add sites that are not
registered to the network database automatically by the system. The
Description of auto-added sites will show the date the site was autoadded.

3.

In the Loop Back Request ID field, enter the AMIS loop back test
number for this site. For LOCAL sites, this defines the loop back test for
incoming calls from other sites.

4.

In the Admin Message User ID field, enter the user ID that will receive
messages that cannot be delivered or messages that cannot be returned.
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Note: The default value for this field is blank. If the field is left blank
and these types of messages will be deleted. This field is used
for LOCAL sites only.
5.

In the System ID Number field, enter a unique string that identifies this
site to all other sites that it may ever contact. It will also identify the
callback telephone number.
AMIS has strict guidelines on the format of a system ID. It is composed of
three numeric fields using 0-9, and each field is terminated with a #
(pound sign). The maximum length of the System ID Number is 18
characters, and the minimum is 3 characters. There are two types of
System ID Numbers, public and private.
Public System ID Numbers
Public System ID Numbers are for all sites that can be direct dialed using
the public telephone network. These ID numbers are always in the format
of ccc#nnn#sssssss#, where the value “ccc” is the international country
code (1–4 digits), the value of “nnn” is the national significant number
(area or city code of 0–14 digits) and the value of “sssssss” is a local
subscriber number of 0-14 digits. All locations in North America must use
the format of 1#aaa#sssssss# where “aaa” is the area code and
“sssssss” is the local telephone number.
Private System ID Numbers
Private System ID Numbers are for all sites that are accessible through a
private network or behind a PBX. These always have the format
0##nnnnnnn# where “nnnnnnn” is a site defined number. The site
defined number is typically the extension number of the site. The value
“nnnnnnn” can be from 0–14 digits.

146

6.

In the Digital Timeout for Send field, enter the total length of time to
wait for all digits before timeout. The default is 15.

7.

In the Digit Timeout for Receive field, indicate the number of seconds
to wait for all digits before timing out. The default setting is 15 seconds.

8.

In the Packet Delay for Send field, specify the number of seconds the
system should continue trying to connect before sending a time out
message. The default setting is 15 seconds.

9.

In the Packet Delay for Receive, indicate the number of seconds the
system should continue trying to receive before sending a time out
message. The default is 15 seconds.
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10.

Click Save Company.

Specifying a Company Language
Based on the language module that you install, 6510 UM speaks system prompts,
holiday, business hours, and company greetings in the selected languages. The
Company Languages dialog allows you to select these system languages.
Note: The language module must be installed for the language to
take effect. For more information, refer to the Installation
Guide.
6510 UM can operate with up to nine different languages.

To specify a company language:
1.

In the Company dialog, click the Company Languages tab. The
Company Languages dialog appears.
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2.

Highlight a DTMF key and click Add. The Language Properties dialog
appears.

3.

From the Language drop-down list, select a language.

4.

From the Operator drop-down list, select the mailbox number of the
Day Operator (Receptionist). This allows callers to transfer to this
extension when they press zero (0) to speak to an operator.

5.

From the Greeting drop-down list, select a company greeting.

6.

Select the Set as Default checkbox to set this particular language as the
system default language.

Note: Each company can have their own default language.
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7.

Click OK.

Note: These languages are controlled by licensing.

Creating an Operator Schedule by Language
Following the creation of operators and their languages, you can specify when each
operator is to receive calls based on their spoken languages through the Operator
Schedule feature.

To create a language schedule:
1.

In the Company dialog, click Company Languages. The Company
Languages dialog appears.

2.

Double-click the operator you want to create a schedule for. The
Language Properties dialog appears.

3.

Click

. The Operator Schedule dialog appears.
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4.

Provide the following information to schedule the operator:

• Select the Schedule Enabled checkbox to enable schedule.
• In the Default Operator drop-down list, select the default operator to
use if selected operator is unavailable.

• In the From Year/Month/Day/Time drop-down lists, indicated the
time when the selected operator is to be enabled. Select the All Day
checkbox if you want the operator to be enabled all day.

• In the To Year/Month/Day/Time drop-down lists, indicate when the
selected operator is to be disabled.

• In the Sun, Mon, Tue, Wed, Thur, Fri, Sat, or Everyday checkboxes,
select what day you want the operator to be enabled.
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• In the Operator drop-down list, select the Operator whom you want
to enable.
5.

Click Save Schedule to save settings.

Using Unilingual and Multilingual Mode
The 6510 UM system functions differently when it is configured to operate in the
multilingual mode. It is important to understand how the 6510 UM system answers
calls in standard mode and in multilingual mode. Initially, all calls are handled the
same way. When a call comes into the PBX, it is routed to a hunt group (or some
sort of call routing group that rings one of the free 6510 UM ports). When the port
starts ringing, 6510 UM begins to count the rings. Depending on whether or not
the company is in open or closed mode, the 6510 UM system looks at the
appropriate incoming rings.
For more information about Multi-Company (Tenanting), refer to To configure
multi-tenanting using V.C. Assignment: on page 170.
At approximately 1.5 seconds after going off hook, the 6510 UM system plays the
Main Company Greeting. At this time the 6510 UM system will begin to act
differently depending on Standard or Multilingual mode.

Standard Mode
When only one language is being used (Standard) the appropriate Greeting plays
(Morning, Afternoon, Evening, or Closed) during which time callers can dial
extension numbers, select Key Mapping options, Press <#> to access mailbox
options, Press <*> to access the company directory, or <#><*> to access the
Supervisor menu. If the caller does nothing, the system transfers the caller to the
Day or Night Operator two seconds after the main company greeting ends.

Multilingual Mode
When 6510 UM is configured to operate in Multilingual mode, it operates the same
as standard mode until it begins to play the main company greeting. At this point,
the Morning, Afternoon, Evening, and Closed Greetings are no longer used to offer
options to the callers. The 6510 UM system requires the caller to select a language
in order to continue. These language greetings should welcome the caller and ask
them to select the language that they would like to be served with. The 6510 UM
system then waits for the caller to make a selection.
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No Key Mapping options are available to the caller at this time. The caller may,
however, dial a desired extension number but will be served in the default language
(English by default). Once the caller selects a language, the Multilingual greeting is
played.
If a caller selects a language other than the default language, the call progress for
this caller is supervised to ensure that in the event that the caller is transferred back
to the main greeting, the 6510 UM system continues to play options in the
language chosen by the caller. All calls that are transferred using the default
language will use the supervision specified in the Feature Group.

Configuring a Multilingual Environment
If you have more than one language module in your company, you can set up a
multilingual environment in which callers can select the language to be prompted in
when using the voice menu and when speaking with an operator.
Before configuring a multilingual environment, you must have the following steps
completed:
1.

Installed the language prompts

2.

Licensed the language

3.

Pre-recorded the greetings in the language. For more information, refer
to Performing Supervisor Functions on page 317

Note: To verify that the language prompt you want to use is
installed on your machine, use Windows Explorer and
navigate to C:\UM\Prompts\System\ and you should see
numbered folders. See the following table for a list of folder
numbers and the language each represents:
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Number

Language

1

English

2

French

3

German

4

Spanish

5

Italian

6

Cantonese

6510 UM Server Configuration Guide

Maintaining a Company

Number

Language

7

Mandarin

8

Japanese

9

Arabic

10

Farsi

11

Russian

12

Polish

13

Hungarian

14

Greek

15

Thai

16

Portuguese

17

Dutch

After ensuring that the above steps have been completed, you can begin
configuring a multilingual environment. The configuration of a multilingual
environment consists of three steps:
1.

Configure company languages and schedules

2.

Select language greetings for business hours

3.

Enable transfer supervision

To configure company languages and schedules:
Configuring languages and schedules allows you to designate an operator and
greeting to a specific language, as well as indicate what time the message should
be played.
1.

In the 6510 Admin, right-click the company and select Properties. The
Company dialog appears.

2.

Click the Company Languages tab. The Company Languages tab
appears, displaying the languages available.

Note: The company languages available depend on the language
modules you have installed.
3.

Click Add to add language properties or highlight a language and click
Edit to edit its properties. You can also highlight a language and click
Remove to delete a language. The Language Properties dialog appears.
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• In the Language drop-down list, select the language.
• In the Operator drop-down list, select the operator to transfer to.
• In the Greeting drop-down list, select the voice menu number to use
as the greeting. This greeting must be pre-recorded in order for it to
appear in the drop-down list.

• Click the Select as Default checkbox if you want to specify the current
settings as default.
4.
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Click Schedule to create a specific schedule for the language.
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Provide the following information to schedule the operator:

• Select the Schedule Enabled checkbox to enable schedule.
• In the Default Operator drop-down list, select the default operator to
use if selected operator is unavailable.

• In the From Year/Month/Day/Time drop-down lists, indicated the
time when the selected operator is to be enabled. Select the All Day
checkbox if you want the operator to be enabled all day.
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• In the To Year/Month/Day/Time drop-down lists, indicate when the
selected operator is to be disabled.

• In the Sun, Mon, Tue, Wed, Thur, Fri, Sat, or Everyday checkboxes,
select what day you want the operator to be enabled.

• In the Operator drop-down list, select the Operator whom you want
to enable.
5.

Click Save Schedule to save settings.

To select the language greetings for business hours:
Selecting business hours greetings allows you to define which common
greeting to play (language-wise) and the time it should be played
1.

In the Company Advanced tab, click Business Hours. The Business Hours
dialog appears.

2.

From the Closed Greeting drop-down list, select the closed greeting in
the language that you want the system to play when callers call outside
of business hours.

Note: For information on recording a closed greeting, refer to
Recording a Company Greeting on page 323.
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• In the From field, scroll to the time (hours and minutes in military format) that the greeting is to start or enter the time in the field.

• In the To field, scroll to the time (hours and minutes in military format)
that the greeting is to end or enter the time in the field.
Note: Select the All Day checkbox if you want the greeting to play
for the entire day. If no time is entered, the system will
assume all hours.
A value of From 13:00 to no value indicates 1:00 PM to
midnight. The maximum value is 23:59 and the minimum
value is 0:00.
Other than a no value, the From field cannot be greater than
the To field.

• Select the days of the week that you want the greeting to run.
• If you want the message to run every day, select Every day.
3.

From the Greeting drop-down list, select the open greeting in the
language that you want the system to play during the specified time.

4.

Click Save Schedule.

To enable transfer supervision:
By selecting Language in the Transfer Supervision option, the system will be able to
handle calls in the language that is selected by the caller in the common greeting.
1.

In the 6510 Admin tree, click Feature Group. The list of feature groups
appear in the right pane.

6510 UM Server Configuration Guide

157

Maintaining a Company

2.

Double-click a Feature Group and click the Transfer Options tab. The
Transfer Options tab appears.

3.

In the Transfer Supervision box, select Language.

4.

Click Save Feature Group.

5.

Repeat steps 1-4 for every Feature Group that you want language
supervision enabled.

Your multilingual environment is now set up.
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Specifying the C.O./ Channel Assignment
Line Answering parameters define how the telephone system and the 6510 UM
auto attendant system ports are utilized. When more than one company shares the
same telephone system, it is possible to set-up the system with "Floating Ports."
This means both companies share the same Inbound Ports.
However, the C.O. Lines used by each company must be identified so that the 6510
UM system knows which company greeting to play. For example, if you have two
companies using a four port system and each company has two incoming C.O.
Lines, dedicate C.O. Lines one (1) and two (2) for company A, and dedicate C.O.
Lines three (3) and four (4) for company B. Both companies will use Inbound Ports
one (1) to four (4), or as many as you have installed.
Hint: When there is only one company, there is no need to dedicate
any C.O. lines. These assignments do not have to be
independent of one another if you setup multi-tenanting
with CO Line assignment, under voice channel allocation you
must configure channels that have been allocated to this
particular company.
If 6510 UM is set up for only one company, follow the outline
for a single company. For multiple companies, follow the
outline for Multi-Tenanting.

To specify the C.O. Assignment:
1.

Click C.O./Channel Assignment. The C.O. Assignment dialog appears.
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2.
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In the C.O. Assignment box, click Add. The C.O. Assignment dialog
appears.
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3.

In the From and To fields, enter the number of C.O. Lines the system
uses to receive incoming calls and click OK. The C.O Assignment box lists
the C.O. Lines that you have specified.

For All Company Configurations, enter the number of C.O. Lines that
the system uses to receive incoming calls in this field.
Note: If your telephone system does not have C.O. Line
identification, you may simulate C.O. Line identification. Set
up the C.O. Lines to ring into real extensions that are
programmed to forward all calls to 6510 UM Pilote. On the
"Inband Parameters" screen, enter the inband that you would
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normally receive from a forwarded extension into the
Parameter 190 - "Inband Outside C.O. Call". On the company
screen, enter the extension number of this forwarded
extension in the C.O. Lines field.
For example, Extension 123 is to be used to identify a call for
company A. The code sent by the telephone to 6510 UM is
99E. In parameter 190, enter 99E. On the company screen, in
the C.O. Lines field enter From: 123 and To: 123.
Companies must be listed sequentially according to C.O. Line
Number whenever multi-tenanting based on CO Line Number
is used.
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4.

In the Voice Channel Assignment box, click Add. The Voice Channel
Assignment dialog appears.

5.

In the From field, enter the first voice channel.

6.

In the To field, enter the last voice channel.

7.

Click OK. The Voice Channel Assignment box lists the voice channels that
you have specified.
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8.

Complete the channel configuration for the company by specifying the
corresponding channel in the fields below:

9.

In the MWI/Notification Channels field, enter the specific port on the
UM that you want to use for phone notification. (For the message waiting
light).

Note:
10.

You can allocate anything from 1 to all ports. You can also
dedicate specific ports for each company.
In the Wakeup Call Channels field, enter a specific port (voice channel)
that is different from notification if the company is using the wakeup call
feature.
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11.

In the Mass Recall Channels field, enter the special notification function
that continuously notifies the user of new messages until the messages
are listened to.

Note: This field can have dedicated channels. For light usage they
can be the same as the notification ports.
12.

In the Desktop Channels field, enter number of channels that will be
used to play back messages. (From Outlook and UM Client).

Note: It is recommended you allocate separate ports for desktop
from notification to eliminate the chance of collision between
the two events
13.
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Click Save Company.
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Examples for Configuring Multi-Tenanting
The 6510 UM server offers two configuration setups for supporting multiple
companies:

• Assigning specific C.O. trunks to a specific company
• Assigning specific voice mail ports to a specific company
By setting up one of these two scenarios, you can support multiple companies for
answering and transferring calls on the UM server. This allows you to create a set of
independent attributes related to the automated attendant and the answering
functions for each company or department configured.
The best solution is to dedicate C.O. channels. This allows you to allocate all voice
ports to every company this way they are sharing the voice channel resources and
do not have to factor in busy and non busy periods. You will be optimizing your
voice channels and your automated attendant if you configure Multi-tenanting with
C.O. assignments vs. Voice channel assignments. Only use voice channel
assignments when the PBX is unable to send you information on the incoming C.O.
call via the voice port. In these circumstances your only choice becomes voice mail
port assignment.
6510 UM will allow an unlimited number of company creations. However, for
practical purposes, you will be limited by the number of C.O. lines or voice channels
the system is configured for.

Configuring Multi-Tenanting using C.O.Line Assignment
In this scenario, all voice ports are added to all companies.

To configure multi-tenanting using C.O. Line Assignment:
1.

Open a company from the Administration Console.

2.

Click the C.O./Channel Assignment tab. The C.O./Channel Assignment
dialog appears.
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Note: Make sure that all the voice mail extensions are listed in the
voice channel assignment box.
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1.

Click Add. The C.O. Assignment dialog appears.

2.

Add the C.O. lines that belong to the specific company. For example, for
in the From field, enter 01. In the To field, enter 04 and click OK. The
C.O. Assignment box lists the C.O. lines specified.
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3.

Repeat this sequence for non sequential dedication. For example, if you
want to configure lines 1-3 and lines 7-8 to company one, click Add and
add each sequence independently.
If you are adding one line, fill in the From field and leave the To field
blank.

4.

Once you have assigned the C.O. lines to this company, click
to
advance to the next company. Repeat steps 1-2, but dedicate a different
set of C.O. lines to this company. For example, in the From field, enter
05 and in the To field enter 010. Repeat these steps for any other
company that is required for your multi-tenanting setup.

5.

Complete the channel configuration for each company by specifying the
corresponding channel in the fields below:
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6.

In the MWI/Notification Channels field, enter the specific port on the
UM that you want to have responsibility for message lights and out dial
notification.

Note: You can allocate anything from 1 to all ports. You can also
dedicate specific ports for each company.
7.

In the Wakeup Call Channels field, enter a specific port (voice channel)
that is different from notification if the company is using the wakeup call
feature.

8.

In the Mass Recall Channels field, enter the special notification function
that blasts out notification and turns off once one recipient responds.

Note: This field can have dedicated channels. For light usage they
can be the same as the notification ports.
9.

In the Desktop Channels field, enter the voice channel to use when
playing back messages from your desktop to your phone. This will resolve
conflicts with notification.

Note: It is recommended you allocate separate ports for desktop
from notification to eliminate the chance of collision between
the two events
10.

Click Save Company.

Note: The configuration function in each tab of a company setup
can be independent and different for each company. This
provides true differentiation and multi-tenanting.

Removing a C.O. Line Assignment
You can remove a C.O. Line Assignment from a company.

To remove a C.O Line Assignment:
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1.

Open a company from the Administration Console.

2.

Click the C.O./Channel Assignment tab. The C.O./Channel Assignment
dialog appears.

3.

Highlight the C.O. Line Assignment that you want to delete and click
Remove.

4.

Click Save Company.
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Configuring Multi-Tenanting using Voice Mail Port Assignments
Many telephone systems do not provide C.O Line identification; however, it is still
possible to configure 6510 UM with multiple companies by assigning a specific
voice port to a particular company. All calls received by this port will be answered by
that company's greeting.
Note: This method dedicates your voice ports directly to each
company. The number of possible companies is limited to the
number of voice cards that fit in the computer (Server).
In this scenario make sure that you go to each company created and you add all
C.O. lines to all companies. Then add specific voice mail ports to each specific
company. Now when a call comes in on a specific voice channel, the system knows
which company to answer with. In this scenario you will also need to program you
telephone switch to forward specific C.O. lines to specific phone extensions that will
be connected to the particular voice mail ports. (See your switch programming
manual for more information).

Special Considerations
When using this method, 6510 UM must be able to access at least one voice port to
perform several tasks. The most common of these tasks is Message Waiting
Indication. When a message is received or retrieved, an inband code is sent to the
telephone system that activates/deactivates an extension's message waiting
indicator.
Caution: Although Mitel Networks uses CTI for Message Waiting Indication, if
you are using other switches, it is best to dedicate the last port for all
notification functions. Do not assign this port to a company.
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Port Assignment
You must assign the port numbers for each company to answer. For example, if you
have three companies sharing a 4-port system, you should dedicate port one (1) to
Company A, port two (2) to Company B, and port three (3) to Company C. Port
four should be dedicated to Message Notification.
To assign these values on Company A, enter 1 in the "To" and "From" fields. For
Company B, enter 2 in the same fields, and enter 3 for Company C.

To configure multi-tenanting using V.C. Assignment:
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1.

Open a company from the Administration Console.

2.

Click the C.O./Channel Assignment tab. The C.O./Channel Assignment
dialog appears.

3.

In the Voice Channel Assignment box, click Add. The Voice Channel
Assignment dialog appears.

4.

For this example, in the From field, enter 1, in the To field, enter 2 and
click OK. The Voice Channel Assignment box lists the ports that you have
specified.
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5.

Once you have assigned the Voice Channel ports to this company, click
to advance to the next company. Repeat steps 3-4 but dedicate a
different set of voice channel ports to this company. For example, in the
From field, enter 3 and in the To field enter 4. Repeat these steps for
any other company that is required for your multi-tenanting setup.

6.

Complete the channel configuration for each company by specifying the
corresponding channel in the fields below:

7.

In the MWI/Notification Channels field, enter the specific port on the
UM that you want to have responsibility for message lights and out dial
notification.

Note: You can allocate anything from 1 to all ports. You can also
dedicate specific ports for each company.
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8.

In the Wakeup Call Channels field, enter a specific port (voice channel)
that is different from notification if the company is using the wakeup call
feature.

9.

In the Mass Recall Channels field, enter the special notification function
that blasts out notification and turns off once one recipient responds.

Note: This field can have dedicated channels. For light usage they
can be the same as the notification ports.
10.

In the Desktop Channels field, enter the voice channel to use when
playing back messages from your desktop to your phone. This will resolve
conflicts with notification.

Note: It is recommended you allocate separate ports for desktop
from notification to eliminate the chance of collision between
the two events
11.

Click Save Company.

Removing a Voice Channel Assignment
You can remove a Voice Channel Assignment from a company.

To remove a C.O Line Assignment:
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1.

Open a company from the Administration Console.

2.

Click the C.O./Channel Assignment tab. The C.O./Channel Assignment
dialog appears.

3.

Highlight the Voice Channel Assignment that you want to delete and
click Remove.

4.

Click Save Company.
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In This Chapter . . .
Overview on page 174
Displaying Summary Information on page 174
Opening a Mailbox on page 174
Using the Toolbar Buttons on page 175
Creating a Mailbox on page 176
Editing a Mailbox on page 225
Deleting a Mailbox on page 225
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Overview
Using the 6510 UM, you can create multiple mailboxes, including those that
you create just to play a message.
Note: The number of mailboxes that you can create is limited by
your product license.

Displaying Summary Information
The Administration Console displays a summary of the details for each mailbox
associated with a company. These details include the mailbox Name, the Feature
Group that it is associated with, and the Status.

Opening a Mailbox
You can open all mailboxes from the Administration Console.

To open a mailbox:
1.

Highlight Mailbox. All associated mailboxes appear in the right pane.

2.

Double-click on a mailbox. The General dialog appears.

Note: Once you have opened a mailbox, you can open another
mailbox by clicking on the scroll buttons.
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Using the Toolbar Buttons
There are 13 buttons that allows you to perform various tasks within the Mailbox
application.
Button

Name

Function

Create Range of Mailboxes

Create more than one mailbox at a
time, with sequential mailbox
numbers

Add, Create Mailbox/Distribution
List/Directory Listing/Schedule Item

Add and create a mailbox,
distribution list

Reset Mailbox

Resets mailbox

Delete Mailbox/Distribution List/
Directory List/Schedule

Delete the mailbox or distribution list

Save Mailbox/Distribution List

Save the mailbox or distribution list

Refresh Mailbox/Folder

Refreshes and updates mailbox/folder

Find Mailbox

Find a mailbox

Mailbox Clipboard

Adds configured items to clipboard so
that they can be pasted to other
mailboxes

Paste from Mailbox Clipboard

Pasting clipboard items to another
mailbox

Browse

Browse through different mailbox
configurations
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Creating a Mailbox
After you have installed 6510 UM, you can create a voice mailbox for each user in
your company.

To create a mailbox:
1.

Highlight Mailbox in the Administration Console.

2.

Click Add New Mailbox. The General dialog appears.

Note: You can also open the Mailbox dialog by double-clicking on
an existing mailbox. The Mailbox dialog will display the
details of the existing mailbox. Click Create New Mailbox to
open the next mailbox in sequence.
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Specifying General Options
The General dialog allows you to control options such as Mailbox Number, First
and Last Name, User Name, Feature Group, Department, Extension, Account Code,
Numeric Password, and POP3/IMAP4 Password.

To specify general options:
1.

6510 UM automatically increments the Mailbox Number by one. If you
want to change it, enter the new mailbox number in the Mailbox
Number field.

• In the Last Name field, enter the last name of the user.
• In the First Name field, enter the first name of the user.
• In the User Name field, enter the user name.
• From the Feature Group drop-down list, select a feature group that
the user will be associated with.

• In the Department field, enter the department that the user is associated within the company.
Note: This is used for administrative purposes only.
2.

In the Account Code field, enter the account number. This is used to
pass account number information for toll charges billing back to an
individual user.

Note: The Address field displays the current default address set for
the mailbox.
3.

Click Save Mailbox.

4.

To create another mailbox, click Create Mailbox.

Note: When you click Create Mailbox, a new record screen appears
with the next sequential number after the highest mailbox
created. If you want to change this number, enter it in the
Mailbox Number field.
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Setting a Numeric Password
Setting a numeric password allows a user to ensure the security of the contents in
the mailbox.

To set a numeric password:
1.

In the Password field, enter the user’s password.

2.

In the Confirm Password field, enter the user’s password again.

3.

Click Save Mailbox.

Setting a POP3/IMAP4 Password
You can set a POP3 or IMAP4 password.

To set a POP3/IMAP4 password:
1.

In the Password field, enter the user’s password.

2.

In the Confirm Password field, enter the user’s password again.

3.

Click Save Mailbox.

Specifying Advanced Features
The Advanced dialog allows you to specify the Personal Operator and the Message
Playback Mode. You can also create a distribution list that can be used to send a
voice mail to more than one mailbox.

To specify advanced features:
1.
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Click the Advanced tab. The Advanced dialog appears.
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2.

From the Personal Operator drop-down list, select a personal operator
if you have a different person as your operator.

Note: This field is optional, but if you select an operator, you must
also specify a mailbox.
This mailbox is recognized as the operator for this individual.
When this feature is activated, a caller receives the
individual’s personal greeting. However, when the caller
presses zero (0) to transfer to the receptionist, they are
transferred to the mailbox specified in this field.
3.

In the D.I.D Trunk field, enter the trunk number that the system will use
to access the voicemail of this particular user. This field is normally used
for Norstar Systems.

4.

From the Active Greeting drop-down list and select a mailbox greeting.
The telephone system sends additional digits other than the user's
extension number (such as DID or virtual trunk numbers).
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Note: If you select Notset, 6510 UM plays one of the 3 preconfigured greetings (no-answer, busy, and gone home),
depending on the status of the Mailbox. If an optional
greeting is required for this mailbox, enter the optional
greeting number.
5.

Select the Customized Mailbox checkbox if you use a different
customized mailbox menu. The default customized mailbox will play
automatically if nothing is selected.

6.

Click Browse to browse the customized mailbox. (Browse is only enabled
if you select Customized Mailbox and choose the customized mailbox
first).
Select the Voice Menu checkbox to have the user’s calls answered with
a customized voice menu offering callers a variety of choices. From the
drop-down list, select a voice menu to use for this mailbox.
Click Browse to browse the voice menus.

Note: A voice menu must be created before it can be applied to a
mailbox. For more information, refer to Using the Voice Menu
Dialog on page 303.

• Select Tutorial if you want the user to be prompted with the tutorial
when voicemail is accessed.

• Select Desktop Access to enable Options. This must be selected if the
user is going to use Web Client.
7.

All messages are tagged with a Date and Time stamp. Select Say Date
and Time if you want the user to hear the time and date stamp before
every message.
Users can listen to their messages by either FIFO or LIFO.
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FIFO (First In, First Out)

FIFO plays the oldest message first and the
newest message last.

LIFO (Last In, First Out):

LIFO plays the newest message first.

8.

Select LIFO or FIFO.

9.

Click Save Mailbox.
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Specifying MSS Options
MSS options are used to specify the user as a Unified Messaging client. By activating
MSS and the options, the 6510 UM synchronizes the selected options with the MSS
server., e-mail server and voice mail server.
MSS Option

Function

MSS User

Activates synchronization for this user with their e-mail
account.

MSS Receive Emails

Synchronize e-mail over the phone.

MSS Receive Faxes

Synchronize faxes over the phone.
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Creating a Distribution List
Instead of sending the same e-message to one user at a time, you can create a
distribution list consisting of one or more mailboxes. This allows you to send the
message to multiple recipients.

To create a distribution list:
1.

In the Mailbox dialog, click the Advanced tab. The Advanced tab
appears.

2.

Click Distribution Lists. The Distribution List dialog appears.

3.

In the List Number field, enter the number that you want to assign to
this list.

4.

In the List Name field, enter the name that you want to assign to this
list.

5.

In the Mailbox No. box select the mailboxes that you want to include in
the distribution list and click Add. (If you want to add the whole directory
of mailboxes, click Add All). The site is added.

6.

In the Site No. box, select the sites that you want to include in the
distribution list and click Add. For this to be enabled, you must have
AMIS or VPIM set up. (Click Add All to add the entire directory).

7.

Enter the remote site number and click OK. The site is added.

8.

In the E-mail field, enter any additional e-mail address that you want to
be included in the distribution list (for example,
joerandolph@canada.com). SMTP must be configured in order for E-mail
to function.

9.

The Distribution List box will list all the addresses and sites that you
have added.
If you added mailboxes and alternate e-mail addresses, your list may look
like this:
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10.

Click Save Distribution List.

11.

You can always remove addresses and sites from the list by selecting the
site/address and clicking Remove.

Note: When you have created multiple distribution lists, you can
conveniently access each one by using the Go To drop-down
list and select it in the distribution list name.
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Creating a Folder
You can create custom folders in the user’s mailbox for message storage. The
folders created will automatically be created in another message server (for
example, fax) when this user is bound for Unified messaging (MSS).

To create a folder:
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1.

In the Mailbox dialog, click the Advanced tab. The Advanced tab appears.

2.

Click Folders. The Folders dialog appears.

3.

Highlight the folder you want the sub-folder to be created under and
click Add. The Add Folder dialog appears.

4.

In the Folder Name field, enter the name of the new folder and click
OK. The Folders dialog displays the new folder.
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Deleting a Folder
You can delete any folder that you have created with the exception of system
folders (for example, Outbox).

To delete a folder:
1.

Click Folders. The Folders dialog appears.

2.

Highlight the folder you want to delete and click Delete. A message
appears, prompting you to confirm the deletion of the folder.

3.

Click Yes.

Renaming a Folder
You can rename any folder with the exception of a system folder.

To rename a folder:
1.

Click Folders. The Folders dialog appears.

2.

Highlight the folder you want to rename and click Edit.

3.

Enter the new name for the folder and press Enter.
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Refreshing a Folder
Click Refresh to restore any partially deleted information.

Creating a Directory Listing
6510 UM allows the user to create different versions of their name and store these
versions in the company directory. The mailbox must be set in a feature group that
has the company directory feature set.
In the mailbox, a user can define multiple names that are used for directory
purposes (for example, first name, last name, or maiden name).
When a mailbox is created and the first name, last name and username are
specified, the information is automatically inputted into the Directory List window.
While in this window, you can add and move these names if necessary.

To create a directory profile for the user:
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1.

Click Directory Listing. The Directory Listing dialog appears.

2.

Click Add. The New Directory Listing dialog appears.
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3.

Enter an alternate spelling of the user’s name and click OK. The Directory
Listing dialog appears and displays the new listing.

4.

Close the window and click Save Mailbox.

Renaming a Directory Listing
6510 UM gives you the option of renaming an existing directory listing.

To rename a directory listing:
1.

Open the directory listing for the mailbox.

2.

Click Edit.

3.

Make the required changes.

4.

Close the window and click Save Mailbox.

Deleting a Directory Listing
You can delete a directory listing.

To delete a directory listing:
1.

Click Directory Listing. The Directory Listing dialog appears.

2.

Highlight the directory listing that you want to delete and click Delete.

3.

Close the window and click Save Mailbox.
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Creating a Buddies List
Creating a Buddies List allows you create a list of users within your company. This
list can be conveniently accessed through your UM Client Manager, and you can
broadcast messages to the members of your list through Lan Talk.

To create a buddies list:
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1.

In the Mailbox>Advanced tab, click the Buddies List button. The
Buddies List dialog appears.

2.

In the List Number field, enter a number for the list that you are
creating.

3.

In the List Name field, enter a name for the list that you are creating.

4.

Under Mailbox No./Name, highlight the user that you want to add to
the Buddies List.

5.

Click Add. The user is added under the Buddies List column.

6.

Repeat steps 4 and 5 for all the users that you want to add.
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Note: You can click Add All to add all the users at one time.
7.

Click Save.

Specifying the Transfer Options
The Transfer Options dialog allows you to specify the transfer options currently
active for each mailbox. Transfer Options include Call Screening, Call Forwarding,
Status, Call Queuing, and paging capabilities.
Note: The user can change the transfer options using either TUI or
GUI only if permission is given in the feature group.

To set the transfer options:
1.

Click the Transfer Options tab. The Transfer Options dialog appears.
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2.

Select Call Screening if you want the system to instruct callers who wish
to transfer to an extension to state their name at the tone.

Note: Call screening requires the call to be supervised and the user
must be in his or her group.
Before the call is transferred, the user hears the caller's name and be
prompted by the system to accept the call press <1>, to send to another
extension press <2>, to accept press <3>, to send to your mailbox press
<#>.
Select Call Queuing if you want incoming calls to be placed in a queue
when an extension is busy. Callers are informed of their position in the
hold queue and given opportunities to either continue to hold or leave a
voice message.
Caution: Call Queuing is only available on telephone systems that provide
a busy tone. Most telephone sets with multiple extension
appearances do not produce a busy tone.
3.

Select Pre Transfer Paging if you want a user to be paged before the
call is transferred. When a caller requests an extension, the caller is put
on hold and the 6510 UM system pages the user. The system then waits
for a definable period of time (this timer is defined in the PBX Advanced
dialog with a default of 5 seconds) and then transfers the caller to the
desired extension.

4.

Select Post Transfer Paging if you want the user to be paged after the
call is transferred. When a caller transfers to an extension that is busy or
is not answered, the caller is forwarded to the user's mailbox. In the
user's personal greeting, the caller can be given the option to page the
user over the telephone intercom system (for example, "Press 4 to have
me paged"). Callers must be informed of the paging feature in the user's
personal greeting. The system does not have a pre-recorded prompt.

5.

From the Caller ID drop-down list, select the desired option to get the
caller ID.

Note: This option is required for desktop screen pops using UM
Client Manager.
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Caller ID

Function

None

Turns off screen pops on desktop access.
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Ask

Prompts caller to input their phone number prior to transferring
the call. This information will be used in screen pops if the user
has desktop access.

POP

Provides a screen pop up even if caller ID information does not
exist.

Ask and Pop

Asks the caller to manually input their number so it can be used
in the screen pop if no caller ID is available from the phone
system or not passed by the telco. This guarantees a number on
all incoming calls to that user.

From the Status drop-down list, select the current status of the user and
the mailbox. An appropriate greeting will play for each state.

6.

Status

Greeting

In office

System rings at your desk and plays the users set Active
greeting

Lunch time

Plays user’s name and the prompt ”is out to lunch & will
return at” the defined available at time

Busy

Goes directly to voice mail and plays busy greeting

Gone home

Goes right to voice mail & plays gone home greeting

Do Not Disturb

Goes directly to voice mail and plays personal greeting

Meeting

Plays user’s name and the prompt ”is in a meeting & will
return at” the defined available at time

Out of town

Plays user’s name and the prompt ”is out of town & will
return at” the defined available at time

Vacation

Plays user’s name and the prompt ”is on vacation & will
return at” the defined available at time

No Answer

Rings the desk then forwards to voice mail and plays the
user’s No Answer greeting

Note: Once a Status is changed or defined, it will take time for the
change to appear in Outlook. (Approximately one minute). If
instantaneous change is needed, you must shutdown and
restart Outlook, and the new Status will be activated.
7.

Click Available at to indicate when the user will return if they set a
status that provides a “Return At” prompt.

8.

Select Call Forwarding Enable to forward calls from the automated
attendant to another mailbox
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9.

10.

From the Call Forward to drop-down list, select the mailbox that calls
will be transferred to.
Click Save Mailbox.

Specifying the Message Options
The Message Options dialog allows you to control messaging options.

Specifying the Message Forwarding Options
When a message is left for a user (voice, fax, or email), you can specify how the
system is to handle it.

To specify message forwarding:
1.
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Click the Message Options tab. The Message Options dialog appears.
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2.

From the Forward to drop-down list, select a destination type.

Destination

Function

Mailbox

Identifies another voice mail user on the system.

Distribution list

Defines a personal or global list to have the message forwarded
to. This may be used in system broadcasting purposes

AMIS/VPIM

Defines a network location and a specified user at that location.
Note: Selecting this option makes the Address field active.

E-mail

Defines a SMTP address to have the message automatically
forwarded to

Note: The Forward To field is only enabled if the Feature Group
that the mailbox belongs to is configured to allow message
forwarding.
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3.

From the Destination drop-down list, select the profile of the user based
on the type that you selected in step 2.

4.

In the After-hour(s) and After-minute(s) fields, enter the time interval
that the system should wait before forwarding the message to one of the
defined locations.

Note: If you leave this blank, the system will assume immediate
delivery.
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5.

Select Delete After Forward (Yes) to delete the message after the
system has forwarded it to either a mailbox or to a distribution list.

6.

Click Save Mailbox.
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Specifying Voice Mail, E-mail, and Fax Mail Options
The following options are used when the system is set for MAPI integration. They
are not required for MSS integration.

• Select Send e-mail with Voice Messages to enable the sending of
e-mail with voice messages.

• Select Attach Voice Mail to E-mail to enable the attachment of voice
mail to e-mails.

• Selecti Send E-mail with Text Messages to enable the sending of
e-mails with text messages.

• Select Attach Text File to E-mail to enable the attachment of text
files to e-mails.

• Select Send E-mail with New Faxes to enable the attachment of emails to faxes.

• Select Attach Fax File to E-mail to enable the attachment of fax files
to e-mails.

• Select Optical Character Recognition to enable optical character recognition on faxes.

Specifying the Notification
The Notification tab allows you to specify internal or external addresses that can
be used to notify a user that they have received new messages. Notification options
include the ability to receive notification via message lights, pager, or telephone,
and options to allow or deny outcalling and long distance dialing.
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Specifying the LAP Options
LAP is an additional module that enables users to be notified of incoming calls and
messages to a pager they is logged into a local area transmitter. The voice mail has
the ability to send a packet string to the transmitter, which sends a wireless signal
to the user’s pager. Define the following information for each LAP user under the
notification tab in their mailbox

To specify the LAP options:
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1.

Click the Notification tab. The Options tab appears.

2.

From the LAP Mode drop-down list, select either None (no notification),
Call (notify on incoming calls), Message (notify on new messages), or
Call&Message (notify on both new calls and new messages).

3.

In the Local Area Paging field, enter the pager cap code.
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4.

From the Pager Baud Rate drop-down list, select the baud rate
associated with the pager.

5.

From the Pager Type drop-down list, select the type of pager.

6.

Select the Cascade Notification checkbox if you want the system to
perform the cascade notification function.

Note: This feature is suitable for Technical Support or Sales
environments, where it is essential that incoming messages
are received. The Cascade Notification feature instructs the
system to send notifications in consecutive order to a list of
defined notification schedules. When a user at a notification
address defined in a schedule does not respond to a new
message, the system will proceed to notify the address
defined in the next notification schedule, and so on. The
system will continue to notify the addresses defined in the
schedules in cascading order until the number of retries for all
schedules have been exhausted. When all notification
schedules are exhausted, a user must check the pending new
message in order for the notification cycle to begin again. To
maximize the Cascade Notification feature, it is recommended
that all notification schedules are set to overlap, and that the
maximum number of retries for each schedule is 3 or less.See
Specifying Notification Addresses on page 200 for more
details.
7.

Select the Fax Mail checkbox to notify users of received faxes.

8.

Click Save Mailbox.

Specifying the Message Type
The Message Type option allows you to define different notification rules for
different media types such as voice mail, fax, or e-mail. Fax has the ability to turn on
or off while voice and e-mail can have specific notification rules.

To select a voice mail message type:
1.

Click the Notification tab. The Options tab appears.
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2.

In the Voice Mail box, select the appropriate checkboxes to indicate the
message type.

Message Type

Function

All

Notifies user of all voice mail messages
that are received

Urgent

Notifies user only if an urgent voice mail
message is received

With Caller ID

Notifies user only if voice mail message
is accompanied with caller ID

Certified

Notifies user only if voice mail message
is of a certified status (available only
with internal users)

Private

Notifies user only if voice mail message
is of a private status

Internal

Notifies user only if voice mail message
is from an internal user

External

Notifies user only if voice mail message
is from an external user

3.

Click Save Mailbox.

To select an e-mail message type:
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1.

Click the Notification tab. The Options tab appears.

2.

In the E-mail box, select the corresponding checkboxes to indicate the
message type.

Message Type

Function

All

Notifies user of all e-mail
messages that are received

Urgent

Notifies users only if an urgent email message is received

With Qualified Address

Notifies user only if e-mail
message is from a qualified email address
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Certified

Notifies user only if e-mail
message is of a certified status
(available only with internal
users)

Private

Notifies user only if e-mail
message is of a private status

Internal

Notifies user only if e-mail is from
an internal user address

External

Notifies user only e-mail is from
an external user address

3.

Click Save Mailbox.
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Specifying Notification Addresses
Conventionally, when a user is away from their desk, there is no way of being
notified that they have received an e-mail or voice message. 6510 UM has the
ability to notify a user if they have received any messages. For example, if a user has
received a voice mail message, you can instruct the system to notify them by an email message or call to their cell phone, home phone, or another e-mail account.

Adding a Phone Address
This feature allows you to define multiple phone numbers per user. You can define
a default number (usually a users phone extension) as well as optional numbers the
user can define so that the system can find them and connect the user with a caller.

To specify a phone address:
1.
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In the Notification tab, click the Notification Addresses tab.
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2.

Click Add. The Notification Address dialog appears.

3.

Select Phone.From the Phone drop-down list, select an extension.

Extension

Function

Internal Extension

Calls a telephone in the current PBX.

External Extension Dials outside the PBX via trunk access. The default is 9.
Note: If you select External Extension, the Country and Area/
City Code fields become active.

4.

From the Country drop-down list, select a country.

5.

In the Area/City Code field, enter the area or city code.

6.

In the Number field, enter the phone number.

7.

In the Busy field, enter the time to wait before retrying the number.

8.

In the No Answer field, enter the time to wait if no one answers before
the system retries. The default is 30 minutes.

9.

In the Call It field, enter the number of times a user should retry this
number to notify of a message. The default is 1 time.

10.

Click OK and Save Mailbox.

Adding a Beeper Address
This feature allows you to define multiple beeper addresses where a usercan be
notified.
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To specify a beeper address:
1.

In the Notification tab, click the Notification Addresses tab.

2.

Click Add. The Notification Address dialog appears.

3.

Select Beeper. The Beeper dialog appears.

4.

From the Country drop-down list, select a country.

5.

In the Area/City Code field, enter the area or city code.

6.

In the Number field, enter the phone number.

7.

In the Between Calls field, enter the minutes to wait between beeper
attempts. The default is 5 minutes.

8.

In the Call It field, enter the number of times to notify the beeper. The
default is 1 time.

9.

In the Send field, enter the script you want sent to a alphanumeric
pager. Your options are Custom script, plus “e” for extension & “N”
number of unread messages in the users mailbox.

10.

In the Wait field, enter the second the system should wait after
connecting with the beeper before sending the packets. The default is 0
seconds.

11.

Click OK and Save Mailbox.

Adding an E-mail Address
This feature allows you to define multiple e-mail addresses where a user can be
notified.
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Note: Adding an e-mail address requires SMTP Integration. For
more information, refer to Maintaining the Configuration
Files on page 29.

To specify an e-mail address:
1.

In the Notification tab, click the Notification Addresses tab.

2.

Click Add. The Notification Address dialog appears.

3.

Select E-mail. The E-mail dialog appears.

4.

In the E-mail Address field, enter the user’s e-mail address.

5.

Click OK and Save Mailbox.
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Editing a Notification Address
Currently configured notification addresses can be configured at any time.
To edit a notification address:
1.

In the Notification tab, click the Notification Addresses tab.

2.

Highlight a notification address and click Edit. The Notification Address
dialog appears.

3.

Make the required changes and click OK.

4.

Click Save Mailbox.

Deleting a Notification Address
You can delete a notification address if you no longer want to use it.

To delete a notification address:
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1.

Click the Notification Addresses tab.

2.

Highlight a notification address and click Remove. The system removes
the notification address from the display.

3.

Click Save Mailbox.
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Creating a Notification Schedule
You can create a notification schedule to specify a calendar setting for each
notification address. For example, you can schedule an e-mail notification to start
on one date and end on another.

To create a notification schedule:
1.

Click Schedule. The Notification Schedule appears.

Note: The system selects Schedule Enabled automatically. If you do
not want the schedule enabled, you must clear the selection.
2.

From the Default Address drop-down list, select the address to be used
for notification when Notification Schedule is not enabled.

• In the From/To – Year, Month and Day fields, enter the date that the
menu is to become active.

• In the From/To – Time fields, enter the time (in military format) that
the schedule is to become active.
Note: If no time is entered, the system will assume all hours.
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Select All day if the voice menu is to run all day.
A value of From 13:00 to no value indicates 1:00 PM to
midnight.
The maximum value is 23:59 and the minimum value is 0:00.
Caution: To create a Notification Schedule consisting of multiple notifications within a 24 hour period, you must create separate schedules. The From - Time field does not support a value that is
greater than that of the To - Time field. For example, a pager notification set to run from 17:00 (5pm) to 08:59 (8:59am) the next
day must be specified using two schedules. One that is enabled
from 17:00-23:59 and one from 00:00-08:59. Your From - Time and
To - Time fields should look like the following:
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• Select the days of the week that you want the message to run.
Hint: If you want the message to run every day, select Everyday.
You must arrange dates and times sequentially, from Monday
through to Sunday.
Warning: If two notification schedules are created and the days that they
are designated to run overlap, the system will choose to use the
default address. If the default address is not one of the
addresses specified in the schedules, the system will randomly
select an address.
3.

From the Address drop-down list, select the address that you are
creating a notification schedule for.

4.

Click Save Schedule.
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Specifying Addresses
The Addresses tab allows you to define the following multiple contact numbers
per user:

• default telephone number
• internal or external extension
• Centrex number
• e-mail address
• VPIM address
• fax number
• WAP number
• SMS address
• Reply to address
You can also set an automatic schedule to change the current address settings.

Displaying Existing Numbers for a User
Use the Addresses tab to display all phone numbers that have been assigned to a
mailbox.

To display all existing phone numbers:
1.
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Click the Addresses tab. The Addresses dialog appears.
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2.

Select All to display all phone numbers, e-mail addresses, and fax
numbers.

3.

Select Defaults to display the assigned default address.

4.

Select Only and select a number category from the drop-down list to
display specific numbers.
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Adding a Phone Number
You can add a phone number to the mailbox.

To add a phone number:
1.

Click Add and select Phone Number. The Address dialog appears.

2.

From the Type drop-down list, select a type.

Note: If you select either External Extension or Centrex Number,
the Country and Area/City Code fields become active.
If you select Internal Extension, the Message Light becomes
active.
3.

From the Country drop-down list, select the country in which the phone
is active.

4.

In the Area/City Code field, enter the area or city code for the phone
number.

5.

In the Number field, enter the phone number.

6.

Select the Message Light Assignment checkbox to activate the mailbox
extension that will be used for initiating message waiting lights.

Note: If you have some telephone sets that provide message
waiting lights and some that do not, make sure that separate
feature groups are assigned for each type of set. Deactivate
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the Message Light field for the Feature Group that does not
support this feature.
If you have any mailboxes that do not have a corresponding
telephone extension (for example, phantom mailboxes that
are used for voice menus, guest mailboxes) do not enable this
feature, as there are no message lights to activate
7.

Select the Set as Default checkbox to define this number as your default
address. Only one e-mail address, fax number, and phone number can be
specified as a default.

8.

Click OK.

Adding an E-mail Address
You can add an e-mail address to your mailbox.

To add an e-mail address:
1.

Click Add and select E-mail/VPIM. The Address (E-mail) dialog appears.

2.

In the Address field, enter the e-mail address.

3.

Select the Set as Default checkbox to specify the e-mail address as the
default and click OK.
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Adding a VPIM Address
Voice Profile for Internet Mail (VPIM) is an International Telecommunications Union
(ITU) standard that allows different types of messaging servers to pass voice and fax
messages among each other over the Internet.
Creating a VPIM address allows you to create and send a message to a remote user
mailbox or receives messages from the remote user located on a different
messaging server. This is performed via the network through a special protocol.
The VPIM address must be defined in order for the remote message to be received,
and your ID is also important to allow the remote user to reply to your message. The
Address may be defined as any number that can be different from your actual
mailbox number, which is useful in multi-tenanting situations.
Note: The Company Domain must be defined before you can add a
VPIM address. For more information, refer to Specifying
General Options on page 177.

To add a VPIM address:
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1.

Click Add and select E-mail/VPIM. The Address (E-mail) dialog appears.

2.

From the Type drop-down list, select VPIM. The Company Domain
appears beside the Address field.
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3.

In the Address field, enter the mailbox number to be associated with this
mailbox for VPIM addressing. When VPIM is installed, the system will
automatically create the VPIM address, giving it the same number as the
mailbox (for example, Mailbox 313 will have a VPIM address of
313@192.160.0.127).

Note: You can associate a different number with the mailbox if a
conflict exists in mailbox assignments for multi-tenant
systems that use the same VPIM setting (for example,
Company 1 and Company 2 both have a mailbox 313). When a
remote user sends a message to 313@192.160.0.127, the
system cannot resolve which user gets the message. The
mailbox 313 in Company 2 can be assigned VPIM address
413@192.160.0.127 and any remote VPIM message sent to
that account would be placed in mailbox 313 of Company 2.
4.
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Select the Set as Default checkbox to specify the VPIM address as the
default and click OK.

6510 UM Server Configuration Guide

Maintaining Mailboxes

Adding a Fax
You can add a fax destination number to your mailbox.

To add a Fax:
1.

Click Add and select Fax. The Address dialog appears.

2.

From the Country drop-down list, select a country.

3.

In the Area/City Code field, enter the area or city code.

4.

In the Number field, enter the fax number.

5.

Select the Set as Default checkbox to specify the fax number as the
default.

6.

Click OK.
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Adding a WAP number
You can add a wireless application device number to your mailbox.

To add a WAP:
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1.

Click Add and select WAP. The Address dialog appears.

2.

In the Type field, the system automatically enters the type as WAP.

3.

In the Country drop-down list, select the country in which the wireless
device is active.

4.

In the Area/City Code field, enter the area code or city code of the
wireless device phone number.

5.

In the Callback Number field, enter the phone number of the wireless
device.

6.

Select the Set as Default checkbox to specify the number as the default
WAP number.

7.

Click OK.
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Adding a SMS Address
You can add a SMS address as your notification address.

To add a SMS address:
1.

Click Add and select AddrSMS. The Address dialog appears.

2.

In the Address field, enter the SMS address.

3.

Click OK. The SMS address is added.

Adding a Reply To Address
You can add a Reply To address (a reply e-mail address) to your notifications.

To add a reply to address:
1.

Click Add and select Reply To. The Address dialog appears.

2.

In the Address field, enter the reply to e-mail address.

3.

Click OK. The Reply To address is added.
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Editing a Phone or E-mail Address
You can edit any existing phone or e-mail address.

To edit an address:
1.

Highlight the address that you want to edit and click Edit. The
appropriate dialog appears.

2.

Make the required changes and click OK.

3.

Click Save Mailbox.

Deleting a Phone or E-mail Address
You can delete any address with the exception of the default address.

To delete an address:
1.

Highlight the address that you want to delete and click Remove. A
message appears, prompting you to confirm the deletion of the address.

2.

Click Yes. The system removes the address from the display.

3.

Click Save Mailbox.

Configuring a Notification Schedule for Individual Mailboxes
Using the Notification Schedule feature, you can select a notification schedule that
specifies when and how long notifications should occur for individual mailboxes.

To configure a schedule:
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1.

Select a Mailbox No. you want to create a Notification schedule for.

2.

In the Notification dialog, click the Notification Addresses tab. The
Notification Addresses tab appears.

3.

Click

. The Notification Schedule dialog appears.
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4.

Follow the steps in Creating a Notification Schedule on page 205.

Specifying IMAP Properties
By specifying an IMAP account for the mailbox, you can integrate the mailbox with
the IMAP component.

To specify IMAP properties:
1.

In the Mailbox dialog, click the IMAP tab. The IMAP tab appears.

2.

In the User Name field, enter the IMAP server’s administrator’s name.

3.

In the User Password field, enter the administrator’s password.

4.

In the Confirm Password field, re-enter the administrator’s password
for confirmation.

5.

In the IMAP Server field, enter the IP address of the IMAP server.
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6.

In the IMAP Server Port field, enter the IMAP server port. By default, it is
143.

7.

In the Storage Mode drop-down list, select IMAP to store messages in
the IMAP store, or Database to store messages in the 6510 UM
database.

8.

Click Save.

Creating a Range of Mailboxes
Instead of creating a series of mailboxes one at a time, you can create a range of
mailboxes under a particular Feature Group. Once you have created the mailboxes,
you can go back and specify the options for each mailbox.

To create a range of mailboxes:
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1.

Click Create Range of Mailboxes. The Create Range of Mailboxes
dialog appears.

2.

In the From field, enter the first number in the range.

3.

In the To field, enter the last number in the range.

6510 UM Server Configuration Guide

Maintaining Mailboxes

4.

From the Group Name drop-down list, select the Feature Group that
you want the mailboxes to be associated with.

5.

Click OK.

Resetting the Mailbox
If you make a mistake when creating a mailbox or a mailbox is no longer needed for
an absent employee, you can reset a mailbox and create new properties instead of
deleting the mailbox and recreating it again.

To reset the mailbox:
1.

In the Mailbox Toolbar, click Mailbox>Reset. A message appears,
prompting you to confirm the resetting of the mailbox.

2.

Click Yes.

Finding a Mailbox
This feature allows you to search quickly for a mailbox to edit, configure, or delete.

To find a mailbox:
1.

In the Mailbox Toolbar, click Edit>Find. The Find: Mailbox dialog
appears.
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• Select By Mailbox No to search by mailbox number.
• Select By Last Name to search by a users last name.
• Select By First Name to search by a users first name.
2.

In the text field, enter the criteria you are looking for based on the
selected search method.

3.

Click Find. If the system finds a mailbox matching the search parameters,
it displays the General dialog.

Note: You can open the found mailbox by double-clicking it.
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Using the Mailbox Clipboard
If you want to create a range of mailboxes that all share the same characteristics,
you can use the Mailbox Clipboard function to copy the characteristics of an
existing mailbox and paste them to the new mailbox.

To copy mailbox features:
1.

Open the mailbox whose characteristics you want to copy to the new
mailbox.

2.

Click Mailbox Clipboard. The Mailbox Clipboard dialog appears.

3.

Highlight one or more characteristics and click Add.

Hint: To add all of the characteristics, click Add All.
4.

Click OK.

5.

Click Create Mailbox and Paste from Mailbox Clipboard. A message
appears, prompting you to confirm the pasting action.
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6.

Click Yes. The system pastes the original mailbox characteristics into the
new mailbox.

7.

Modify the new mailbox and click Save Mailbox.
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Editing a Mailbox
You can edit the settings of any mailbox that you create.

To change a mailbox:
1.

Open the mailbox that you want to change.

2.

Make the required changes and click Save Mailbox.

3.

Click Next Mailbox or Previous Mailbox to select another mailbox to
edit, or close the General dialog.

Deleting a Mailbox
You can delete a mailbox either from the Administration Console or from any of the
five dialogs after you have opened it.

Deleting from the Administration Console
To delete a mailbox in the Administration Console:
1.

Highlight Mailbox. The Administration Console displays all existing
mailboxes.

2.

Highlight the mailbox that you want to delete and click Delete. A
message appears, prompting you to confirm the deletion.

Note: The Delete button becomes active after you highlight a
mailbox.
3.

Click Yes. 6510 UM remove the mailbox from the Administration
Console.

Deleting from a Dialog
You can delete a mailbox from any of the five dialogs after you have opened the
mailbox.
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To delete a mailbox from a Dialog:
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1.

Click Delete Mailbox. A message appears, prompting you to confirm
the deletion.

2.

Click Yes. The system displays the General dialog of the next mailbox in
order.
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In This Chapter . . .
Overview on page 228
Opening a Feature Group on page 228
Using the Toolbar Buttons on page 229
Creating a Feature Group on page 230
Editing a Feature Group on page 251
Deleting a Feature Group on page 252

6510 UM Server Configuration Guide

Maintaining a Feature Group

Overview
A feature group contains a series of mailboxes that have been assigned the same
features and functions. These features include recording limits, message expiration,
notification, transfer supervision, transfer options, and mailbox options.
Each feature group can be customized for a specific office or application. For
example, multilingual feature groups may be created to meet the needs of a
multicultural staff or customers. Different group configurations can be created for
executive mailboxes or offsite users who are not physically at the location.

Opening a Feature Group
You can open an existing feature group from the Administration Console.

To open a feature group:
1. Expand a company and highlight Feature Group. The 6510 UM
displays all feature groups associated with that company.

2. Double-click on a feature group. The General dialog appears.
Note: Once you have opened a feature group, you can open
another group by clicking on the scroll buttons.
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Using the Toolbar Buttons
There are convient toolbar buttons that allow you to perform various tasks with the
Feature Group application.
Button

Name

Function

Create Feature Group

Creates a feature group (Located
in the main 6510 Admin)

Open Feature Group

Opens a feature group (Located in
the main 6510 Admin)

Delete Feature Group

Deletes a feature group

Create Feature Group

Create a new feature group from
an existing group

Save Feature Group

Saves a feature group

Refresh Feature Group

Refreshes the feature group

Navigation Keys

Navigates through the different
Feature Groups (only enabled if
there is more than one feature
group)

Enabling and Disabling Features
Once a Feature Group has been created, you can enable and disable many of these
features, including Call Screening, Call Queuing, Do Not Disturb, Pre-Transfer
Paging, Post-Transfer Paging, Login/Logout, Call Forwarding, Notification, and
Message Forwarding. These settings may be also be changed when a user calls into
their mailbox and accesses the "Options" menu.
Note: You can activate features for individual users or deny them
the ability to disable these features. To do this, enable the
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feature on the user's status screen, and disable the feature in
the Feature Group that their mailbox is associated with.

Creating a Feature Group
6510 UM allows you to add as many feature groups as you have mailboxes.

To create a feature group:
1. Select Feature Group from the Administration Console.
2. Click Add New Feature Group. The General dialog appears.
Hint: You can also open the General dialog by double-clicking on an
existing feature group. The General dialog displays the
details of the feature group that you open. Click New Feature
Group to clear the dialog.
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Specifying General Options
The General dialog allows you to assign a name, mailbox and caller language to
the feature group.

To specify general options:
1. The Group Number field displays the next number in sequence. If
you want to change the group number, enter a one to two digit
number (from 1 to 99).
Note: The system fills in this field automatically.
2. In the Group Name field, enter the name of the Feature Group.
3. From the Mailbox Language drop-down list, select the default
language Users hear when picking up messages.
4. From the Caller Language drop-down list, select the default
language that the caller is greeted with if he or she does not
choose a language when prompted by the automated attendant.
5. From the Message Format drop-down list, select the format the
messages will be stored and played back in.
Note: If you are integrating Lotus Notes with the 6510 UM system
you must select the WAV format and must use the Dialogic
JTC voice card.
6. From the Greeting Format drop-down list, select the format the
system will use to record the personal greetings for the users in
this feature group in.
Note: The select available for steps 5 and 6 are defined by the type
of board drivers that are loaded on the system.
7. Click Save Feature Group.
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Assigning Storage Options
The Storage Options dialog allows you to assign storage limitations for all users
associated with the feature group. For example, you can limit the number of new
and saved messages allowed, the length of a message, and the number of days that
a message can be saved for a given mailbox.

To assign storage options:
1. Click the Storage Options tab. The Storage Options dialog
appears.

• In the Maximum Number of Messages field, enter the maximum
number of messages (includes new, saved and messages deleted that
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day) that are allowed for each mailbox associated with this feature
group. The default is 200.
Hint: The maximum messages value should be based on the needs
of the user. You should allow more than enough message
storage space for each user to make sure that no messages
get lost when a mailbox reaches load capacity. Ten
megabytes of hard drive space is equal to approximately one
hour of voice message storage.

• In the Maximum Message Length field, enter the maximum length
of time that a caller may use to record a voice message.
Note: This number is specified in seconds. This value should be set
higher than the anticipated message length to ensure that
callers are not disconnected in the middle of their messages.

• In the Maximum Greeting Length field, enter the maximum number
of seconds that a mailbox greeting may be. Typically the default (120
seconds) is sufficient for most applications. However, if there is a mailbox that provides lengthy information to callers, you may need to
increase the time.

• In the Days to Keep Unread Messages field, enter the number of
days the system is to store unread messages before deleting. Messages
that are unread will be deleted after the specified number of days.

• In the Days To Save Read Messages field, enter the number of days
to save old messages. Messages that have been tagged by the user as
"Saved" will remain on the system for the period of time specified in
this field. The default value is 30 days.

• In the Days to Keep Deleted Messages field, enter the number of
days to keep deleted messages in the database.

• In the Maximum Conversation Length field, enter the maximum
amount of time (in minutes) that users in this feature group can use to
record a conversation. The default is 60 minutes.
2. Click Save Feature Group.

234

6510 UM Server Configuration Guide

Maintaining a Feature Group

Specifying the Notification Options
The Notification Options dialog allows you to specify the notification features
allowed for a feature group. The options include turning on message waiting lights,
allowing phone, beeper, e-mail notification, and limiting access to toll lines for longdistance notification.

To specify notification options:
1. Click the Notification Options tab. The Notification Options dialog
appears.

• Select Message Light Activation to enable the message waiting light
feature. By selecting this checkbox, the following fields become active:
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Note: If you have telephone sets that provide for message waiting
lights as well as some that do not, make sure that separate
feature groups are assigned for each type of set. Deselect
Message Lights for the Feature Group that does not support
message waiting lights.
If you have any mailboxes that do not have a corresponding
telephone extension (for example, phantom mailboxes that
are used for voice menus, guest mailboxes), do not enable
this feature, as there are no message lights to activate.
Note: The ON and OFF For All Msgs checkboxes are not applicable
due to the use of TAPI in the 6510 UM environment.

• Select the OFF When No New Msg checkbox to indicate that the
message light off code will only be set when there are no new messages in the user’s mailbox.

• In the No of ON Retries field, enter the number of times to retry the
activating of the message light.

• In the No of OFF Retries field, enter the number of times to retry the
deactivating of the message light.

• In the ON Between Retries field, enter the duration to wait inbetween retry attempts.

• In the OFF Between Retries field, enter the time between retries.
• In the ON Code field, enter the code to turn on message waiting lights.
• In the OFF Code field, enter the code to turn off message waiting
lights.
Note: The On and Off Code fields should be used in situations
where the code is too long to be inputted in the On Code field
in the PBX Message Light tab (usually MCI). As well, for multiPBX configurations, different codes must be used for
different PBXs. In this situation, certain feature groups can be
assigned to a message waiting light code that reflects the
different PBXs being used.

• In the Channels field, enter the channel number that will be used to
send message light notification.
2. Click Save Feature Group.
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Notifying the User
6510 UM allows you to select the type of device that will notify all users associated
with this feature group. The options are email devices, telephone numbers, and
beepers or pagers.

To notify the user:
1. Under Message Type, click the checkbox that indicates the
message type (All, E-mail, Fax, or Voice).
2. Select Beeper to allow the system to notify a user via beeper, voice
pager, or alpha-numeric pager when a message is recorded in the
user's mailbox.
3. Select Outcall to allow the system to notify a user at a specified
telephone number when a message is recorded in the user's
mailbox.
Caution: If the telephone number is long distance, the "Long Distance" box
must also be checked to allow long distance dialing.
4. Select Long Distance to allow long distance telephone numbers to
be dialed for notification.
5. Select E-mail to allow the system to e-mail an SMTP device that
you have a message and the type.
6. Click Save Feature Group.
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Specifying LAP
Specifying the Local Area Pager (LAP) allows you to specify the conditions
determining when users will be notified to their local area pager.

To specify the LAP:
1. Select the LAP for Message checkbox to activate LAP notification
capabilities for new messages.
2. In the Template field, enter the default script you want sent to the
internal pager upon notification of a new message.
3. Select LAP for Call Template to activate a LAP notification
capability on new calls to the user.
4. In the Template field, enter the default script you want sent to the
internal pager upon notification of a new call.
5. Click Save Feature Group.
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Transferring Calls
The Transfer Options dialog allows you to specify how 6510 UM is to operate
when handling your calls.
Transfer Options include Call Screening, Call Forwarding, Do Not Disturb, Busy
Hold, Call Queuing, or Paging Capabilities, either before the call is transferred or
after the caller has reached the mailbox.
Caution: Only one transfer option may be selected for each Feature Group.

To specify transfer options:
1. Click the Transfer Options tab. The Transfer Options dialog
appears.
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2. Select one or more of the following checkboxes to enable the
corresponding options:
Option

Function

Call Screening

Select Call Screening to instruct callers who wish
to transfer to an extension to state their name at
the tone.
Before the call is transferred, the user hears the
caller's name followed by the system prompt: "To
accept the call press <1>, to reject the call press
<#>, or to redirect the call press <2>.” If the user
rejects the call, the caller hears a no-answer
message and is given the choice of trying another
extension, leaving a voice mail message, or dialing
the operator's extension. If the user redirects the
call, he or she presses <2> and the destination
extension number and hangs up to transfer the call.

Call Forwarding

Select Call Forwarding to allow a user to have all
calls redirected to another extension. If the call is
not answered by the forwarding extension, it is
forwarded back to the original user's mailbox. If this
feature is activated, the mailbox number of the user
to have calls forwarded should be entered in the
"Forwarding Ext." field of the Mailbox Status
screen.

Busy Hold

Select Busy Hold when an extension is busy and
the "Busy Hold" option is activated, callers will be
given the option to hold for the extension, leave a
message for that extension, or to try another
extension. While on hold, callers may leave a voice
message by pressing <∗>.
Note: This feature is only available on telephone
systems that provide a busy tone. Most telephone
sets with multiple extension appearances do not
produce a busy tone.

240

6510 UM Server Configuration Guide

Maintaining a Feature Group

Call Queuing

Select Call Queuing to place incoming calls in a
queue if an extension is busy. Callers are informed
of their position in the hold queue and given
opportunities to either continue to hold or leave a
voice message.
Note: This feature is only available on telephone
systems that provide a busy tone. Most multiple
telephone sets do not produce a busy tone.

Forced Messaging

Select Forced Messaging to prompt the caller to
press any key to leave a message. The mailbox does
not automatically begin recording after the
greeting. When a mailbox is associated with a
group with this feature activated, the caller hears
the user's personal greeting, and is then prompted
to press 5 to leave a message. This forces the caller
to press a digit in order to leave a message. When
this feature is activated, it should help to eliminate
short blank messages.
Note: If Forced Messaging is selected, the message
that prompts the caller to leave a message will be
played after the personal greeting.

Pre-Paging

Select Pre-Paging to page a user before the call is
transferred. When a caller requests an extension,
the caller is put on hold and the 6510 UM system
pages the user. The system then waits for a
definable period of time (default is 5 seconds) and
transfers the caller to the desired extension.

Post Transfer Paging

Select Post Transfer Paging to page the user after
the call is transferred. When a caller transfers to an
extension that is busy or is not answered the caller
is forwarded to the user's mailbox. In the user's
personal greeting, he or she can offer callers the
predefined option to page them over the telephone
intercom system (fro example, "Press 4 to have me
paged"). Callers are only informed of the paging
feature in the user's personal greeting.
Note: The system does not have a pre-recorded
prompt.
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Get Caller ID

Select Get Caller ID for the user to receive a call
control pop-up screen when receiving an incoming
call.

Play Name During Transfer

Select Play Name During Transfer to play the user’s
name when the caller is being transferred to their
mailbox.

3. In the Rings Before Forwarding field, enter the number of rings
that will occur before the system transfers the call to the extension
that the user has defined in their call forwarding feature.
4. Click Save Feature Group.

Specifying Transfer Supervision
The Transfer Supervision option allows you to determine how an incoming call is
transferred.
Caution: Only one transfer option may be selected for each Mailbox
Group.
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1. Select one or more checkbox to enable the following options:
Option

Function

None

When "None" is activated, the system transfers calls to extensions
without supervising the call (blind transfer). In this case, a caller being
transferred to an extension is placed on hold while the 6510 UM
system dials the desired extension. The caller is then released to the
telephone system.
From this point, the telephone system controls the call. Calls are
forwarded to 6510 UM only if the telephone system has the capability
to forward calls on a Busy or a No-Answer condition.

Busy

When "Busy" is activated, the 6510 UM system supervises the call
while the caller is being transferred to the extension. If the extension is
busy, the system detects the busy tone and the caller is instructed to
leave a voice message. However, if the extension is not busy and a ring
signal is heard, the caller is released to the telephone system.
From this point, the telephone system controls the call. Calls are
forwarded to 6510 UM only if the switch has the capability to forward
calls on a No-Answer condition.

Busy / NA

When "Busy/NA" is activated, the 6510 UM system supervises the
transfer of calls to the desired extension. 6510 UM checks for both the
busy and the no answer conditions and informs the caller of the
options available to them when either situation arises.
Using this type of transfer supervision will make the 6510 UM system
less efficient because the port being used will not be able to receive
any additional calls while 6510 UM is supervising the call.

Language

When the 6510 UM system is configured with more than one
language, the system must remember what language a caller has
selected during various types of transfers. In order for 6510 UM to
remember, it must be configured to supervise for language.
This type of transfer supervision is similar to the Busy/No-Answer
supervision, in that the port being supervised will not be able to
receive any additional calls while 6510 UM is supervising the call.

Centrex

Select to supervise a transferred Centrex line so that the system will
send the call back to voice mail if there is no answer.

Blind
Centrex

Select to transfer a Centrex line unsupervised. Once the call is
transferred, the system will not continue to monitor it for a
connection.

Trombone

This must be selected for integration if an Aculab voice board is being
used.
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2. Click Save Feature Group.

Specifying the Auto Attendant
The Auto Attendant feature allows you to identify the action that is to be
performed by the Auto Attendant when during a greeting message.

To specify auto attendant:
1. Select the Try Other Extension After checkbox if you want to give
callers an option to try another extension after they leave users in
this feature group a message.
2. Select the Notify User of Transfer checkbox to notify the user of a
call transfer.
3. Click Save Feature Group.

Specifying Paging Zone
Zone Paging enables the system to page users of incoming calls in their defined
paging zone.

To specify a paging zone:
1. In the Access Code field, enter the dial string that is required to
access the paging zone on that particular PBX.
2. In the Delay Time field, enter the time (in seconds) that the voice
mail is to wait before it transfers the call to the specified extension
after the user is paged.
3. Click Save Feature Group.
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Specifying Mailbox Options
The Mailbox Options dialog allows you to specify the options for all mailboxes
associated with this feature group. You can configure the Directory, Distribution
List, Tutorial, Language, and Login/Logout options by using this tab.

To specify mailbox options:
1. Click the Mailbox Options tab. The Mailbox Options dialog
appears.

2. Select one or more of the following checkboxes to enable the
options:
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Option

Function

Distribution List

This option allows users to send the same message to
multiple mailboxes.

Directory

Directory access allows users to be listed both in the dial by
name directory and the complete directory. The dial by name
directory is set up in ascending order with respect to mailbox
number. Callers may access the dial by name directory by
pressing the <*> key when they reach the auto attendant,
or they may listen to the complete company directory
(arranged in ascending order according to mailbox) by
pressing the <*> key a second time.
If any particular User does not wish to be listed in the dial by
name directory, another mailbox group can be set up with
this feature deactivated.
Note: All mailboxes are automatically entered into the
complete company directory. To remove a name from the
complete company directory, inform the user that they must
delete the Name prompt recorded in their own mailbox. If
RealSpeak TTS is installed, the system will play the names
even if the prompt is deleted. You must delete the user from
the feature group directory to fully remove the user.

Confirmation

This option instructs the system to prompt users to choose to
send a standard or certified message.

Ask For Password
(Inband Login)

This option will initiate the system to prompt users to enter
their passwords every time they log on.

Change Status

All mailboxes can exist in one of two states. "Logged In",
which is when the user is in the office and "Logged Out",
which is when the user has left the office for the day. When
this field is activated, users have the option to either log in or
log out. When this feature is deactivated, the mailbox will
remain in either a “Logged In" or a “Logged Out” state.

Confirm Delete

Activation of this feature will prompt users to press <9> to
confirm deletion of a message. This feature helps to prevent
accidental deletion of vital messages.
Note: If Message Recovery is active (See Message Recovery
earlier in this chapter), any message that is deleted can be
undeleted during the same day. You should only have
confirm delete or message recovery activated for all users.
You do not need both.
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Forced Tutorial

If selected, a user belonging to this Feature Group will not
be able to pick up messages until he or she completes the
tutorial.

Multilingual

This feature allows users to record personal greetings in
more than one language. The user will be prompted to
select the language.

Guest Mailbox

This feature is not supported in this version release.

Wakeup Call

This enables the wakeup call feature.

Message
Forwarding

This enables messages received by this feature group to be
forwarded to other mailboxes and extensions.

Shared Extension

This feature changes the way a caller uses Auto Station
Login. When this feature is activated and the user performs
an Auto Station Login (for example, pressing a key for
message retrieval), 6510 UM prompts for the mailbox
number. If this field is not activated, the system will accept
the inband extension number as the mailbox number and
ask the user to enter their password.
This feature allows installers to set up scenarios with more
than one mailbox associated to one extension number. It can
also make it easier for the receptionist to transfer callers
directly into the user’s mailboxes.

LAN talk

This feature allows users to send and receive LAN Talk
messages, provided that UM Client Manager is installed on
their PC.

Hide On Send List

If selected, mailboxes in this group will not appear in the
Send list of 6510 UM desktops.

Show Message
Count

If selected, a message window will appear over the UM
Client Manager icon in the Windows toolbar, showing the
user the number and type of new messages in their Inbox.

3. Click Save Feature Group.

Specifying Message Options
The Message Options tab allows you to specify comment attachments to messages,
as well as message sending information.

To specify message options:
1. Click the Message Options tab. The Message Options dialog
appears.
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2. In the Message Send Inter-Digit Delay field, enter the number of
seconds that the user can wait between entering digits while
leaving a message before the system decides that caller has
finished.
3. Select the Attach Comment on Reply checkbox to indicate that the
user can attach comments when replying to or forwarding a
message.
4. Select the Send all Comments checkbox to attach all comments to
a message when it is forwarded from user to user.
5. Select the Verify Sending Destination checkbox to verify the
destination of messages that are being sent.
6. Select the Cancel Auto Forwarding Only when Message Saved or
Deleted checkbox to instruct the system to cancel auto forwarding
if the message has been saved or deleted.
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7. In the When Sending a Message, Ask for Mailbox Number dropdown list, select the mailbox number to send the message to
either before recording the message or after recording the
message.
8. In the Crypt Mode drop-down list, select the crypt mode to use.
9. Click Save Feature Group.
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Specifying IMAP Configuration
By specifying an IMAP account for the feature group, you can integrate the
mailboxes of all users within the feature group with the IMAP component.

To specify IMAP configuration:
1. In the Feature Group dialog, click the IMAP tab. The IMAP tab
appears.

2. In the IMAP Account field, enter the IMAP server’s administrator’s
name.
3. In the Account Password field, enter the administrator’s password.
4. In the Confirm Password field, re-enter the administrator’s
password for confirmation.
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5. In the IMAP Server field, enter the IP address of the IMAP server.
6. In the IMAP Server Port field, enter the IMAP server port. By
default, it is 143.
7. Click Save.

Editing a Feature Group
You can edit the settings of existing feature groups at any time.

To edit a feature group:
1. Click Feature Group. The Feature Group List appears in the right
window.
2. Double-click the Feature Group you want to edit. The Feature
Group dialog appears.
3. Perform the required changes and click Save Feature Group.
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Deleting a Feature Group
You can delete a feature if it is no longer needed.

To delete a feature group:
1. Click Feature Group. The Feature Group List appears in the right
window.
2. Right-click the feature group you want to delete, highlight All
Tasks and click Delete. A prompt appears, confirming the deletion.
3. Click Yes to delete the feature group.
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In This Chapter . . .
Overview on page 254
Understanding Networking on page 254
Using the Toolbar Buttons on page 255
Configuring the Server for Networking on page 256
Adding a Remote Site on page 256
Opening a Remote Site on page 271
Deleting a Remote Site on page 272
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Overview
Audio Messaging Interchange Specification (AMIS) is a series of standards that
enables voice messaging systems produced by different vendors to network or
inter-network. Before AMIS, systems from different vendors could not exchange
voice messages.

Voice Profile for Internet Messaging (VPIM) is a SMTP standard that enables
voice mail systems to network with one another over IP. Different vendors
that adhere to the standard can interoperate with one another networked
over a Wide-area network (WAN).

Understanding Networking
Networking has two specifications VPIM and AMIS-Analog. The AMIS-Analog
specification uses DTMF tones to convey control information and the transmission
of the message itself in analog form. This means that the 6510 UM system may be
networked to other 6510 UM systems and/or other vendors’ voice messaging
systems that are also AMIS-Analog compatible. With AMIS networking, users from
different locations can send messages as if they are all on the same voice mail
system.

VPIM deployment requires a Static IP address and a free port in your network dedicated to the VPIM SMTP server. This allows the VPIM server to
receive and send VPIM SMTP packets in priority. See your network administrator for allocating a free port to the VPIM server.

254

6510 UM Server Configuration Guide

Maintaining a Remote Site

Using the Toolbar Buttons
There are eight buttons that allow you to perform various tasks within the Remote
Site application and the 6510 UM Administrator.
Button

Name

Function

Add New Site

Add a Remote Site

Open Site

Open an AMIS site

Delete Site

Delete a site

Add Site

Add an AMIS site

Save Site

Save an AMIS site

Refresh Site

Refresh information on the dialog
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Configuring the Server for Networking
Before you can add a remote site, you must make sure that both AMIS and VPIM is
enabled in the configuration.

To configure the server:
1.

Expand Configuration and highlight Remote Site Settings. The AMIS
parameters appear in the right pane.

2.

Double-click on Remote Site Installed. The following dialog appears:

3.

From the Value Data drop-down list, select True. This will enable both
AMIS and VPIM on the UM server as long as they are licensed on your
system Sentinel.

Note: AMIS Initial Delay is a timer setting for receiving AMIS
packets from other sites. The default is 3 but you can adjust it
for fine-tuning.

Adding a Remote Site
Every site that is to be included in the network must be added to each site with a
unique site number. In order for 6510 UM to be able to communicate with another
system, each site’s parameters must be correctly inputted for proper networking.
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Adding an AMIS Site
Adding an AMIS Site allows a user from a remote site to interact as if the user is inoffice, where the AMIS system uses DTMF tones to convey control information and
the transmission of the message itself in analog form.

To add an AMIS Site:
1.

Highlight Remote Site on the Administration Console.

2.

Click Add New AMIS. The General dialog appears.

3.

If this is the first site that you are adding, enter the appropriate
information and click Save Site.
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Note: The system automatically selects the first site number
available
4.

For all subsequent sites, click Add Site. 6510 UM clears the dialog of
information.

5.

Select AMIS. The following fields appear.

6.

If you want to change the site number, enter a unique number in the
Site Number field.

Note: Every network site is assigned a unique number from 1-999.
This is used to reference site information.
7.

In the Description field, enter a description of the site. Typically, it is the
company name of the site.

8.

In the Location field, enter the location of the site. Typically, it is the City
and State for U.S. locations and City and Country for international
locations.

9.

In the Site ID Number field, enter a system identification number for the
remote site.
AMIS has strict guidelines on the format of a system ID. It is composed of
three numeric fields using 0 to 9, and each field is terminated with a #
(pound sign). The maximum length of the System ID Number is 18
characters, and the minimum is 3 characters.
The two types of System ID Numbers are public and private.
Public System ID Numbers are for all sites that can be direct dialed using
the public telephone network. These ID numbers are always in the format
of ccc#nnn#sssssss#, where the value “ccc” is the international country
code (1-4 digits), the value of “nnn” is the national significant number
(area or city code of 0-14 digits) and the value of “sssssss” is a local
subscriber number of 0-14 digits. All locations in North America must use
the format of 1#aaa#sssssss# where “aaa” is the area code and
“sssssss” is the local telephone number.
Private System ID Numbers are for all sites that are accessible through a
private network or behind a PBX. These always have the format
0##nnnnnnn# where “nnnnnnn” is a site defined number. The site
defined number is typically the extension number of the site. The value
“nnnnnnn” can be from 0-14 digits.

10.
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In the Country drop-down list, select the country in which the site is
located.
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11.

In the Area/City Code field, enter the area/city code of the site.

12.

In the Number field, enter the dial string or number to be dialed in order
to call the site.

Note: This number should include any necessary access numbers
(for example, 1 or 011). Do not include the trunk access code
(usually a 9).
13.

From the Access Codes drop-down list, select the type of call used to
connect to that site.

14.

Click Save Site.

Adding a VPIM Site
Voice Profile for Internet Mail (VPIM) is an International Telecommunications Union
(ITU) standard that allows different types of messaging servers to pass voice and fax
messages among each other over the Internet. Creating a VPIM address allows the
6510 UM to use VPIM to send messages to assigned network voicemail users.

To create a VPIM Site:
1.

Highlight Remote Site on the Administration Console.

2.

Click Add New Remote Site. The General dialog appears.

3.

Select VPIM. The VPIM dialog appears.

6510 UM Server Configuration Guide

259

Maintaining a Remote Site

4.

In the Site Number field, enter the unique number of this VPIM site.
Every network site is assigned a unique number from 1-999.

Note: This field is used to reference site reference.
5.

In the Description field, enter a description of the site. Typically, it is the
company name of the site.

6.

In the Location field, enter the location of the site. Typically, it is the City
and State for U.S. locations and City and Country for international
locations.

7.

In the Domain Name field, enter the domain name of where the VPIM
server is logged into (in other words, the Domain of the UM Server).
or
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8.

A networked site needs a static IP and a free port for the UM to connect
to. In the IP Address field, enter the IP and port number information for
the remote UM or voice mail server.

Note: The Domain name or IP Address entered must correspond
with the Domain name of IP address specified in the Company
configuration. Refer to To specify general options: on
page 116.
Note: Enter the information as a standard address, followed by a
colon and the port number (for example, 192.168.0.172:25).
9.

Click Options. The Options dialog appears.

Specifying AMIS or VPIM Options
In order for 6510 UM to be able to communicate with another system using AMIS
or VPIM systems, you must specify the options for the configuration.

To specify AMIS options:
1.

Click the Options tab. The Options dialog appears.

6510 UM Server Configuration Guide

261

Maintaining a Remote Site

262

6510 UM Server Configuration Guide

Maintaining a Remote Site

2.

Select one or more of the following checkboxes to enable the options:

Options

Function

Journal Sessions

The system will log information about this session to a
disk file.
Incoming calls are kept in the file D:\SITE_Cnn.LOG,
where “nn” is the channel number
Outbound calls are kept in the file D:\SITE_x.LOG,
where “x” is the site number.
If this is a local site and this applies to all incoming and
outbound calls to or from this site.
If this is a remote site and this applies to all outbound
calls to this site.
If not checked then journaling is disabled for this site.
Note: This option is not available for VPIM.

Accept Incoming

The system will accept all incoming network calls from
any REMOTE site. If this is not selected, the system will
reject calls from any REMOTE site. This will cause the
REMOTE site to return the messages to the senders.
Note: This is the default when checked.
Note: This option is not available for VPIM.

Place Outbound

Calls may be placed to this remote site.
If it is not selected, calls will not be placed to this remote
site.
If not selected, the Send and Forward options in the
user Mode menus will not allow the selection of this
remote site as a destination for a message.
Note: This is the default when checked.
Note: This option is not available for VPIM.

Accept Broadcast ID

Incoming network calls may access public broadcast
lists. If it is not selected, incoming messages for public
broadcast will be rejected.
Note: This option is not available for VPIM.
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New Message To Send

Network management will automatically check to see if
this site has messages waiting for delivery. Selecting this
field forces a re-check for outbound messages. If this
field is not selected, outbound delivery attempts will be
cancelled until more messages are queued.
Note: This option is not available for VPIM.

End Record Any

Recording of incoming messages will terminate on any
DTMF tone. This is an AMIS compatible value. However,
this will cause any messages that contain partial DTMF
tones to be rejected. The default is for this field to
remain unselected. This causes any DTMF tones other
than a valid “*” tone to be ignored. This field should
remain deselected.
Note: This option is not available for VPIM.

Ask For Special

6510 UM will verify the version of networking being
used on the remote site when calls are placed to this
remote site. If the version is the same as that used by
the system and enhanced AMIS protocol will be used to
communicate between the systems. If it is a different
version of networking and 6510 UM will use the
standard version of AMIS to communicate.
If calls to this remote site fail, and the site is using a
different version and deselecting this field will cause
6510 UM to only use standard AMIS networking when
communicating with this site.
Note: This option is not available for VPIM.

Send Site Name

The site name will be transmitted as part of the AMIS
message. If not selected, no name will be transmitted.
Note: This option is not available for VPIM.

Unlisted Site

This field defines whether this site will be listed in the
Network Assistance Menu. Network Assistance is used
to assist in selecting a site number and is available in
user Mode when sending or forwarding a message. It is
invoked by selecting 0 as the site number.
Selecting this field defines this remote site as unlisted. If
the field is not selected, the site is listed.
Note: This option is not available for VPIM.

3.
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In the Consec Fails Stop field, enter a value to shutdown outbound
calling to this site if there are too many consecutive failures. When the
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number of consecutive failures reached this value, the New MSGS to
Send field will be set to “N”.
Note: The consecutive failures count is only reset to zero when a
network call is acknowledged by the called site, or when the
operator clears the count.
4.

In the Minimum Recall field, enter the number of minutes that must
elapse before attempting a second and ensuing outbound call to this site.
The time between ensuing recalls is increased by this value with each
retry until the number of recalls equals the value in the Maximum Recall
field. For example, if this field is set to 2 and 6510 UM will attempt a
second call 2 minutes after the first, four minutes after the second, etc.
until the number of minutes in the Maximum Recall field is reached.
Retries will continue within the value of the Maximum Recall field until
the Consecutive Fails Stop value is reached.

5.

In the Maximum Recall field, enter the maximum number of minutes
between retries of outbound calls until the value of Consecutive Fails
Stop is reached.

6.

In the Message Send Expired field, enter the expiration time period of
messages waiting to be sent via the network. Any undelivered message
that has reached expiration will be marked as expired and nondeliverable and be returned to the sender (or to the LOCAL site operator).

Note: Setting this value too low will cause messages to be returned
unnecessarily. Setting this value to 0 will disable the
expiration option. The default value for this field is 24 hours.
7.

Click Save Site.
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To specify VPIM options:
1.

Click the Options tab. The Options dialog appears.

2.

Follows steps 3 to 7 in the specify AMIS options section above to
configure VPIM options.

3.

Click Save Site.

Example of a VPIM Site
The following example illustrates the settings required for networking two 6510
UM systems using VPIM.

Example settings for networking two systems using VPIM:
Site 4

Site 1

IP Setting: 147.23.16.13

IP Setting: 66.57.123.56

Mailbox Range 100-120

Mailbox Range 100-320

Note: Any mailbox that will be sent a message from one site to
another must be duplicated in each site.
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1.

Open and login to the 6510 UM Administrator.

2.

In the Tree left window pane, expand Configuration and click Remote
Site Setting. The Remote Site settings appear in the right window pane.

3.

Double-click Remote Site Installed. The Edit String dialog appears.
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4.

In the Value Data drop-down list, select True and click OK.In the Tree
left window pane, right-click 6510 and select New>Company. The
Company dialog appears.

5.

In the General tab, provide the necessary information for the company.
For the purpose of this example, attention must be made to provide the
IP address in the Domain Name/IP Address field of Site 1.

6.

Click Save Company.
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7.

In the Tree left window pane, expand the company and right-click
Remote Site and select New>Remote Site. The Remote Site dialog
appears.

8.

In the General tab, select VPIM and provide the necessary information
for the remote site. For the purpose of this example, attention must be
made to provide the site number and IP address of Site 4.

Note: The site number and IP address must be duplicated at all the
locations where it is created in.
9.
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Click Save Site.
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10.

In the Tree left window pane, expand the company and right-click
Mailbox and select New>Mailbox. The Mailbox dialog appears.

11.

Enter the required information in all tabs. For the purpose of this
example, click the Addresses tab. The Addresses tab appears.

12.

Click Add and select E-mail/VPIM. The Address dialog appears.

13.

In the Type drop-down list, select VPIM.

14.

In the Address field, enter the extension number for the mailbox. The
default IP address for the site will be displayed "@66.57.123.56".

Note: If the IP address or domain name was created in the company
tab first, then each mailbox will have a default VPIM address
already assigned.
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15.

Click OK and then click Save Mailbox.

Through this configuration example, a user at Site 4 can create a message and
address it to a mailbox at Site 1. The local user will create a message from their own
mailbox. When asked for the destination, the user should enter 110*1, and this
represents mailbox 110 at remote site 1.

Using VPIM Tools
VPIM Tools allow the administrator to monitor the operation of the VPIM service,
check the log files for error and modify VPIM addresses.
The VPIM Tools are located in the UM directory onthe machine where 6510 UM is
installed. The directory is \\UM\vpim\vpimclient.exe.
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Opening a Remote Site
You can open all remote sites from the Administration Console.

To open a remote site:
1.

Highlight Remote Site. All associated remote sites appear in the right
pane.
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2.

Double-click on a remote site. The Remote Site dialog appears.

Changing a Remote Site
If you need to change information about a site (for example, the dial-up number),
you must change the information on all sites containing the affected site address.

To change a remote site:
1.

Double-click the site you want to edit. The Remote Site dialog appears.

2.

Perform the required changes and click Save Site.

Deleting a Remote Site
6510 UM allows you to delete a site from either the Administration Console or form
the Remote Site list.

To delete a remote site:
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1.

Right-click the site you want to delete, highlight All Tasks and click
Delete. A prompt appears, confirming the deletion.

2.

Click Yes.
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Overview
The Call Routing Table works in conjunction with Caller ID/DNIS to assign certain
telephone numbers to specific extensions, or with PIN Numbers to direct the call to
specific Voice Menus.
The 6510 UM allows you to route an outside call to an individual mailbox. For
example, you might want all sales calls from the 416 area code to go to the mailbox
of the individual responsible for that area.

You can also route all calls that begin with a specific three digit number followed by a series of wildcards (known as Caller ID). For example, whenever
the system recognizes the number 212-555-9999, it will route the call
directly to the designated voice menu.

Using the Toolbar Buttons
There are seven buttons that allow you to perform various tasks within the Routing
Table application and the 6510 UM Administrator.
Button

Name

Function

Open the Routing Table

Opens the routing table.

Add a Routing Destination Adds a new routing destination.
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Delete a Routing
Destination

Deletes an existing routing destination.

Edit a Routing Destination

Edits an existing routing destination.

Schedule

Assigns a schedule to a routing destination.
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Add Schedule Item

Add a schedule.
Note: This function allows you to add more
than one schedule to the same mailbox.

Delete Schedule Item

Delete a schedule.
Note: This function allows you to delete a
schedule from the same mailbox.

Opening the Routing Table
Open the Routing Table from the Administration Console.

To open the routing table:
1.

Highlight Routing Table. The routing table appears in the right pane.

2.

Double-click on the Routing Table. The Routing Table dialog appears and
displays all existing routing destinations.
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Creating a Caller ID
Routing destinations are based on call information such as Caller ID, Voice Menus
or Mailboxes, and Account codes.

To create a routing destination:
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1.

Highlight Routing Table in the Administration Console.

2.

Highlight Routing Table in the right pane and click Open. The Routing
Table screen appears.
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Creating a Caller ID/DNIS Destination
You can create a routing destination that is based on caller ID.

To create a caller ID/DNIS destination:
1.

Click the CallerID/DNIS tab.

2.

Click Add. The Routing Table dialog appears.

3.

In the Caller ID/DNIS field, enter the number that will be routed to the
mailbox. You can enter either a caller ID or a DNIS number.

Note: The Automated Attendant will detect either the Caller ID or
the DNIS number only it is configured properly in the PBX
configuration.
You can enter the full number or area code with wild cards
“*”. You can combine the wild card number with any
configuration of numbers as well. For example, 416* will
route all numbers that lead with 416. 41* will route numbers
that lead with 41.
4.

Select Mailbox and in the Mailbox drop-down list, select the mailbox
that will receive the incoming calls.
or
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5.

Select Voice Menu and in the Voice Menu drop-down list, select the
voice menu that will receive the incoming calls.

6.

In the Sub Menu drop-down list, select the sub menu to use. (Only
applicable if Voice Menu is chosen).

7.

In the Associated Name field, enter a description of the types of calls
being redirected to a mailbox.

8.

Click OK.

9.

After setting Caller ID/DNIS destinations, you must enable the caller id
feature. In the 6510 Admin tree, click Configuration>Device
Management>Caller ID Settings and specify the caller ID settings.
Refer to Specifying the Caller ID Device on page 43 to see how to
configure these settings.

Creating a Pin Number Destination
Pin Numbers are used to create a custom dialog and action based on numerical
inputs from the caller. Pin number verification and routing may be used in a support
center, dealer, or partner log in scenarios.

To create a PIN Number Destination:
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1.

Highlight Routing Table in the Administration Console.

2.

Highlight Routing Table in the right pane and click Properties. The
Caller ID/DNIS dialog appears.

3.

Click the Pin Number tab and Add. The Routing Table dialog appears.
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4.

In the Pin Number field, enter the PIN Number to be verified for call
processing. The number can be up to 25 digits in length.

5.

In the Voice Menu drop-down list, select the voice menu to direct the
call to.

6.

From the Sub Menu drop-down list, select the sub menu to direct the
call to upon a valid entry. This sub menu is located in the originating
Voice Menu.

7.

In the Associated Name field, enter the name that is to appear for
screen popups if using the “Pin Number as Caller ID” function.

8.

Click OK.

9.

After specifying PIN numbers, make sure that you enable the Ask Pin
Number feature in the Voice Menu. In the 6510 Admin tree, expand the
company that this PIN number is associated to and double-click Voice
Menu. The Voice Menus appear in the 6510 Admin right window.

10.

Double-click the Voice Menu that the PIN number will be associated to.
The Voice Menu dialog appears.
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11.

In the Actions box, select and drag Ask Pin Number to the DTMF Key/
Action box. The Parameters (Ask Pin Number) dialog appears.

12.

In the Next Sub Menu, When Valid drop-down list, select the sub
menu you want the caller to hear if the incorrect PIN number is entered.
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13.

In the Phrase drop-down list, select the pre-recorded phrase that the
caller will hear if the correct PIN number is entered.

14.

In the No. of Retries field, enter the number of times the system is to
allow the caller to attempt to enter a PIN number.

15.

Click OK and then Save Voice Menu.
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Assigning a Schedule
6510 UM allows you to assign a schedule to a routing destination to determine
when a call is to be transferred to an extension. For example, when Caller ID
recognizes a particular number, the system will examine the appropriate schedule. If
the current day and time falls within the time frame specified in the schedule, the
call is routed directly to the correct mailbox.
A schedule can also be applied to a PIN Number so that it is only active within a
specific time period. The destination is the sub-menu number within the Voice
Menu that originated the PIN Number request. When “Get PIN Number” is used in
a Voice Menu, and the caller enters 5454 as their PIN Number, the caller is routed to
sub menu 10 within the Voice Menu that requested it.
Note: For PIN number scheduling, you are changing the sub-menu
you will use to process the call based on time of day or day of
week.

To apply a schedule:
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1.

Open the routing destination that you want to apply the schedule to.

2.

Click Schedule. The Routing Table Schedule dialog appears.
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Note: If you are assigning a schedule to a PIN Number, the Default
Mailbox drop-down list will appear as the Default Voice
Menu drop-down list. The Mailbox drop-down list will appear
as the Voice Menu drop-down list.
3.

Click Add Schedule Item.

4.

In the From/To – Year, Month and Day fields, enter the time (in military
format) that the voice menu is to become active.

5.

In the From/To – Time fields, enter the time (in military format) that the
schedule is to become active.

Note: If no time is entered, the system will assume all hours.
Select All day if the voice menu is to run all day.
A value of From 13:00 to no value indicates 1:00 PM to
midnight.
The maximum value is 23:59 and the minimum value is 0:00.
Select the days of the week that you want the message to run.
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Hint: If you want the message to run every day, select Everyday.
You must arrange dates and times sequentially, from Monday
through to Sunday.
6.

From the Mailbox drop-down list, select the destination mailbox for
CallerID/DNIS or the sub-menu for PIN Number.

7.

Click Save Schedule.

Deactivating a Schedule
You can deactivate any schedule that has been assigned to a routing destination.

To deactivate a schedule:
1.

Open the Routing destination.

2.

Click Schedule.

3.

Deselect Schedule Enabled and click Save Schedule.

Reactivating an Existing Schedule
You can reactivate any schedule that has been assigned to a routing destination.

To reactivate a schedule:
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1.

Open the Routing destination.

2.

Click Schedule.

3.

Select Schedule Enabled and click Save Schedule.
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Changing an Existing Schedule
You can make changes to any schedule regardless of whether or not it has been
assigned to a routing destination.

To change an existing schedule:
1.

Open the Routing destination.

2.

Click Schedule.

3.

Select the schedule that you want to change.

4.

Modify the required information and click Save Schedule.

Removing a Schedule Entry
You can remove a schedule entry when you no longer want it to be assigned to a
routing destination.

To remove a schedule entry:
1.

Open the Routing destination.

2.

Click Schedule.

3.

Select the schedule entry that you want to delete.

4.

Click Delete Schedule Item.

5.

Click OK and Save.
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Removing a Complete Schedule
A complete schedule is made up of one or more sub schedules and can be removed
entirely.

To remove a complete schedule:
1.

Open the Routing destination.

2.

Click Schedule.

3.

Click Delete Schedule.

4.

Click Yes to confirm deletion. The Routing Table dialog appears.

Creating a Schedule Report
You can create a schedule report to view and print the routing table.

To create a schedule report:
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1.

Open the Routing destination. The Routing Table dialog appears.

2.

Click

3.

Click
. The Schedule Report dialog appears. The Routing Table list
appears, and allows you to view what is scheduled.

. The Routing Table Schedule dialog appears.
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Creating a PIN Number
PIN Numbers are used to create a custom dialog and action based on numerical
inputs from the caller. PIN number verification and routing may be used in a support
center, dealer, or partner log in.

To create a PIN Number:
1.

Click PIN Number. The Routing Table dialog appears.

2.

In the Pin Number field, enter the number you want to verify for call
processing. The number can be from 1 to 25 digits.

3.

From the Voice Menu drop-down list, select a custom voice menu you
want to associate to callers when the number is verified. Once the
number above is verified, the system will take the caller to this voice
menu for processing.

4.

From the Sub Menu drop-down list, select the sub-menu to direct the
call upon a valid entry. This sub-menu is located in the originating Voice
Menu.

5.

In the Associated Name field, enter the name you want to appear on
screen pops when this number is verified and sent to an extension.

6.

Click OK.

Changing a PIN Number
PIN number verification and routing may be used in a support center, dealer, or
partner log in. You can change the PIN number at any time in the Routing Table
dialog.

To change a PIN Number:
1.

Highlight the PIN Number that you want to change.

2.

Double-click the PIN Number. The Routing Table dialog appears.

3.

Modify the required information and click OK.
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Deleting a PIN Number
PIN number verification and routing may be used in a support center, dealer, or
partner log in. You can delete the PIN number at any time in the Routing Table
dialog.

To delete a PIN Number:

288

1.

Highlight the PIN number that you want to delete.

2.

Click Delete.

3.

Click Yes to confirm the deletion.

6510 UM Server Configuration Guide

Maintaining a Routing Table

Adding a Pin Number
You can add a pin number.

To add a PIN Number
1.

Click Add. The Routing Table dialog appears.

2.

In the Pin Number field, enter the number you want to verify for call
processing. The number can be from 1 to 25 digits.

3.

From the Voice Menu drop-down list, select a custom voice menu you
want to associate to callers when the number is verified. Once the
number above is verified, the system will take the caller to this voice
menu for processing.

4.

From the Sub Menu drop-down list, select the sub-menu to direct the
call upon a valid entry. This sub-menu is located in the originating Voice
Menu.

5.

In the Associated Name field, enter the name you want to appear on
screen pops when this number is verified and sent to an extension.

6.

Select Apply Schedule if a schedule will be used to route the call. Enter
the schedule number in the field provided.

7.

Click OK.
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Edit a Routing Table
The Call Routing Table works in conjunction with Caller ID/DNIS to assign certain
telephone numbers to specific extensions. You can edit the settings of the routing
at any time.

To edit a routing table
1.

Right-click Routing Table, highlight All Tasks and click Properties. The
Routing Table dialog appears.

2.

Double-click the Routing Table you want to edit. The Routing Table
Properties dialog appears.

3.

Perform the required changes and click OK.

Deleting a Routing Table
You can delete a Routing Table from your Routing Table list.

To delete a routing table

290

1.

Right-click Routing Table, highlight All Tasks and click Properties. The
Routing Table dialog appears.

2.

Highlight the Routing Table you want to delete.

3.

Click

4.

Click Yes.

. A prompt appears confirming the deletion.
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In This Chapter . . .
Overview on page 292
Using the Toolbar Buttons on page 292
Opening a Voice Menu on page 293
Adding a Sub Menu on page 304
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Overview
Voice Menus provide you with the ability to customize company greetings and
individual mailboxes. You can create voice menus inside a mailbox from which
callers may access options to leave or obtain information. Company greetings can
offer callers the option to transfer themselves to specific departments, leave
messages, or obtain company information such as address, telephone number, fax
number, or office hours.
Schedules can also be applied to these menus, allowing a greater degree of
flexibility in controlling the caller’s capabilities.

Using the Toolbar Buttons
There are twelve buttons that allow you to perform various tasks within the Voice
Menu application and the 6510 UM Administrator.
Button
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Name

Function

New Voice Menu

Add a new voice menu

Open Voice Menu

Open an voice menu

Delete Voice Menu

Delete a voice menu

Save Voice Menu

Save a voice menu

Start Menu Schedule

Add a menu schedule

Add Sub-Menu

Add a sub-menu.
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Delete Sub Menu

Delete a sub menu

Find Sub Menu

Find a sub menu

Opening a Voice Menu
You can open an existing voice menu from the Administration Console.

To open a voice menu:
1.

In the 6510 UM Administrator, click Voice Menu. All associated voice
menus appear in the right window.

2.

Double-click on a voice menu. The Voice Menu dialog displays
information about the voice menu.
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Adding a Voice Menu
Adding a voice menu allows you to assign functionality to each of the keys on a
telephone keypad. For example, you can create a voice menu called “Company”
that allows callers to connect to different departments within your organization. If a
caller wants to speak to someone in Sales, the system will prompt them to press 1.

To add a voice menu:
1.

In the 6510 UM Administrator, click Voice Menu. The voice menus that
are available appear in the right window.

2.

Double-click on a voice menu. The Voice Menu dialog appears.

3.

Click Add New Voice Menu. A new Voice Menu dialog appears.

Hint: You can also open the Voice Menu dialog by double-clicking
on an existing voice menu. The Voice Menu dialog will display
all details of the existing voice menu. Click New Voice Menu
to clear the dialog.
.
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The Menu Number starts automatically at 1 if this is the first voice menu
you are creating.
4.

In the Menu Name field, enter the name you want associated to this
voice menu. It should be a descriptive name (for example, Sales mailbox
or Company greeting).

Note: Each Voice Menu can have unlimited sub-menus. You must
begin the administration of voice menus in sub-menu 1. If
there is no schedule applied, the 6510 UM starts all Voice
Menus with sub-menu number one. Refer to Creating a Menu
Schedule on page 299.
5.

Select Default to make this voice menu the system default that is used
throughout the system. It will use this menu by default if you assign a
voice menu to an action and do not indicate which specific voice menu to
use.

6.

In the No. of Retries field, enter the number of incorrect actions a caller
can input before you execute the default action.

7.

From the Sub Menu Phrase drop-down list, select the phrase you want
played in this particular level. There are several options:

Sub Menu Phrase

Function

Nothing

It will not play a greeting and will wait for an
action

Company Salutation

Enter a company recorded phrase by putting in
the phrase number

Company Active Greeting

Plays the current scheduled company greeting
that the menu is associated with.

Mailbox Active Greeting

Plays the active mailbox greeting you have
associated the voice menu to

Mailbox Optional Greeting

Allows you to select an optional mailbox greeting
number that will play.

8.

In the Not Set drop-down list, select the set type.

9.

In the Timeout field, enter a value indicating the number of milliseconds
before the default action will be taken, upon no response.
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Note: The default value is 2000. A value of 0 is not permitted.
However, if the user wants the default action to take effect
immediately, you can enter a value of –1.
10.

In the Description field, enter a description for the voice menu.

11.

Select the Extension Dialing checkbox if you want callers that are in this
Voice Menu to be directly transferred to a valid mailbox.

12.

Under the Actions box, right-click an action and select the DTMF key that
it will be assigned to.

13.

Repeat step 12 until all desired actions are assigned DTMF keys.

Note: A dialog box will appear if additional information is required.
For more information, refer to Appendix F - Customize
Mailbox: DTMF Key Parameters.
For more information on adding an action to a DTMF key, refer
to Adding an Action to a DTMF Key on page 297.
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14.

Click Save Voice Menu.

15.

To create another voice menu, click New Voice Menu.
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Adding an Action to a DTMF Key
Creating a voice menu enables you to assign a wide range of actions to the keys on
the telephone keypad (also known as Dual-Tone Multi-Frequency or DTMF keys).
This allows for a wide range of flexibility in how the system handles incoming calls.
For example, in the voice menu, you could assign the Send to Directory action to
the first DTMF key. When a caller presses 1, the system sends them to the company
directory.
You can add an action to a DTMF key in both the customized mailbox and voice
menu applications.
Hint: To help you trace the call flow and double-check the
sequence, create a flow chart with all of the actions and submenus defined.

To add an action to a key:
1.

In the Voice Menu dialog, select the appropriate sub-menu.

2.

Drag and drop the action to a DTMF key.
You can also highlight an action and press the right mouse button and
select Set Action To. The DTMF key drop-down list appears.

3.

Match the action to a DTMF key.

4.

If a value is required for the action (for example, Get Transfer Mailbox),
the system displays a dialog. Enter the appropriate information and click
OK.
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5.

Click Save Voice Menu or Save Customize Mailbox.

Removing an Action from a DTMF Key
You can remove an action from a particular DTMF key if you do not want the user
or caller to use it.

To remove an action from a DTMF Key:
1.

In the Voice Menu dialog, select the sub-menu containing the key that
you want to remove.

2.

Use one of the following methods to remove the action:

• Drag and drop the action to the left pane.
• Highlight the action and select Delete.
• Highlight the action, right-click and select Clear.

Changing an Existing Action
You can change the action associated with a DTMF key. You can also move an
action from one key to another.

To change an existing action:
1.

In the Voice Menu dialog, select the sub-menu containing the key you
want to change.

2.

Drag and drop the new action to the assigned key.

3.

To move an action from one key to another, drag and drop the action
from the existing key to the new key. If the new key is blank, the system
completes the move. If the new key has an action already assigned to it, a
warning message appears.

Hint: You can also right click on a key that has an action assigned to
it, click Cut or Copy and paste it to another key
4.
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Click Yes to replace the item, if there is an action already assigned. The
system completes the change.
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Creating a Menu Schedule
Creating a menu schedule allows you to define when 6510 UM is to activate a
certain sub menu. You can define unique caller actions for weekdays and
weekends, so that weekend actions are activated automatically Friday evening and
weekday actions are reactivated on Monday morning.

To start a menu schedule:
1.

Create all of the sub-menus required with all functions and prompts
defined.

2.

Double-click on the voice menu in the right window of the 6510 UM
Administrator screen. The Voice Menu dialog appears.

3.

Click Start Menu Schedule. The Start Menu Schedule dialog appears.

4.

From the Default Start Menu drop-down list, select the voice menu
that should be active during default hours.
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5.

In the From/To – Year, Month and Day fields, enter the time (in military
format) that the voice menu is to become active.

6.

In the From/To – hour and min fields, enter the time (in military format)
that the voice menu is to become active.

Note: If no time is entered, the system will assume all hours.
Select All day if the voice menu is to run all day.
A value of From 13:00 to no value indicates 1:00 PM to
midnight.
The maximum value is 23:59 and the minimum value is 0:00.
Caution: To create a Menu Schedule consisting of multiple voice menu
types within a 24 hour period, you must create separate schedules. The From - Time field does not support a value that is
greater than that of the To - Time field. For example, a pager notification set to run from 17:00 (5pm) to 08:59 (8:59am) the next
day must be specified using two schedules. One that is enabled
from 17:00-23:59 and one from 00:00-08:59.
7.

Select the days of the week that you want the message to run.
If you want the message to run every day, select Everyday.
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8.

From the Start Menu drop-down list, select the sub-menu level to start
with during this defined schedule to override the default voice menu sublevel.

9.

From the Default Start Menu drop-down list, select a default start
menu for the voice menu.

10.

Click Save.
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Displaying the Schedule Report
The Schedule Report displays a synopsis of all schedules that have been created for
a particular voice menu.

To create a schedule report:
1.

In the 6510 UM Administrator, click Voice Menu. The voice menus that
are available appear in the right window.

2.

Double-click a voice menu. The Voice Menu dialog appears.

3.

Click the Start Menu Schedule button. The Start Menu Schedule dialog
appears.

4.

Click the Schedule Report button. The Schedule Report (Start Menu
Schedule) dialog appears.
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Changing a Voice Menu
6510 UM allows you to change an existing voice menu, including names, sub
menus, phrases, and actions
Note: All changes must be done from the Administration Console.

To change a voice menu:
1.

In the 6510 UM Administrator, click Voice Menu. The voice menus
available appear in the right window.

2.

Double-click on the voice menu you want to edit. The Voice Menu dialog
appears.

3.

Make the required changes and click Save Voice Menu.

Deleting a Voice Menu
You can delete a voice menu from either the Administration Console or the Voice
Menu dialog.

Deleting a Default Voice Menu
If you try to delete a voice menu that has been specified as the default used
throughout the system, 6510 UM displays the following message:

Make sure that you first specify another voice menu as the default before deleting
this voice menu.
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Using the Administration Console
6510 UM allows you to delete a voice menu from the Administration Console.

To delete a voice menu:
1.

In the 6510 UM Administrator, click Voice Menu. All associated voice
menus appear in the right pane.

2.

Right-click the voice menu that you want to delete and click Delete or
select a combination of voice menus by pressing CTRL and click the
mouse at the same time and then clicking Delete. A message appears,
prompting you to confirm the deletion.

Note: The Delete button becomes active after you highlight a voice
menu.
3.

Click Yes to delete a single voice menu, or Yes to All to delete all of the
highlighted voice menus.

Using the Voice Menu Dialog
6510 UM allows you to delete a voice menu form the Voice Menu dialog.

To delete a voice menu:
1.

In the 6510 UM Administrator, click Voice Menu. The voice menus that
are available appear in the right window.

2.

Right-click the voice menu that you want to delete and select All
Tasks>Delete. A message appears, prompting you to confirm the
deletion.

3.

Click Yes. The Menu Number displays the next available Voice Menu.
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Adding a Sub Menu
Sub menus are used to create multiple actions for a voice menu, for example, a
Q&A Script, an account code verification, or an IVR with password verification.
All of these applications would be created in a voice menu with multiple layered sub
menus to process the caller selection.

To add a sub menu:
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1.

In the 6510 UM Administrator, click Voice Menu. The voice menus that
are available appear in the right window.

2.

Double-click the voice menu that you want to add a sub menu to. The
Voice Menu dialog appears.

3.

Click Add Sub Menu. 6510 UM clears the Voice Menu dialog of all
displayed information.

4.

Follow the steps detailed in Adding a Voice Menu on page 294.
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Searching for a Voice Menu
6510 UM provides you with the ability to search for a particular voice menu.

To search for a voice menu:
1.

In the 6510 UM Administrator, click Voice Menu. The voice menus that
are available appear in the right window.

2.

Double-click a voice menu. The Voice Menu dialog appears.

3.

Click Sub Menu and select Find. The Find Menu dialog appears and
displays all existing voice menus.

4.

Double-click on the sub menu that you are looking for. The sub menu
settings appear in the Voice Menu dialog.

Editing a Sub Menu
You can editing the properties of a sub menu at any time.

To change a sub menu:
1.

Find the sub menu by either using the scroll buttons or by searching the
existing sub menus.

2.

Once you have found the sub menu, make all of the appropriate changes
and click Save Voice Menu.
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Deleting a Sub Menu
You can delete a sub menu at any time.

To delete a sub menu:
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1.

Find the sub menu by either using the scroll buttons or by clicking Sub
Menu and selecting Find.

2.

Click Delete Sub Menu. A message appears, prompting you to confirm
the deletion.

3.

Click Yes.
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In This Chapter . . .
Overview on page 308
Using the Toolbar Buttons on page 308
Creating a Customized Mailbox on page 309
Specifying Control Keys on page 313
Copying a Customized Mailbox on page 316
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Overview
Customizing a mailbox allows you to emulate or customize the Telephone
User Interface (TUI) required for a user to interact with their mailbox. You
can define the keystroke actions that a user will use when navigating their
mailbox.

Using the Toolbar Buttons
There are nine buttons that allow you to perform various tasks within the
Customize Mailbox application.
Button

Name

Function

Add New Customize Mailbox

Create a new customized mailbox.

Open Customize Mailbox

Open a customized mailbox.

Copy

Copies customize mailbox settings and
creates a new menu.

Delete Customize Mailbox

Delete a customized mailbox.

Save Customize Mailbox

Save a customized mailbox.

Control Keys

Enables control function to be used
while in a sub menu or listening to a
message.

Customize Mailbox Flowchart

Add Sub Menu
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Add a sub menu
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Delete Sub Menu

Delete a sub menu

Find Sub Menu

Find a sub menu

Creating a Customized Mailbox
Before you can create a customized mailbox, you must first create a TUI template
that can be saved and mapped to an individual user’s mailbox.
Note: DTMF stands for Dual-Tone Multi-Frequency.

To create a customized mailbox:
1.

Highlight Customize Mailbox and click Add New Customize Mailbox.
The Customize Mailbox dialog appears.
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2.

The Menu Number field starts automatically at number 1 if this is the
first customized mailbox you are creating. It will automatically increment
the menu number by one each time you create a new customized
mailbox.

3.

In the Menu Name field, enter a name for the customized mailbox.

Hint: The name should be descriptive of what the menu does.

310

4.

Select Default if you want this TUI template to be the system default
template. This will be used for all of the mailboxes

5.

In the No. of Retries field, enter the number of retries that a subscriber
can input until the system disconnects.
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6.

From the Play Method drop-down list, select a prompt setting.
Playback Method

Function

Nothing

6510 UM does not play a custom
phrase.

Only Sub Menu
Phrase

System instructions are custom
recorded by the System
Administrator.
They are based on the phrase
number you input in the Sub
menu phrases

Only
Segmentized
Phrase

System plays back the system
default phrases associated to the
actions

Both Sub Menu
and Segmentized
Phrase

System plays back both the
custom instruction followed by
the default segmented phrases
associated to the actions

If you select Sub Menu Phrase or Both Sub Menu and Segmentized
Phrase, the Sub Menu Phrase (Company Salutation) field becomes
active. Indicate the custom recording you want played based on the
playback method defined. To define the Sub Menu Phrase (Company
Salutation) for different language environments, you must specify the
correct .VOX file in the Sub Menu Phrase drop-down list for each of the
ten default sub menus. Refer to the following table for the .VOX files that
correspond to the language that is required.

7.

Language

.VOX File (Range)

English

SAL9501.vox - SAL9510.vox
(set by default)

French

SAL9551.vox - SAL9560.vox

Gernman

SAL9601.vox - SAL9610.vox

Spanish

SAL9651.vox - SAL9660.vox

In the Timeout field, enter the number of milliseconds that the system
should wait for no user input before it reverts to the “No Action”
function.
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8.

Select Control Keys enables control function to be used while in a sub
menu or listening to a message.

9.

In the Description field, enter a text message describing the action of
this sub menu in the TUI template.

10.

Highlight an action and press the right mouse button and select Set
Action To. The DTMF key drop-down list appears.

11.

Select a DTMF key to match the action to.

Note: A dialog box will appear if additional information is required.
For more information, refer to Appendix F – Customize
Mailbox: DTMF Key Parameters.
12.
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Click Save Customize Mailbox.
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Specifying Control Keys
While listening to messages, a user can adjust the speed and volume of the
message. They can also pause, rewind, or fast forward it.
Note: If Control Keys have not been assigned, and a caller presses a
key while the message is playing, the system will respond as
if it has reached the end of the message and the associated
action key (for example, Save Message) has been pressed.
The Control Keys Enabled option must be selected on the main
Voice Menu.

To specify control keys:
1.

Click Control Keys. The Control Keys dialog appears.

2.

Highlight an action and press the right mouse button and select Set
Action To. The DTMF key drop-down list appears.
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3.

Select a DTMF key to match the action to and click OK.

Note: A dialog box will appear if additional information is required.
For more information, refer to Appendix G – Control Keys.

314

6510 UM Server Configuration Guide

Customizing a Mailbox

Customizing the Mailbox Flowchart
The display of the mailbox flowchart can be customized with colors, and fonts.

To customize the mailbox flowchart:
1.

Click Customize Mailbox Flowchart. The Customize Mailbox Flowchart
dialog appears.

2.

In the Color drop-down list, select the color you want the text to be
displayed in.

3.

In the Header Font drop-down list, select the font you want the header
to appear in.
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4.

In the Text Font drop-down list, select the font you want the text to
appear in.

5.

In the Max Number of Menus In Each Row drop-down list, select the
maximum number of menus that can appear in each row when the
flowchart is displayed.

6.

Click OK.

Copying a Customized Mailbox
After creating and configuring a customized mailbox, you can conveniently copy
the features and sub menus of that customized mailbox and duplicate it.

To copy a customized mailbox:
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1.

Double-click the Customized Mailbox that you want to copy. The
Customized Mailbox dialog appears.

2.

In the Customized Mailbox toolbar, click
. The Menu Number
displays the next available customize mailbox number. This is the menu
number associated to the customized mailbox settings that you have just
copied.

3.

Make any configuration changes, and click Save. A new customized
mailbox is created based on the settings that you have copied.
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In This Chapter . . .
Overview on page 318
Accessing the Supervisor Menu on page 318
Specifying the System Parameters on page 321
Recording a System Prompt on page 322
Changing the Holiday Setting on page 325
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Overview
Although the 6510 UM is designed with a comprehensive set of system screens,
you can perform many of the system's supervisory functions using a telephone. A
set of prompts guides you through these functions.
Hint: Make sure you read through this chapter to familiarize
yourself with the remote functions.

Accessing the Supervisor Menu
You can access the Supervisor menu from the handset.

To access the Supervisor menu:
1.

Access 6510 UM from an internal extension.

Note: If you are dialing into the system from outside the company,
press # and proceed to step 2.
2.

3.

Press * when you hear the password prompt. The system prompts you to
enter the Supervisor password.
Enter the Supervisor password.

Note: If an incorrect password is entered, you have three retries at
entering the correct password. If you do not enter the correct
password, the system hangs up.
The default password is 1111.
The system speaks the supervisor menu:

• To configure mailboxes, press 1
• Feature groups, press 2
• System parameters, press 3
• System prompts, press 4
• Company maintenance, press 5
Note: Multiple Supervisors may access the system supervisory
functions at the same time.

318

6510 UM Server Configuration Guide

Performing Supervisor Functions

Creating a Mailbox
You can use the handset to create a mailbox for a user without accessing the
Administration Console.

To create a mailbox:
1.

Press 1 at the Supervisor Main Menu. 6510 UM prompts you to enter the
first mailbox.

2.

Enter the lowest mailbox number in the list. 6510 UM prompts you to
enter the last mailbox.

3.

Enter the highest mailbox number.

Hint: To work with a single mailbox, enter the same mailbox
number as the first mailbox. If you make a mistake, press # to
return to the previous menu.
Creating a range of mailboxes automatically creates
sequentially numbered mailboxes. You may always delete
any unwanted mailboxes later.
The system prompts you press 1 to create a mailbox or 3 to delete a
mailbox.
4.

Press 1 to create a mailbox. 6510 UM prompts you to enter a two digit
feature group.

5.

Enter the feature group number to describe the features assigned to the
mailboxes you created. There will be a short pause after you enter this
value while the system creates the mailboxes.

6.

You receive mailbox creation confirmation and are transferred back to
the Supervisor Main Menu.

6510 UM Server Configuration Guide

319

Performing Supervisor Functions

Deleting a Mailbox
6510 UM allows you to delete one or more mailboxes that have been set up on
your system.
Caution: When the system deletes a mailbox, all prompts, messages, and
settings will be permanently removed and cannot be recovered.

To delete a mailbox:
1.

Press 1 at the Supervisor Main Menu. 6510 UM prompts you to enter the
first mailbox.

2.

Enter the lowest mailbox number in the list. 6510 UM prompts you to
enter the last mailbox.

3.

Enter the highest mailbox number.

Hint: To work with a single mailbox, enter the same mailbox
number as the first mailbox. If you make a mistake, press # to
return to the previous menu.
4.

The system prompts you press 1 to create a mailbox or 3 to delete a
mailbox.

5.

Press 3 to delete mailboxes. The system prompts you to confirm the
deletion of these mailboxes by pressing 1.

Note: When you press 1, there is a short pause.
6.
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Press 1. The system confirms that you have successfully deleted the
mailbox and transfers you to the Supervisor Main Menu.
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Specifying the System Parameters
The system parameters control the parameter values the system uses to perform its
operations.

To specify the parameters:
Press 3 at the Supervisor’s Administration Console. The following
prompts are available:

1.

“Enter the parameter number, followed by the new value for that
parameter. Press pound (#) when complete.”
For example, if you wish to change the Extension Length of the mailboxes
(Parameter 144) in the system to two (2), after the prompt press [144]
followed by [2] followed by [#].
Note: 6510 UM does not confirm the entered value. The same
prompt is played back after each entry. All parameters must
be entered as three digits. For example, parameter twelve
(12) must be entered as 012.
The following table displays the telephone keypad values for the special
characters utilized by the telephone system and the 6510 UM system.

2.

Name

Character

Phone Code

Flash Hook

&

*1

Pause

,

*2

Extension

E

*3

Sender’s Extension

S

*4

C.O.

C

*5

Mailbox

M

*6

Code for Inband

$

*7

Underscore

_

*8

Blank

*9

Pound

#

*0

Star

*

**
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3.

When you have finished entering the new parameters, press <#> to
return to the Supervisor main menu.

4.

Press <#> to exit the Supervisor main menu.

Recording a System Prompt
A system prompt is used to greet a caller when they reach your company.
For more information on the available system prompts supported by 6510 UM, refer
to Appendix A: System Prompts.

To record a system prompt:
1.

Press 4 at the Supervisor main menu. The system speaks the following
message:
Press one (1) for System Prompts; Press two (2) for Company Greetings.”
The Company Greetings are the personal salutations that callers hear
when they call your company (for example, “Good morning...you have
reached the ABC company...”). The System Prompts are the prerecorded
messages listed in Appendix E

2.

Press 1 to record System Prompts. The system speaks the following
message:
“Please enter the three digit system prompt to work with.”

3.

Enter the system prompt. 6510 UM plays back the prompt you have
chosen. When the playback ends, the system speaks the following
message:
“To accept, press one (1); to review, press two (2); to re-record press
three (3); or to return to the previous menu press pound (#).”

Note: “Record” deletes and replaces the original prompt.
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4.

Press 3 to record. After the tone, begin speaking in a clear, slow voice.
When you finish, press #.
6510 UM plays the system prompt that you just recorded. The system
then prompts you to choose one of the following options:
“To accept press one (1); to review press two (2); to re-record press three
(3);or to return to the previous menu press pound (#).”

5.

If you are satisfied with the system prompt, press 1.

6.

If you are not satisfied with the prompt, press 3 to re-record it.

7.

To record another system prompt, repeat steps 2 to 5.

8.

To return to the Supervisor Menu, stay on the line.

Recording a Company Greeting
Use the handset to record a company greeting.

To record a company greeting:
1.

Press 4 at the Supervisor main menu. The system speaks the following
message:
Press one (1) for System Prompts; Press two (2) for Company Greetings.”
The Company Greetings are the custom salutations that callers hear
when they call your company (for example, Good morning...you have
reached the ABC company...). The System Prompts are the prerecorded
messages listed in Appendix E

2.

Press 2 to record Company Greetings. The system speaks the following
message:
“Please enter the two digit Company Greeting to work with.”

3.

Enter the company number. The system speaks the following message:
“Please enter the three digit system salutation to work with.”

Note: The Company greetings are prompts set up on the Company
Menu. The numbers you use must be entered on the Company
Menu in the Greeting Times/Phrases section of the screen.
4.

Enter the company greeting. 6510 UM speaks the Company Greeting
you chose, if it was previously recorded.
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When the recording ends (if a greeting was previously recorded), the
system speaks the following prompt:
“To accept press one (1); to review press two (2); to re-record press three
(3); or to return to the previous menu, press pound.”
5.

Press 3 to record. After the tone, begin speaking in a clear, slow voice.

Hint: Try to eliminate all background noise. If possible, use a
telephone within your office. Accessing 6510 UM through
outside lines may result in additional background noise.
6.

When you finish, press #. 6510 UM plays the new greeting automatically.
When the greeting ends, 6510 UM speaks the following prompt:
“To accept press one (1); to review press two (2); to record press three
(3); or to return to the previous menu press pound (#)”.

7.

If you are satisfied with the system prompt, press 1.

8.

If you are not satisfied with the prompt, press 3 to re-record it.

9.

To record another system prompt, repeat steps 2 to 5.

10.
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To return to the Supervisor Menu, stay on the line
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Changing the Holiday Setting
Use the handset to change the holiday setting.

To add a holiday setting:
1.

Press 5 at the Supervisor’s Administration Console. The system speaks the
following prompt:
“Please enter the two digit Company number.”

2.

Enter the number of the company that you wish to modify. The system
speaks the following prompt:
“To listen to existing holidays, press <1>; to add a holiday, press <2>; to
delete a holiday, press <3>; or to return to the previous menu, press
<#>.” Press one (1) to review the dates and greeting numbers of
existing holidays on this particular company, press two (2) to input a new
holiday date and prompt number, and press three (3) to remove an
existing holiday date and prompt number.”

3.

Press 1 to listen to existing holidays. If any holidays exist, 6510 UM plays
the date and greeting number of each holiday assigned to this particular
company.

4.

Press 2 to add a holiday. The system speaks the following prompt:
“Enter the four (4) digit Holiday date, Month then Day.”

5.

Enter the three (3) digit Holiday Salutation. For example, Christmas Day
(December 25) would be entered 1225.

Note: When adding holidays, remember that you must record the
Holiday Salutation.
6.

Press 3 to delete a holiday:

7.

When you press 3 to delete a holiday, you are prompted for the
following:
“Enter the four (4) digit Holiday date to delete, Month then Day.”
For example, to remove Christmas Day (December 25) from the holiday
list, enter 1225.
Although 6510 UM is designed with a comprehensive set of system
screens, you can perform many of the system's supervisory functions
using a telephone. A set of prompts guides you through these functions.
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In This Chapter . . .
VPIM Tools Overview on page 328
Starting Web Report on page 347
Creating a Custom MMC Snap-In on page 361
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VPIM Tools Overview
VPIM Tools is a robust application that provides you with configuration and testing
tools for the VPIM server. This application allows you to freely test VPIM connectivity
as well as monitor and generate error reports. VPIM Tools should be used by
knowledgable system administrators and high level users.
The VPIM Tools application consists of 12 functions:
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1.

Errors

2.

Network

3.

ADPCM

4.

Addresses

5.

Log

6.

MSS

7.

Sender

8.

Service

9.

Settings

10.

Preferences

11.

Access

12.

Monitor
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To open VPIM Tools:
In the Windows Desktop Taskbar, click
Start>Programs>6510UM>VPIMClient. The Vpim Tools window
appears.

1.

Errors Tab
The Errors tab allows you to monitor error codes, unprocessed VPIM tasks and
unresolved messages.

Errors Box:
1.

Facility field: Displays the source of the error.

2.

Severity field: Displays the level of severity that the error is classified as.
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To resolve an error:
1.

Empty field: Enter an error code to see the source of the error.

Tasks Box:
The Tasks box shows all unprocessed VPIM tasks, including details such as the
destination, company, recipient, site, message and date of the unprocessed task.

Unresolved Box:
The Unresolved box displays all unresolved messages that are stored in the VPIM/
Unresolved directory.
1.
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Double-click on a message to display the message source in MIME
format.
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Network Tab
The Network tab displays network settings (network interfaces, IP addresses, DNS
servers). A simple DNS resolver is provided to allow the checking of DNS settings.
This feature is reserved for Advanced DNS users only.

Network Box:
The Network box displays all network information.

DNS Box:
The DNS box displays the DNS query results.

To check DNS settings:
1.

Server field: Enter the DNS server address (IP address or domain name).

2.

Complete checkbox: Select for a query that provides complete results.
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3.

Inverse checkbox: Select for a query that provides inverse results.

4.

Drop-down list: Select the type of DNS record.

5.

Click Query to fetch results. The results appear in the DNS box.

ADPCM Tab
The ADPCM tab allows you to convert audio files to and from the default ADPCM
(G726 4 bit) format. Supported formats that can be converted to and from ADPCM
(G726 4 bit) format are Wave PCM, OKI32, RHET32, and A-LAW.

Decoding/Format Box:
This feature allows you to decode an existing message in G726 4 bit format into
another format.
1.
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G726 4 bit ADPCM field: Enter the G726 4 bit file to decode.
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2.

Output file field: Enter the name for the decoded output file.

3.

In the Format box, select the format to decode to.

4.

Click Decode to decode.

5.

Click Play to listen to decoded file.

Encoding Box:
This feature allows you to encode a message into G726 4 bit format.
1.

Input file field: Enter the name of the input file.

2.

G726 4 bit ADPCM field: Enter the name for the encoded G726 4 bit
file.

3.

Click Encode to encode.

Addresses Tab
The Addresses tab allows you add and delete VPIM addresses to test VPIM
connectivity.
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To add/delete addresses:
1.

Address field: Enter the VPIM address.

2.

Drop-down list: Select the mailbox.

3.

Click Add to add the address or Delete to delete the address. Addresses
that are added are listed in the VPIM Address box. Deleted addresses are
removed from the VPIM Address box.

Note: You can verify the adding or deleting of the address by
opening the mailbox that the address is assigned to in the
6510 UM Admin.

VPIM Addresses box:
The VPIM Addresses box displays all VPIM addresses. To see mailboxes associated to
a specific address, click the VPIM address.

Mailbox box:
The Mailbox box displays all the mailboxes associated to the select VPIM address.
Double-click a mailbox to see details of the mailbox.

6510 UM Server Configuration Guide

335

Optional Modules

Log Tab
The Log tab allows you to view the log events. You can select the type of log file to
display, as well as the date and refresh rate.

Event Box:
The Event box displays all log events. You can select the type of log to view. Log
types include VPIM, DNS, ADPCM, CONN (connectivity), RECV (received msgs),
SENT, UNRES (unresolved), MSS, and STG (storage).
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1.

Refresh spinbox: Select the interval (in minutes) time to be used to
refresh the event display.

2.

Type drop-down list: Select the type of log file.

3.

Date drop-down list: Select the date of the log you want to view.

4.

Click Apply to initiate.
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MSS Tab
The MSS tab allows you to define synchronization rules, test synchronization and
verify MSS connectivity.

Synchronization Rules Box:
1.

Select the components that you want synchronized.

2.

Click Resynchronize to synchronize based on the rules defined.

Request Box:
1.

Messages Included checkbox: Select if you want messages to be
included in the synchronization.

2.

Click Request All Objects to synchronize all components (folders, users,
and messages).
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Test Box:
1.

Client field: Enter the client address.

2.

MSS Server field: Enter or select the MSS server that the client is
synchronized with.

3.

Click Test. If any problems in connectivity are detected, the appropriate
error codes will be displayed.

Sender Tab
The Sender tab allows you send a voice, fax, or text message to test connectivity.
Note: In order to send a voice message, a microphone must be
available on your system.
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Sender Box:
1.

Sender field: Enter the sender's address.

2.

Spoken Name field: Enter a spoken name (for voice messages) and click
Record to record the name.

3.

Recipient field: Enter the recipient's address.

4.

Delivery Status checkbox: Select to show delivery status.

5.

Subject field: Enter the subject for the test message.

6.

Voice Message/Fax/Text radio buttons: Select the type of test
message.

7.

Spoken Subject field: Enter a spoken subject name and click Record to
record subject.

8.

Message field: Enter the message, or select Record to record a voice
message, or select >>> to attach a fax message.

9.

Silence Level and Volume slidebars: If a voice message is being
recorded and sent, use the slidebars to adjust the silence level and
volume of the recorded message.

10.

Click Send to send test message. Any errors will be displayed. The
message will be sent to the defined recipient address.
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Service Tab
There Service tab allows you to control the VPIM server service.

Service box:
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1.

Computer field: Enter or select the location of the VPIM server.

2.

Click Start, Stop, or Restart to Start, Stop, or Restart the server.

3.

Service Path field: Identify the path where the VPIM server executable
file exists.

4.

Click Check to check the VPIM server status. Results are displayed in the
Dependencies box.
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Settings Tab
The Settings tab allows you to establish VPIM server settings.

Protocols Box:
1.

Enter the ports for the corresponding protocols and select the checkbox
to enable the protocol.

2.

If HTTP is defined and selected, it will enable you to view the members of
the voicemail system and the status of each mailbox through any Internet
connection. To do this, you must open an Internet browser, and in the
address field, enter the address in the format:
IP Address/HTTP Protocol
For example, 162.564.4.333/400
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Forwarding Box:
1.

Forwarding allowed checkbox: Select to enable the forwarding of
messages from remote machines.

2.

Smart Host field: Enter the port for the smart host. If VPIM server is not
connected to the Internet, all messages will be sent to the smart host
with an Internet connection so that the messages can be forwarded to
the intended recipient.

Others Box:
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1.

Maximum Connections drop-down list: Select the maximum number of
servers allowed.

2.

Check sender/recipient domain/IP checkbox: Enables the system to
check sender/recipient information.

3.

Monitoring checkbox: Enables monitoring through VPIM Client. (See
Monitor tab).

4.

Conversion type for mail client drop-down list: Select audio format for
SMTP, IMAP4 and POP3 servers. All VPIM message audio files are
converted into ADPCM format.

5.

Log Level bar: Select the log level to use.

6.

Click Apply to save settings.
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Preferences Tab
The Preferences tab allows you to set log deletion preferences, identify the
administrator address, and specify notification settings.

Log Deletion Box:
1.

Select Manually to enable the manual deletion of logs.

2.

Select Copy to Another Location to enable the copying of logs to
another location for storage. Enter the location in the field.

3.

Select Delete to enable the deletion of logs, and select the number of
days to keep logs until deletion.

4.

Click Process to enable selection.

5.

Click Apply to save settings.
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Administrator Box:
This function is not used in this version. In later releases, this feature will notify the
administrator address of all errors that occur.

Delivery Box:
1.

Number of Attempts spinbox: Select the number of attempts to send a
message. When the specified number is exceeded, the message is moved
to the unresolved directory in the Error tab.

2.

Delay Notification After spinbox: Select the number of attempts to
allow before delay notification is sent.

3.

Click Apply to save settings.

Access Tab
The Access tab is not functional in this version release.
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Monitor Tab
The Monitor tab allows you to retrieve and monitor VPIM server information.

Monitor Box:
1.

VPIM Server field: Enter or select the VPIM server to monitor.

2.

The Totals box displays the number of messages sent and received by
the selected VPIM server.

3.

The Queue Status box displays the queue status as well as the number
of unresolved messages.

4.

Refresh checkbox/spinbox: Select to enable refreshing, and select the
time interval at which to refresh.

5.

The Report box displays the VPIM server events.

6510 UM Server Configuration Guide

345

Optional Modules

6.

The Incoming/Outgoing Traffic boxes display the traffic information
for the VPIM server.

Note: The Incoming/Outgoing Traffic boxes will only be displayed if
the Monitoring checkbox is selected in the Settings tab.
7.
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Click Apply to save settings.
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Web Report Overview
The 6510 UM allows you to generate a variety of reports on key areas of the system
such as calls per hour by PBX and Company, port usage, and mailbox usage. These
reports help you adjust server load and performance to ensure maximum
productivity. In order to enable Web Report, you must first enable it in the 6510 UM
Administrator by clicking Configuration>Advanced>Log System Statistics and
setting the Value Data to be True.

Starting Web Report
Before you can generate a report, you must access the Web Report feature.

To start Web Report:
1.

Open your browser (using Microsoft Explorer 6.0 or greater, or Netscape
Navigator 6.2 or greater).

2.

In the Address field, enter the IP address of the UM server and click Go.
An example of an IP address can be 192.166.9.19\UM.

Note: If you do not know the proper IP address, contact your
Network Administrator.
The Web Client screen appears.
3.

Click Web Report. The Web Client dialog appears.
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4.

In the User Name field, enter your administrator user name.

5.

In the Password field, enter your administrator password and click
Login. The CallPerHour dialog appears.
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Generating a Call Per Hour Report
The Call Per Hour report details the number of calls per hour that have been made
on a particular PBX and Company for a specific time period.

To generate the report:
1.

Click CallPerHour. The CallPerHour dialog appears.

2.

From the PBX drop-down list, select a PBX or use the default.

3.

From the Company drop-down list, select a company or use the default.

4.

In the From field, enter the date when the report is to start.

5.

If you want to view the calendar for the current month, click the ...
button. The Calendar dialog appears.
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6.

From the Month drop-down list, select a month and year and click
Enter. You can also click on a calendar date.

7.

To change the date back to the current week, click This week.

8.

To change the date back to the current month, click This month.

9.

In the To field, enter the date when the report is to end.

10.
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Click View Report. Web Report displays the following report:
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Note: This report displays calls made on a single day. The greater
the length of time specified in the From and To fields, the
greater the number of calls that will be reported.
11.

Close the window to return to the Calls Per Hour dialog.

6510 UM Server Configuration Guide

351

Optional Modules

Generating Port Usage Reports
The Port Usage Report displays statistics on the activity of each port by hour, port,
company, and usage.

Creating a Port Usage by Hour Report
The Port Usage by Hour report details port usage by hour for all ports.

To generate a report:
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1.

In the Web Report Call Per Hour page, click PortUsage. The Port Usage
drop-down list appears.

2.

Click By Hour. The Port Usage by Hour dialog appears.

3.

From the PBX drop-down list, select a PBX or use the default.

4.

From the Company drop-down list, select a company or use the default.

5.

In the From field, enter the date when the report is to start.

6.

If you want to view the calendar for the current month, click the ...
button. The Calendar dialog appears.
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7.

From the Month drop-down list, select a month and year and click
Enter. You can also click on a calendar date.

8.

To change the date back to the current week, click This week.

9.

To change the date back to the current month, click This month.

10.

In the To field, enter the date when the report is to end.

11.

Click View Report. Web Report displays the following report:

12.

Close the window to return to the Port Usage By Hour dialog.
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Creating a Port Usage by Port Report
The Port Usage by Port report details port usage by individual port.

To generate a report:
1.

Click By Port. The Port Usage by Port dialog appears
For information on completing the fields, refer to Creating a Port Usage
by Hour Report on page 352.

2.

Click View Report. Web Report displays the Port Usage by Port report.

3.

Close the window to return to the Port Usage By Port dialog.

Creating a Port Usage by Company Report
The Port Usage by Company report details port usage by company.

To generate a report:
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1.

Click By Company. The Port Usage by Company dialog appears.

2.

In the From field, enter the date when the report is to start.

3.

If you want to view the calendar for the current month, click Browse.
The Calendar dialog appears.
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4.

From the Month drop-down list, select a month and year and click
Enter. You can also click on a calendar date.

5.

To change the date back to the current week, click This week.

6.

To change the date back to the current month, click This month.

7.

In the To field, enter the date when the report is to end.

8.

Click View Report. Web Report displays the following report:

9.

Close the window to return to the Port Usage by Company dialog.
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Creating a Port Usage by Usage Report
The Port Usage by Usage report details port usage by usage. Each port is reported
on in one-hour increments.

To generate a report:
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1.

Click By Usage. The Port Usage (by Usage) dialog appears.

2.

For information on completing the fields, refer to Creating a Port Usage
by Company Report on page 354

3.

Click View Report. Web Report displays the following report:

4.

Close the window to return to the Port Usage by Usage dialog.
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Generating a Mailbox Usage Report
The Mailbox Usage report displays information on the usage of mailboxes.

To generate a report:
1.

Click MailBoxUsage. The MailBoxUsage dialog appears.

2.

From the Company drop-down list, select a company or use the default.

3.

In the From Mailbox field, enter the first mailbox to report on.

4.

In the To Mailbox field, enter the last mailbox to report on.

5.

In the From field, enter the date when the report is to start.

6.

If you want to view the calendar for the current month, click Browse.
The Calendar dialog appears.

7.

From the Month drop-down list, select a month and year and click
Enter. You can also click on a calendar date.

8.

To change the date back to the current week, click This week.

9.

To change the date back to the current month, click This month.

10.

In the To field, enter the date when the report is to end.

11.

Click View Report. The Mail Box Usage report appears.

12.

Close the window to return to the MailBoxUsage dialog.
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Generating a Mailbox Info Report
The Mailbox Info report provides information on each mailbox, including its feature
Group, Personal Operator, and extension.

To generate a report:
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1.

Click MailBoxInfo. The MailBoxInfo dialog appears.

2.

From the Company drop-down list, select a company.

3.

In the From Mailbox field, enter the first mailbox to report on.

4.

In the To Mailbox field, enter the last mailbox to report on.

5.

Click View Report. The Mailbox Info report appears.

6.

Close the window to return to the MailBoxInfo dialog.
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Generating a Caller ID Report
The Caller ID report provides detail on Caller ID.

To generate a report:
1.

Click CallerID. The Caller ID dialog appears.

2.

From the Company drop-down list, select a company.

3.

From the Mailbox drop-down list, select a mailbox.

4.

In the From field, enter the date when the report is to start.

5.

If you want to view the calendar for the current month, click Browse.
The Calendar dialog appears.

6.

From the Month drop-down list, select a month and year and click
Enter. You can also click on a calendar date.

7.

To change the date back to the current week, click This week.

8.

To change the date back to the current month, click This month.

9.

In the To field, enter the date when the report is to end.
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10.

In the Prefix field, enter the

11.

Click View Report.
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Creating a Custom MMC Snap-In
When you access 6510 UM for the first time, you do not have access to any
of the application screens. To manage the 6510 UM and its associated components, you must use the Microsoft Management Console to create special
tools to delegate specific administrative tasks to users or groups and specify
the snap-in applications and services that you want to maintain.
To create a custom snap-in:
1.

Click Start > Run. The Run dialog appears.

2.

Enter MMC and click OK. The Console1 window appears.

3.

Click Console > Add/Remove Snap-in. The Add/Remove Snap-in
dialog appears.
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4.
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Click Add. The Add Standalone Snap-in dialog appears.
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5.

Highlight 6510 Admin and click Add. 6510 UM is pasted to the Add/
Remove Snap-in dialog.

6.

Highlight Services and click Add. The Services dialog appears.

7.

Select Local computer and click Finish and Close.

8.

Click OK. The Login Information dialog appears.
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9.

In the User Name field, enter your user name.

10.

In the Password field, enter your password.

11.

From the UM Server Name (IP Address) drop-down list, select the IP
address.

Note: The User name and Password will allow you to access the
6510 UM.
The default password for the Supervisor is 9999. While this
level allows routine maintenance to the system, it does not
allow access to the parameters screen.
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12.

Click OK. The 6510 Admin window appears.

13.

Click Console > Save to save the Console.
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Using System Prompts
The following pages list all of the prompts 6510 UM uses to answer and transfer
calls. These prompts are stored as MESS***.VOX files in the
C:\UM\PROMPTS\SYSTEM\1\.
Note: System prompts are not the same as Company Greetings. These are
stored in the C:\UM\PROMPTS\SYSTEM directory as SAL***.VOX
files, (where *** is also the prompt number).

Prerecorded Company Greeting
There are nine pre-recorded company greetings in the C:\UM\PROMPTS\SYSTEM\1\ directory. Be careful when recording your company greetings that you do
not accidentally select System Prompts and record over the existing voice.

List of Available Prompts
Use this list as reference if you are re-recording any of these prompts.
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Filename

Prompt

[MESS007.VOX]

Please hold for assistance.

[MESS008.VOX]

Paging your party.

[MESS009.VOX]

Thank you for calling. Good-bye.

[MESS010.VOX]

Thank you. Please hold.

[MESS011.VOX]

Transferring you to...

[MESS012.VOX]

Paging...

[MESS013.VOX]

One moment, you have a call

[MESS014.VOX]

I'm sorry, I did not understand that, please try again

[MESS015.VOX]

I'm sorry, that extension is busy.
To try another extension press 1; to try the extension again press 2;
to be transferred to the receptionist press 0, or stay on the line to
leave a message.

[MESS016.VOX]

I'm sorry, there is no answer at that extension. To try another
extension press 1; to be transferred to the receptionist press 0, or
stay on the line to leave a message.

[MESS017.VOX]

I'm sorry, your party is not in the office right now. To try another
extension press 1; to be transferred to the receptionist press 0, or
stay on the line to leave a message.

[MESS018.VOX]

…is out of the office and will return at...

[MESS019.VOX]

Please enter your area code and telephone number.

[MESS020.VOX]

Call for...

[MESS027.VOX]

Caller found; please hang up to receive the call.

[MESS028.VOX]

I'm sorry, no one is currently leaving you a message.

[MESS029.VOX]

Your party is now available.

[MESS033.VOX]

Enter the extension of the person you wish to redirect this call to.

[MESS035.VOX]

May I say who is calling?

[MESS038.VOX]

You have a call from...

[MESS040.VOX]

To accept press 1; send to another extension press 2; send to your
mailbox press pound.

[MESS041.VOX]

To accept press 1, send to another extension press 2, accept press
3, send to your mailbox press pound.

[MESS043.VOX]

There are...
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There is...

[MESS045.VOX]

...calls ahead of you.

[MESS046.VOX]

...call ahead of you.

[MESS048.VOX]

That extension is still busy. To try another extension press 1; to
remain on hold press 2; to leave a message press 5, or press star to
exit

[MESS049.VOX]

That extension is busy. To try another extension press 1; to remain
on hold press 2; to leave a message press 5, or press star to exit.

[MESS050.VOX]

That extension is busy. Your call is being processed next. To try
another extension press 1; to remain on hold press 2; to leave a
message press 5, or press star to exit.

[MESS052.VOX]

That extension is still busy, your call is being processed next. To try
another extension press 1; to remain on hold press 2; to leave a
message press 5, or press star to exit.

[MESS054.VOX]

Press 1 after hearing the name of the person you wish to be
transferred to.

[MESS055.VOX]

Enter the digits that correspond to the first few letters of the person
you wish to speak with. For the letter Q or Zed press 1.

[MESS056.VOX]

Enter the digits that correspond to the first few letters of the person
you wish to speak with. For the letter Q or Zee press 1.

[MESS057.VOX

I'm sorry, I do not recognize that name. Please re-enter the digits
that correspond to the first few letters of the person you wish to
speak with. For the letter Q or Zed, press 1.

[MESS058.VOX]

I'm sorry, I do not recognize that name. Please re-enter the digits
that correspond to the first few letters of the person you wish to
speak with. For the letter Q or Zee press 1.

[MESS061.VOX]

Press 1 for...

[MESS062.VOX]

Press 2 for...

[MESS063.VOX]

Press 3 for..

[MESS064.VOX]

Press 4 for...

[MESS065.VOX]

Press 5 for...

[MESS066.VOX]

Press 6 for...

[MESS067.VOX]

Press 7 for...

[MESS068.VOX]

Press 8 for...

[MESS069.VOX]

Press 9 for...

[MESS073.VOX]

Please enter the telephone number or numeric message to be sent.

[MESS074.VOX

You entered…
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[MESS075.VOX]

Thank you. Your message will be sent.

[MESS077.VOX]

I'm sorry, that mailbox is full. Please try again later.

[MESS080.VOX]

Record your message at the tone. When finished, hang-up or press
pound for more options

[MESS081.VOX]

To try another extension press 1; to leave a message press 5; to be
transferred to the receptionist press 0.

[MESS082.VOX]

To send your message press 1; To re-record your message press 2;
to review your message press 3; to continue recording press 4; to
cancel your message press star.

[MESS083.VOX]

To send your message with normal delivery press 1; to send with
urgent delivery, press 2

[MESS084.VOX]

There are 10 seconds of recording time left.

[MESS086.VOX]

If you would like to receive a response for this message press 1.

[MESS090.VOX]

Thank you. Your message has been sent.

[MESS103.VOX]

To confirm deletion of this message press 9, or press pound to
return to the previous menu.

[MESS107.VOX]

Mass recall deleted.

[MESS108.VOX]

I'm sorry, you do not currently have access to that feature.

[MESS109.VOX]

I'm sorry, that is not a valid entry.

[MESS110.VOX]

You have...

[MESS112.VOX]

...new messages.

[MESS113.VOX]

...new message.

[MESS119.VOX]

This message is a fax.

[MESS121.VOX]

End of new messages.

[MESS124.VOX]

I'm sorry, you cannot reply to a message sent by an outside caller.

[MESS125.VOX]

...received your message on...

[MESS126.VOX]

You cannot reply to a private message.

[MESS131.VOX]

Reply sent. What would you like to do with the original message?

[MESS132.VOX]

To send this message standard press 1; certified press 2.

[MESS133.VOX]

Message sent certified.

[MESS134.VOX]

Message saved.

[MESS135.VOX]

Message deleted.

[MESS136.VOX}

Message moved.

[MESS139.VOX]

Enter the next recipient's mailbox number. If finished, press
pound.
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Enter the destination mailbox number.

[MESS142.VOX]

That is an invalid mailbox. Please try again.

[MESS143.VOX]

Begin speaking at the tone. Press pound when finished.

[MESS145.VOX]

To send your message press 1; re-record your message press 2;
review your message press 3; continue recording press 4; cancel
your message press star.

[MESS147.VOX]

Nothing recorded.

[MESS152.VOX]

Notification entries.

[MESS153.VOX]

Notification entry.

[MESS155.VOX]

Blank.

[MESS160.VOX]

To add a new notification entry press 1; to modify an entry press 2;
to delete an entry press 3; to listen to an entry press 1; to turn
notification on or off press 5. Or, to return to the previous menu,
press pound.

[MESS163.VOX]

Please enter the telephone number for notification. When finished,
press the pound sign.

[MESS167.VOX]

If this is correct press 1. Otherwise press 2.

[MESS168.VOX]

If this is a beeper, press 1; phone, press 2.

[MESS169.VOX]

Notification added.

[MESS170.VOX]

Please record your notification prompt at the tone; press pound to
exit.

[MESS172.VOX]

Please enter the 4 digit start time, hour then minute.

[MESS173.VOX]

Please enter the 4 digit start date, month then day.

[MESS174.VOX]

Please enter the 4 digit stop time, hour then minute.

[MESS175.VOX]

Please enter the 4 digit stop date, month then day.

[MESS176.VOX]

Please enter the entry number to be changed

[MESS177.VOX]

That is an invalid outcall entry.

[MESS178.VOX]

Please enter the outcall entry to delete, to delete all entries press
star.

[MESS179.VOX]

Notification is now active.

[MESS180.VOX]

Notification is now off.

[MESS186.VOX]

Hello this is your voice messaging system. There is a message for...

[MESS189.VOX]

Urgent message.

[MESS190.VOX]

New voice message.

[MESS195.VOX]

New data messages.
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[MESS196.VOX]

New email message.

[MESS197.VOX]

New email messages.

[MESS200.VOX]

Enter the destination number. To return to the previous menu,
press pound.

[MESS202.VOX]

I'm sorry, that is an invalid mailbox number.

[MESS203.VOX]

To add comments press 1; to forward without comments press 2.

[MESS205.VOX]

Message forwarded. What would you like to do with the original
message?

[MESS230.VOX]

To listen to an existing list press 1; add a list press 2; modify an
existing list press 3; delete an existing list press 4, or to return to the
previous menu press pound.

[MESS233.VOX]

There are no distribution lists at this time.

[MESS235.VOX]

End of list.

[MESS240.VOX]

Enter the list number to modify.

[MESS242.VOX]

I'm sorry, there is no such list.

[MESS245.VOX]

To listen to list members press 1; add members to your list press 2;
delete members from your list press 4; change list name press 5, or
to return to the previous menu press pound.

[MESS248.VOX]

End of list.

[MESS255.VOX]

Enter the mailbox number to be added.

[MESS260.VOX]

Enter the mailbox number to be deleted.

[MESS265.VOX]

Enter the list number to add.

[MESS267.VOX]

Please record the list name at the tone, when finished press pound.

[MESS270.VOX]

To accept press 1; to re-record press 2, or to return to the previous
menu press pound.

[MESS272.VOX]

To add members to this list press 1; to continue press 2, or to return
to the previous menu press pound.

[MESS275.VOX]

Enter the list number to be deleted.

[MESS280.VOX]

Enter the list number to send this message to.

[MESS281.VOX]

Your distribution list is being processed. Please hold until you hear
the Administration Console prompt or hang up and call back later.

[MESS300.VOX]

Please enter the supervisor password.

[MESS305.VOX]

SUPERVISOR MAIN MENU- To configure mailboxes press 1; to
configure feature groups press 2; for system parameters press 3; for
system prompts press 4; for company maintenance press 5; to
check faxes press 9; to return to the automated attendant press 0,
or to disconnect press pound.
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[MESS306.VOX]

SUPERVISOR ADMINISTRATION CONSOLE- To configure mailboxes
press 1; to configure feature groups press 2; for system parameters
press 3; for system prompts press 4; for company maintenance
press 5; to return to the automated attendant press 0, or to
disconnect press pound.

[MESS310.VOX]

I’m sorry, there is no such voice prompt.

[MESS311.VOX]

To change system time press 1; to change system date press 2; to
change operation mode press 3; to return to the previous menu
press pound.

[MESS312.VOX]

The office is now open.

[MESS313.VOX]

The office is now closed

[MESS323.VOX]

Enter the parameter number followed by the new value for that
parameter followed by the pound sign.

[MESS326.VOX]

Enter the two digit feature group number to change. To return to
the previous menu press pound.

[MESS329.VOX]

To review press 1; to modify press 2.

[MESS343.VOX]

You have entered an incorrect value; try again.

[MESS351.VOX]

Please enter the message segment number to be recorded.

[MESS355.VOX]

Press 1 for system prompts, 2 for company greetings.

[MESS358.VOX]

Enter the three digit system prompt to work with.

[MESS361.VOX]

Press 1 to accept, 2 to review, 3 to record, or pound to exit.

[MESS370.VOX]

Please enter the 3 digit system salutation to work with.

[MESS380.VOX]

Please enter the first mailbox.

[MESS382.VOX]

Please enter the last mailbox.

[MESS385.VOX]

To create mailboxes, press 1; to delete mailboxes, press 3.

[MESS387.VOX]

Please enter the two digit feature group for these mailboxes.

[MESS395.VOX]

Press 1 to confirm deletion of these mailboxes, or press pound to
return to the previous menu.

[MESS400.VOX]

Please enter your mailbox number.

[MESS404.VOX]

I'm sorry, that mailbox is invalid; please try again.

[MESS405.VOX]

Please enter your password.

[MESS412.VOX]

Enter the mailbox number to have calls forwarded to.

[MESS413.VOX]

Call forwarding is now off

[MESS414.VOX]

Calls forwarded to...

[MESS415.VOX]

Enter the destination to forward messages to.

[MESS416.VOX]

Enter the 4 digit delay time, hour then minute.
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[MESS417.VOX]

Call screening is now off.

[MESS418.VOX]

Call screening is now active.

[MESS419.VOX]

Messages forwarded to...

[MESS420.VOX]

To delete messages upon forwarding press 1; to leave messages in
your mailbox after forwarding press 2.

[MESS421.VOX]

Message forwarding is now off.

[MESS422.VOX]

Call queuing is now off.

[MESS423.VOX]

Call queuing is now active.

[MESS426.VOX]

You are now logged in.

[MESS427.VOX]

You are now logged out.

[MESS450.VOX]

MAILBOX OPTIONS MENU - To record prompts press 1; notification
options press 2; call transfer options press 3; change autoforwarding press 4; distribution list maintenance press 5; change
your password press 9; return to the Administration Console press
pound.

[MESS454.VOX]

To accept this prompt press 1; re-record press 2; delete press 3;
review press 4; to return to the previous menu press pound.

[MESS458.VOX]

Message playback will be Last In First Out.

[MESS459.VOX]

Message playback will be First In First Out.

[MESS472.VOX]

Your mailbox is no longer password protected.

[MESS473.VOX]

Please enter you new password, up to 15 digits, followed by the
pound sign.

[MESS475.VOX]

To confirm, re-enter your new password, followed by the pound
sign.

[MESS476.VOX]

I'm sorry, your entries do not match; please try again.

[MESS477.VOX]

Your new password will be active the next time you call.

[MESS478.VOX]

Auto time stamp is now active.

[MESS479.VOX]

Auto time stamp is now off.

[MESS480.VOX]

Do not disturb is now active.

[MESS481.VOX]

Do not disturb is turned off.

[MESS482.VOX]

Pre-paging is now off.

[MESS483.VOX]

Pre-paging is now active.

[MESS484.VOX]

Post-paging is now off.

[MESS485.VOX]

Post-paging is now active.

[MESS490.VOX]

To repeat this prompt press 0, or to return to the previous menu
press pound.
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RECORD MENU - To record your personal greeting prompt press 1;
record your busy prompt press 2; record your gone home prompt
press 3; record your name prompt press 4; record your optional
greetings press 5; set your active greeting press 6; or, to return to
the previous menu press pound.

[MESS492.VOX]

Enter the 2 digit greeting to record, 1 to 99.

[MESS493.VOX]

Enter the 2 digit greeting to activate. To deactivate your optional
greeting press 0.

[MESS494.VOX]

Select the language number to record your prompts for.

[MESS496.VOX]

Default greetings are now active.

[MESS497.VOX]

Your active greeting is number…

[MESS500.VOX]

<One minute of music used in the Holding Queue.>

[MESS515.VOX]

Please enter the two digit company number.

[MESS516.VOX]

I’m sorry, that is not a valid company number.

[MESS517.VOX]

To listen to existing holidays press 1; add a holiday press 2; delete a
holiday press 3; or, to return to the previous menu press the pound
sign.

[MESS522.VOX]

Enter the 4 digit holiday date, month then day.

[MESS524.VOX]

Enter the 3 digit holiday salutation.

[MESS526.VOX]

Holiday added.

[MESS527.VOX]

Enter the 4 digit holiday to delete, month then day.

[MESS529.VOX]

Holiday deleted.

[MESS562.VOX]

This is an automated call, to disconnect press 1.

[MESS581.VOX]

...is at lunch and will return at...

[MESS582.VOX]

...is at lunch.

[MESS583.VOX]

...cannot be interrupted, but will be available after...

[MESS584.VOX]

...cannot be interrupted.

[MESS585.VOX]

...is in a meeting, and will be available after...

[MESS586.VOX]

...is in a meeting.

[MESS587.VOX]

...will be out of the office until...

[MESS588.VOX]

...is out of the office.

[MESS589.VOX]

...is away on vacation until...

[MESS590.VOX]

...is on vacation.

[MESS591.VOX]

...is out of town until...

[MESS592.VOX]

...is out of town.
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[MESS620.VOX]

There are new unreceived faxes.

[MESS621.VOX]

There are no unreceived faxes.

[MESS622.VOX]

To save this fax as a document press 1; delete this fax press 2; skip
to the next fax press the star key, or to return to the previous menu
press pound

[MESS624.VOX]

Enter the document number to save the fax as.

[MESS625.VOX]

Document saved.

[MESS626.VOX]

Error saving document; you may have to re-fax this document to
save it properly.

[MESS627.VOX]

There are more unreceived faxes.

[MESS628.VOX]

No more unreceived faxes.

[MESS629.VOX]

Deleting fax. To confirm the deletion of this fax press 9.
Otherwise, press pound to return to the previous menu.

[MESS630.VOX]

Fax deleted.

[MESS631.VOX]

Error deleting fax.

[MESS640.VOX]

At the sound of the fax tone, press start on your fax machine.

[MESS641.VOX]

There are currently no free fax ports, please try again later.

[MESS650.VOX]

To change the mailbox language press 3.

[MESS672.VOX]

This is your wakeup call, to cancel press 1, to reschedule press2, or
press any other key to snooze.

[MESS673.VOX]

For same time tommorow, press 1; to enter a new time, press 2.

[MESS680.VOX]

Please enter your area code and fax number.

[MESS700.VOX]

...press 0.

[MESS701.VOX]

...press 1.

[MESS702.VOX]

...press 2.

[MESS703.VOX]

...press 3.

[MESS704.VOX]

...press 4.

[MESS705.VOX]

...press 5.

[MESS706.VOX]

...press 6.

[MESS707.VOX]

...press 7.

[MESS708.VOX]

...press 8.

[MESS709.VOX]

...press 9.

[MESS710.VOX]

...press star.

[MESS711.VOX]

...press pound.
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...press star.

[MESS720.VOX]

Please enter your customer ID.

[MESS721.VOX]

Please re-enter your customer ID.

[MESS730.VOX]

Please enter your access code.

[MESS740.VOX]

Please enter the document number to be faxed.

[MESS742.VOX]

I’m sorry, you have entered an invalid document number, please try
again.

[MESS743.VOX]

Document has been sent.

[MESS744.VOX]

Please enter the area code and fax number of the receiving fax
machine.

[MESS745.VOX]

Your fax will be sent to...

[MESS746.VOX]

Please enter your extension number so that the fax can be directed
to your attention.

[MESS747.VOX]

... is an invalid fax number

[MESS755.VOX]

To send your fax to your default fax machine press 1. To select a
different fax number press 2.

[MESS756.VOX]

To send your fax to your default fax number machine press 1; to
select a different fax number press 2; to save this fax as a Fax On
Demand document press 4.

[MESS770.VOX]

Please enter the country code of the receiving fax machine,
followed by the pound sign.

[MESS771.VOX]

Please enter your country code, followed by the pound sign.

[MESS772.VOX]

Please enter the country code for your outcall destination, followed
by the pound sign.

[MESS773.VOX]

Please enter the country code for your wakeup call, followed by the
pound sign.

[MESS774.VOX]

That is an invaid number. Please try again.

[MESS775.VOX]

Please enter your area code, followed by the pound sign.

[MESS776.VOX]

Please enter your telephone number, followed by the pound sign.

[MESS800.VOX]

Welcome to your new voice messaging system. Over the next few
minutes we will introduce you to some of the features of the
system and help you initialize your mailbox. If you wish to exit the
tutorial at any point, press the pound sign located on the bottom
right hand corner of your telephone keypad.
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[MESS801.VOX]

Your mailbox is where all your messages will be stored and also
where you can send messages to others in your company. To keep
your mailbox secure you should enter a password. Your password
can be one to fifteen digits in length, and cannot start with a zero.
Please enter your new password now.

[MESS802.VOX]

Callers will hear one of three personal prompts when they are
leaving a message for you. First, there is the personal greeting
prompt. This prompt is heard when you are not at your desk but
are in the office. Try to change this prompt as often as possible and
include your name and current date in all messages. An example of
this prompt would be "Hi, this is Jane on January 15th. I'm in today
but I can't take your call right now. Please leave a message at the
tone and I will return your call as soon as possible. Thank you".
You will now be asked to record your personal greeting.

[MESS803.VOX]

The busy prompt will let the caller know that you are on the phone.
An example of this prompt would be “Hi, this is Jane, I'm on the
phone right now and can't take your call, please leave a message at
the tone and I will return your call as soon as possible. Thank you".
You will now be asked to record your busy prompt.

[MESS804.VOX]

The gone home prompt is activated when you have gone home for
the day. This will automatically be played when you log out of the
system, so you only need to record it once. An example of this
prompt would be "Hi, this is Jane, I have gone home for the day.
Please leave a message at the tone and I will return your call
tomorrow.” You will now be asked to record your gone home
prompt.

[MESS805.VOX]

The next prompt to record is your name prompt. It consists of your
first and last name. This prompt is entered in a variety of places,
and will identify your mailbox to callers leaving you messages. An
example of a name prompt is " Jane Jackson". You will now be
asked to record your name prompt.

[MESS806.VOX]

Finally, in order to register you in the company directory you will
have to spellthe first three letters of your last name. Callers who do
not know your extension can access your mailbox by spelling your
last name in the company directory. For example if your last name is
"Jackson" press 522. Please enter the three letters of your last
name now.

[MESS807.VOX]

This completes your mailbox tutorial. If you require to make
additional changes to your prompts, you can follow the instructions
in your user's guide. If you have any questions about using your
new mailbox, you may ask your system supervisor. Thank you.
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[MESS808.VOX]

Since you have decided not to carry out your tutorial, you will need
to follow the instructions in your User's guide to change your
prompts and password. If you have any questions about using your
new mailbox, you may as your system supervisor. Thank you.

[MESS820.VOX]

Welcome to your voice mail. Your mailbox is where your messages
will be stored. It is simple to use. If you have any questions about
using your mailbox, please contact the front desk.

[MESS840.VOX]

Your current wakeup call is for...

[MESS841.VOX]

To add a wake up call press 1, to return to the previous menu press
pound.

[MESS842.VOX]

To cancel your wake up call press 1, to reschedule your wake up
call press 2, to return to the previous menu press pound.

[MESS844.VOX]

Please enter the 4-digit wake up call time, hour then minutes.

[MESS845.VOX]

Please enter the 4-digit wake up call date, month then day.

[MESS850.VOX]

Please enter the telephone number for your wake up call.

[MESS885.VOX]

Wake up call added.

[MESS899.VOX]

Press 1 for Yes, press 2 for no.

[MESS900.VOX]

Allow message lights.

[MESS901.VOX]

Allow beeper message delivery.

[MESS902.VOX]

Allow phone message delivery.

[MESS903.VOX]

Allow long distance message delivery.

[MESS904.VOX]

Allow call screening.

[MESS905.VOX]

Allow call forwarding.

[MESS906.VOX]

Allow do not disturb.

[MESS907.VOX]

Allow busy hold.

[MESS908.VOX]

Allow call queuing.

[MESS909.VOX]

Allow pre-transfer paging.

[MESS910.VOX]

Allow post-transfer paging.

[MESS911.VOX]

Allow distribution lists.

[MESS912.VOX]

Allow directory registration.

[MESS913.VOX]

Allow message confirmation.

[MESS914.VOX]

Allow message recovery.

[MESS915.VOX]

Allow login / logout.

[MESS916.VOX]

Allow access to supervisor functions.

[MESS917.VOX]

Enter maximum number of messages allowed.

6510 UM Server Configuration Guide

Appendix A

[MESS918.VOX]

Enter maximum message length.

[MESS919.VOX]

Enter maximum days to save messages.

[MESS920.VOX]

Enter maximum rings for call progress.

[MESS921.VOX]

For no transfer supervision press 1; for busy only supervision press
2; for busy no answer supervision press 3; for multilingual
supervision press 4.

[MESS922.VOX]

Enter mailbox language number.

[MESS1000.VOX]

Send to menu...

[MESS1001.VOX]

For mailbox options...

[MESS1002.VOX]

To record prompts...

[MESS1003.VOX]

For notification options...

[MESS1004.VOX]

For call transfer options...

[MESS1005.VOX]

For distribution list maintenance...

[MESS1006.VOX]

To change your password...

[MESS1007.VOX]

For message options...

[MESS1008.VOX]

To return to the automated attendant...

[MESS1009.VOX]

To disconnect...

[MESS1010.VOX]

To add a list...

[MESS1011.VOX]

To delete an existing list...

[MESS1012.VOX]

To modify a list...

[MESS1013.VOX]

To review lists...

[MESS1014.VOX]

To return to the main menu...

[MESS1021.VOX]

To add a notification entry...

[MESS1022.VOX]

To delete a notification entry...

[MESS1023.VOX]

To modify an existing notification entry...

[MESS1024.VOX]

To review notifications...

[MESS1025.VOX]

To turn notification on or off...

[MESS1029.VOX]

To set a wake up call...

[MESS1031.VOX]

To clear your password...

[MESS1032.VOX]

To listen to your existing password...

[MESS1033.VOX]

To set a new password...

[MESS1034.VOX]

To clear your voice password...

[MESS1035.VOX]

To listen to your existing voice password...

[MESS1036.VOX]

To set a new voice password...
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[MESS1038.VOX]

To browse...

[MESS1040.VOX]

To browse folders...

[MESS1041.VOX]

To autoplay messages...

[MESS1042.VOX]

To listen...

[MESS1043.VOX]

Unread...

[MESS1044.VOX]

Read...

[MESS1045.VOX]

Voice...

[MESS1046.VOX]

E-mail...

[MESS1047.VOX]

Fax...

[MESS1048.VOX]

And...

[MESS1049.VOX]

In...

[MESS1050.VOX]

To...

[MESS1051.VOX]

Messages...

[MESS1052.VOX]

Your inbox...

[MESS1053.VOX]

Your deleted folder...

[MESS1054.VOX]

Your outbox...

[MESS1055.VOX]

Your sent items...

[MESS1056.VOX]

Folder...

[MESS1057.VOX]

To send a message...

[MESS1059.VOX]

To change auto forwarding...

[MESS1060.VOX]

To reply to all...

[MESS1061.VOX]

To delete...

[MESS1062.VOX]

To move to...

[MESS1063.VOX]

To review...

[MESS1064.VOX]

To reply...

[MESS1065.VOX]

To forward...

[MESS1066.VOX]

For message information...

[MESS1067.VOX]

For time and date...

[MESS1068.VOX]

To skip to the next message...

[MESS1069.VOX]

To record out of town greeting...

[MESS1070.VOX]

To record personal greeting...

[MESS1071.VOX]

To record busy greeting...

[MESS1072.VOX]

To record gone home greeting...
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[MESS1073.VOX]

To record name prompt...

[MESS1074.VOX]

To record do not disturb greeting...

[MESS1075.VOX]

To record lunch greeting...

[MESS1076.VOX]

To record vacation greeting...

[MESS1077.VOX]

To record in meeting greeting...

[MESS1078.VOX]

To record optional prompts...

[MESS1079.VOX]

To set active greeting...

[MESS1081.VOX]

To change your status...

[MESS1082.VOX]

To play active greetings...

[MESS1083.VOX]

To clear mass recall...

[MESS1084.VOX]

To recall a caller...

[MESS1091.VOX]

To turn call screening on or off...

[MESS1092.VOX]

To turn call forwarding on or off...

[MESS1093.VOX]

To turn call queuing on or off...

[MESS1094.VOX]

To turn post paging on or off...

[MESS1095.VOX]

To turn pre paging on or off...

[MESS1096.VOX]

To print...

[MESS1097.VOX]

To deliver to a fax machine...

[MESS1098.VOX]

To review and print...

[MESS2001.VOX]

Unread voice message.

[MESS2002.VOX]

Unread voice messages.

[MESS2003.VOX]

Unread e-mail message.

[MESS2004.VOX]

Unread e-mail messages.

[MESS2005.VOX]

Unread fax message.

[MESS2006.VOX]

Unread fax messages.

[MESS2007.VOX]

Read voice message.

[MESS2008.VOX]

Read voice messages.

[MESS2009.VOX]

Read e-mail message.

[MESS2010.VOX]

Read e-mail messages.

[MESS2011.VOX]

Read fax message.

[MESS2012.VOX]

Read fax messages.

[MESS2013.VOX]

For...
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[MESS2016.VOX]

Please enter the desired folder number; to list sub folders, press
star.

[MESS2018.VOX]

When you hear your desired sub folder name, press 1.

[MESS2019.VOX]

End of sub folders.

[MESS2022.VOX]

For unread messages, press 1; e-mail messages, press 2; all
messages, press 9.

[MESS2023.VOX]

For voice messages, press 1; e-mail messages, press 2; fax
messages, press 3; all messages, press 9.

[MESS2024.VOX]

Message marked urgent.

[MESS2025.VOX]

Message marked private.

[MESS2027.VOX]

To set your status to In Office, press 1; Gone Home, press 2; Do Not
Disturb, press 3; At Lunch, press 4; In a Meeting, press 5; On
Vacation, press 6.

[MESS2028.VOX]

Please enter the four digit date you will return, month then day.

[MESS2029.VOX]

Please enter the four digit time you will return, hour then minute.

[MESS2034.VOX]

To send this message, press 1; mark message urget, press 2; review
message, press 3; rerecord message, press 4; append message,
press 5; cancel message, press star.

[MESS2035.VOX]

To send this message, press 1; mark message urgent, press 2;
review message, press 3; rerecord message, press 4; append
message, press 5; cancel message, press star.

[MESS2036.VOX]

To send standard, press 1; certified, press 2; private, press 3;
certified and private, press 4.

[MESS2037.VOX]

Enter the four digit date you want this message delivered, month
then day.

[MESS2038.VOX]

Enter the four digit time you want this message delivered, hour
then minute.

[MESS2039.VOX]

Your message will be delivered on...

[MESS2040.VOX]

Your current greeting is...

[MESS2041.VOX]

This is how your new greeting will sound...

[MESS2045.VOX]

For...

[MESS2046.VOX]

Voice messages, press 1.

[MESS2047.VOX]

E-mail messages, press 2.

[MESS2048.VOX]

Fax messages, press 3.

[MESS2049.VOX]

...all messages, press 9.

[MESS2050.VOX]

To return to the previous menu, press pound.
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[MESS2100.VOX]

To enroll, press 1. To return to the previous menu, press pound.

[MESS2101.VOX]

Your voiceprint is not in our database.

[MESS2102.VOX]

Would you like to enroll now?

[MESS2103.VOX]

Your voiceprint is already registered.

[MESS2104.VOX]

Would you like to re-enroll?

[MESS2105.VOX]

To re-enroll, press 1. To return to the previous menu, press pound.

[MESS2106.VOX]

Please say your first and last name.

[MESS2107.VOX]

Again, please repeat your first and last name.

[MESS2108.VOX]

Please count from zero to nine as follows: zero, one, and so on.

[MESS2109.VOX]

Please count from nine to zero as follows: nine, eight and so on.

[MESS2110.VOX]

Lastly, please say the four digit year you were born in.

[MESS2111.VOX]

Thank you. You have successfully enrolled.

[MESS2150.VOX]

Hello, thank you for calling. Please say the person you’re trying to
reach, or use the keyword, followed by your name, to login to your
mailbox. Alternatively, you can enter the extension you are trying to
reach, or press pound to log into your mailbox.

[MESS2151.VOX]

Please say your mailbox number.

[MESS2152.VOX]

Please say your extension.

[MESS2153.VOX]

Please say the following five digit number.

[MESS2154.VOX]

Please say what day of the week it is.

[MESS2155.VOX]

Please say your phone number.

[MESS2156.VOX]

Please say the four digit year you were born in.

[Answer.VOX]

Answer.

[Sayyes.VOX]

When you hear the name of the person you are trying to reach, say
yes or press 1.

[Sayno.VOX]

Say no.

[Retry.VOX]

I’m sorry, can you please repeat that?

[Retry2.VOX]

I don’t think I heard you, can you please repeat that?

[Retry3.VOX]

I’m sorry, please say the first and last name of the person you are
trying to reach or dial their extension number.

[Retry4.VOX]

Who?

[Nameconf.VOX]

Did you say...?

[Nameconf2.VOX]

I think you said...

[Nameconf3.VOX]

...is that correct?
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[Multiple.VOX]

The following names match your selection.

[Multiple2.VOX]

There are multiple matches.

[Multiple3.VOX]

More than one person has this name.

[Hangup.VOX]

Sorry, you are having trouble. Please try again later. Thank you for
calling. Goodbye.

[Dstar.VOX]

Star.

[Dpound.VOX]

Pound.

[Cmdconf.VOX]

I think I heard...

[Stopxfer.VOX]

To stop the tranfer to...

[Stopxfer2.VOX]

Say no if you’d like to try another name.

[Stopxfer3.VOX]

To stop this tranfer please say no.

[Finalxfer.VOX]

Sorry, I’m having so much trouble, I’m transferring you to the
operator and I’ll work on recognizing that name better.

[A.VOX]

A

[B.VOX]

B

[C.VOX]

C

[D.VOX]

D

[E.VOX]

E

[F.VOX]

F

[G.VOX]

G

[H.VOX]

H

[I.VOX]

I

[J.VOX]

J

[K.VOX]

K

[L..VOX]

L

[M.VOX]

M

[N.VOX]

N

[O.VOX]

O

[P.VOX]

P

[Q.VOX]

Q

[R.VOX]

R

[S.VOX]

S

[T.VOX]

T

[U.VOX]

U

6510 UM Server Configuration Guide

Appendix A

[V.VOX]

V

[W.VOX]

W

[X.VOX]

X

[Y.VOX]

Y

[Z.VOX]

Z
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Overview
Voice menu actions allow you to perform voice actions.
Action

Definition

Ask Password

Restricts access to sensitive areas of the voice menu.
Callers selecting this option must enter the correct
password to get to the next menu level.
Enter a password in the box labeled "Password." Enter
a menu number in the box labeled "Next Menu".
Note: The caller is given three opportunities to enter a
correct access code before the system terminates the
connection.

Ask Pin Number

This option prompts the callers to enter a PIN number
and, if valid, refers to the Call Routing Table to
determine where to send them. The valid PIN number is
already entered in the Call Routing Table, with a
destination mailbox indicated.
Note: Enter a phrase number in the box labeled
“Action Phrase.” Enter a menu number in the box
labeled “Invalid.”

Ask Question

Use this option to obtain information from callers.
When this option is selected, callers hear a pre-recorded
question. 6510 UM stores the response to the question
in the specified mailbox and then transfers the caller to
the next voice menu. To ask several questions, use this
action in the next menu. All answers will be joined
together and stored as one message in the specified
mailbox.
Note: Enter a mailbox number in the box labeled
"Mailbox." Enter a menu number in the box labeled
"Next Menu." Enter a question number in the box
labeled "Question."
The Questions, Voice Menu prompts and the Company
Greetings are all stored as the same type of file. The
question numbers that you choose for this action must
not be the same as the Company Greetings. Refer to
the Company Menu to see company greeting prompt
numbers.
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Beep Caller Phone
Number

This option acts just like Send Beeper Message, an
option that is available in all mailboxes. A caller
selecting this option is prompted to enter his/her phone
number using the telephone keypad. The DTMF digits
that are entered are then sent to the User's
Alphanumeric pager.
Note: The user must have an Alphanumeric pager
that is configured in the Notification of the User's
mailbox.

Disconnect

Allow callers to disconnect from the 6510 UM system.

Get Caller ID Info

This option prompts the caller to enter their telephone
number. The number entered is then displayed as Caller
ID to the User’s desktop.

Get Destination from
DB

Asks the caller for their number or pin code and sends
the call information to the active X that has pre-defined
actions and integration setup.

Get Transfer Mailbox

Use this option to allow callers to transfer directly from
within the voice menu to a desired extension. When a
caller selects this option from a voice menu, a second
prompt, which must be recorded, should tell callers to
“Enter the extension number of the person that you
wish to speak with.” The system then tries to transfer
to the desired extension.
Note: Enter the Prompt number in the box labeled
“Phrase”.

Get Transfer Phone
Number

This option prompts the caller to enter a telephone
number to transfer to.
Note: Enter a prefix (may be required to grab an
outside line) in the box labeled “Prefix.”

LAP Current Monitor

When a caller selects this option, 6510 UM activates the
User's pager. The user may then pick up the call from
any telephone.

Page Current Mailbox

This option acts just like Post-Transfer Paging. When a
caller selects this option, they are placed on hold while
6510 UM makes an intercom page announcement.
After paging, the caller is transferred to the User's
extension. If the user does not take the call, the caller
will be transferred back to the voice menu.
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Send Predefined Fax

6510 UM system does not ask the user for the
document number of the FAX document to be sent
because the installer enters the document number (see
Additional Information below). 6510 UM prompts the
caller for their FAX machine number including area
code.
Additional information: Enter a FAX document number.
Enter a mailbox number in the box labeled "Mailbox."

Send Requested Fax

Allows users to send requested facsimiles.

Send to Directory

Callers may transfer themselves to a company directory
where they hear a listing of all employees. The caller
may then transfer him or herself to a particular
extension.

Send to Express
VoiceMail

This option permits callers to transfer directly to a
mailbox, hear the name greeting only, followed by a
beep for the caller to leave a message.
Note: Enter a mailbox number in the box labeled
“Mailbox.” Enter a language number in the box labeled
“Language.”

Send to Fax Start Tone This sends the call directly to the fax port and starts
receiving the fax with no instructions.
Send to FaxMail

This sends the call to the fax port and asks the caller to
press start on their fax machine when they hear the fax
tone.

Send to Login

Callers are allowed to access mailboxes to retrieve and
send messages. The caller is asked to enter the mailbox
number to be transferred to and then asked to enter
the mailbox password to retrieve messages.

Send to Mailbox

Allows callers to transfer themselves to the extension
associated with this option.
Note: Enter a mailbox number in the box labeled
"Mailbox".

Send to Main Greeting Transfers callers to the Company Main Greeting. This
option transfers callers back to the point where they
first called the 6510 UM system.
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Send to Menu

Use this option to transfer callers to another voice
menu. This option facilitates multi-level voice menus.
Every voice menu can have up to ninety-nine (99) submenus.
Note: Enter a menu number in the box labeled "Next
Menu".

Send to Operator

Transfers callers to the operator.

Send to Requested
Voice Mailbox

When you use this option, the 6510 UM system asks
the user for the document number of the FAX
document. The 6510 UM also prompts the caller for
their FAX machine number including area code.
Enter a menu number in the box labeled "Next Menu."

Send to VoiceMail

Use this option to play the no-answer greeting or gone
home greeting of the mailbox that the voice menu is
configured on. This option plays the greeting and then
a trailer message (MESS080.VOX) that informs the
caller to record the message after the tone and to press
# when finished for more options.

Send to VoiceMail and
Record after Tone

Use this option to go directly to the Beep to begin
recording a message in the mailbox that the voice menu
is configured on. This option does not play another
greeting before the caller hears the beep to begin
recording.
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PBX Template Parameters
The following PBX parameters are filled in automatically when you choose a PBX
template:

• Manufacturer
• Model
• Version
• PBX Extension Length Fixed
• PBX Extension Max Length
• Blind Transfer Code
• Supervised Transfer Code
• No Answer Release Code
• Busy Release Code
• Connect Code
• Hands Free Announce Code
• Call Pickup Code
• Conference Code
• Centrex Transfer Code
• Centrex Release Code
• Centrex Recall Code
• Hangup Code
• Hangup Delay Time
• Msg Light ON Code
• Msg Light OFF Code
• Inband Signaling Delay
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Actions
Below is a list of action commands you can define in a voice menu when
customizing call flows for callers.

Ask Password
The Ask Password action prompts the caller for a pre-defined static password
before it allows the caller to proceed to a defined sub menu. You define a static
password and the sub menu to take the caller once they are verified. The password
can be both numeric and alphanumeric.

Field

Function

Password

Pre-defined static password

Next Sub Menu

Indicates which sub menu to proceed to

Ask Pin Number
The Pin Number action prompts the caller to input their PIN number. On input, the
system will verify the number against the pin number table in the routing tables. If
verified, you can route the caller to a specific sub menu for custom processing.
When configuring this action you define the sub menu number to take the caller to
and the phrase you want played when prompting the caller to input a number.
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Field

Function

Next Sub Menu

Indicate which sub menu to proceed to

Phrase

The phrase you want the system to play
when prompting the caller to input
number
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Ask Question
This is used for a Q and A script. It enables you to ask the caller a question and
record their response. You can daisy chain several Q’s and A’s together as well as
define where and which mailboxes the answers should be recorded in.
You define the sub menu to take the caller once they answer the question, the
mailbox to record that specific question, and the number of questions that will be
asked so you can notate them together as one answer.

Beep Call Phone Number
This asks the caller to input their phone number. The system will then send this
number out to a pager.

Disconnect
This disconnects the caller from the call.

Get Destination from DB
This action is associated to the desktop call control active X. It asks the caller for
their number or pin code and sends the call information to the active X that has predefined actions and integration setup.
For more information, refer to the ACTIVE X configuration guide.

Send to Voice Menu
The Send to Voice Menu action sends the user to a completely different voice menu
for further processing. By default, it will take the caller to the first sub menu in the
new voice menu.
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Field

Function

Next Voice Menu

Indicates which next voice menu to
proceed to

Get Transfer Mailbox
The Get Transfer Mailbox action prompts the caller to input a mailbox the system
will transfer them to.

Field

Function

Phrase

A custom phrase that plays for the
request.

Get Transfer Phone Number
The Get Transfer Phone Number action prompts the caller for a phone number so it
can transfer the live call off site.
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Field

Function

Prefix

A preconfigured prefix that enables the
call or only request a 7 digit number.

LAP Current Mailbox
Sends a LAP (Local Area Page) to the mailbox that this voice menu is attached to.
Note: The user must have a lap pager and their lap setting configured in
their mailbox for this option to operate correctly. For more
information, refer to NNN on page X.

Page Current Mailbox
The Page Current Mailbox action activates the system to page the current mailbox
over the paging system that they have a call. It then waits 5 seconds and transfers
the call to the users extension.
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Field

Function

Mailbox

A specific mailbox that has been defined to
page over the intercom.
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Send Predefined Fax
The Send Predefined Fax action activates the system to send a fax document that
has already been defined. It will request the caller for a fax number and send the
document to the caller.
You would define the document number found in the fax library as well as the sub
menu to take the caller once the system sends the document.

Field

Function

Next Sub Menu

Indicates the next sub menu to proceed to

Send Requested Fax
The Send Requested fax action prompts the caller for a specific fax document and
fax number. Once completed, the system searches the fax library for a matching
document and sends it to the inputted fax number.
You can also define the sub menu to take the caller once the action is completed.
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Field

Function

Next Sub Menu

Indicates the next sub menu to
proceed to

Send to Directory
Sends the call to the company directory where users can either speak or enter the
user’s name they are searching for.

Send to Express VoiceMail
The Send to Express VoiceMail action defines a mailbox to send express messages
to. The caller hears the users name and a beep. With this action, you simply define
the mailbox to express message to.
You can define a mailbox and a specific language to service the caller
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Field

Function

Mailbox

The mailbox to send express
messages to

Language

Indicate the language to use to
service the caller

Send to Fax Start Tone
This sends the call to the fax board and the fax tone with no instructions.

Field

Function

Mailbox

Indicates the mailbox to send
message to
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Send to FaxMail
This sends the call to the fax board and leaves a fax message in the attached
mailbox.

Field

Function

Mailbox

The mailbox that you want the fax message
stored in.

Send to Login
This sends the caller into log in mode and request their user number and password
so that they can be logged into the system as a subscriber
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Field

Function

Mailbox

The mailbox to log this user into.
Note: If you specify a mailbox, it
will only request their password.

Send to Mailbox
Transfers the call to a defined mailbox. A mailbox can be a message center, an
outside phone number, or another user, depending on how the mailbox was
defined.
When sending to a mailbox, you can define the mailbox format to transfer.

Field

Function

Mailbox

Indicates the mailbox to send the
message to

Language

Specifies the language to use
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Send to Main Greeting
This action sends the call to the main greeting of the automated attendant.

Send to Operator
This action sends the call to the system defined operator or the personal operator
defined in the mailbox associated to this voice menu.

Send to Requested Mailbox
This action prompts the caller for a mailbox. Once entered, it takes the caller directly
to the active voice mail greeting for that mailbox.
Note: You can define a language to play back the greeting. The language
choice must be recorded by the user in order for it to operate
properly.

Send to Voice Menu
This action allows the user to be sent to a completely different voice menu for
further processing. By default, it will take the caller to the first sub menu in the new
voice menu.
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Field

Function

Next Sub Menu

Indicate the sub menu to proceed
to

Mailbox

Specifies the mailbox to send the
message to

No. Of Questions

Indicates the number of questions

Send to Requested Voice Mailbox
The caller is prompted for a mailbox. Once the caller inputs the mailbox number,
the system takes the caller directly to the active voice mail greeting for that mailbox.

Field

Function

Language

The language that plays back the greeting.
Note: The language choice must be
recorded by the user in order for it to
operate properly.
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Send to Sub Menu
A sub-menu can be defined within this voice menu to send the caller to for further
processing.

Field

Function

Next Sub Menu

Indicates the sub menu to proceed
to

Send to Voice Menu
The user is sent to a completely different voice menu for further processing. By
default, it will take the caller to the first sub menu in the new voice menu.
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Field

Function

Next Voice Menu

Indicates the next voice menu to proceed to

Send to VoiceMail
The caller is sent directly to the defined mailbox’s active greeting (the transfer
attempt is skipped).

Field

Function

Mailbox

Indicates the mailbox that the caller is to be
forwarded to for active greeting

Language

Language used to play back the greeting.
Note: The language choice must be
recorded by the user in order for it to operate
properly.

Send to Voice Mail and Record After Tone
This takes the call directly to the beep within a defined mailbox, skips the greeting,
and starts to record.
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Actions
The following actions can be mapped to each DTMF key in a customized mailbox.

Active Features
The Active Feature action lists all the active features that are turned on in the
mailbox.

Add Distribution List
The Add Distribution List action allows a user to create a distribution list.

Add Distribution List Member
The Add Distribution List Member action allows a user to add members to a
distribution list.

Add Notification Schedule
The Add Notification Schedule action allows a user to add a notification schedule
over the phone.

Append to Recorded Message
The Append to Recorded Message action allows a user to add another message to
an already recorded message.

Auto Forward Message
The Auto Forward Message action allows the user to preset a forwarding recipient
for all messages.

Autoplay
The Autoplay action automatically plays the messages sequentially without breaks.

Browse Folder
The Browse Folder action allows the user to select a folder to go to and listen to the
stored messages.
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Field

Function

Folder

Selects the folder in which the message is
kept.

Message Menu

Selects the message menu.

Cancel Message and Exit
The Cancel Message and Exit action allows the user to cancel the current recorded
message and exit the system.

Change Status
The Change Status action changes the user’s status from Logged in, Logged out,
Out of Office and other status options.

Clear Mass Recall
The Clear Mass Recall action resets the message recall notification.

Clear Numeric Password
The Clear Numeric Password action resets the numeric password to the default
(1111).

Clear Voice Password
The Clear Voice Password resets the voice password to the system default.
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Define Default Fax Address
The Define Default Fax Address action allows a user to define a default fax address
to send fax messages to.

Delete Distribution List Member
The Delete Distribution List Member action allows a user to delete a member from a
distribution list.

Delete Distribution List
The Delete Distribution List allows a user to delete a personal list.

Delete Message
The Delete Message action allows a user to delete active message they are listening
to.

Delete Notification Schedule
The Delete Notification Schedule allows a user to delete a notification schedule.

Disconnect
The Disconnect action disconnects the session and hangs up.

Forward Message
The Forward Message action prompts the user for a mailbox to forward a message
to as well as to turn it on or off.

Listen Distribution List
The Listen Distribution List plays back the active distribution list you are editing.

Listen Notification Schedule
The Listen Notification Schedule plays back the active notification schedule you are
editing or creating.

Listen Numeric Password
The Listen Numeric Password action plays back your numeric password.

Listen to Messages
The Listen to Messages action plays back the message-voice fax or e-mail.
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Field

Function

Folder

Selects the folder to listen to messages

Message Menu

Selects the message menu

(Flag) Ask

Flags asked message

(Flag) Unread

Flags unread message

(Flag) Read

Flags read message

(Type) Ask

Indicates type as ask message

(Type) E-mail

Indicates type as e-mail message

(Type) Fax

Indicates type as fax message

(Type) Voice

Indicates type as voice message

Listen Voice Password
The Listen Voice Password action plays back the voice password.

Mark Message As Unread/Read
The Mark Message As Unread/Read action allows the user to mark a message as
read or unread.
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Modify Distribution List
The Modify Distribution List action allows users to edit a specific list.

Modify Notification Schedule
The Modify Notification Schedule action allows user to edit a notification schedule.

Move Message to Another Folder
The Move Message to Another Folder action allows a user to move a message to a
user-selected folder.

Field

Function

Folder

Indicate the folder to which the
message is to be moved to

Record Busy Greeting
The Record Busy Greeting action allows you to record the busy greeting prompt.

Record DND Greeting
The Record DND Greeting action allows you to record the “Do Not Disturb”
greeting.

Record Gone Home Greeting
The Record Gone Home Greeting action record the greeting that is activated when
the user activates their gone home status.

Record Lunch Greeting
Record the greeting that is activated when the user activates their Lunch status.
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Record Meeting Greeting
Record the greeting that is activated when the user activates their Meeting status.

Record Name Prompt
Record the mailbox user name that is used in the directory and transfer options.

Record Optional Greeting
Record an optional greeting which users can turn on or off manually in substitute of
their general no answer greeting.

Record Out of Town Greeting
Record the greeting that is activated when the user activates their Out Of Town
status.

Record Personal Greeting
Record the greeting that is used to greet the caller when the user does not answer
the call.

Record Vacation Greeting
Record the greeting that is activated when the user activates their On Vacation
status.

Reply Message
The reply message given to callers.

Rerecord List Name
The Rerecord List Name action allows the user to rerecord a distribution list name.

Return to Auto Attendant
Returns caller to auto attendant.

Review Distribution List Members
The Review Distribution List Members action allows the user to review all members
that are on the distribution list.

Review List Name
The Review List Name action allows the user to review the distribution list name.
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Review Recorded Message
The Review Recorded Message action allows the user to review the message that
has been recorded.

Review Message
Reviews the read message.

Save Recorded Message in Draft and Exit
Send a Message
Sends a message.

Send Recorded Message
Sends the recorded message.

Send Recorded Message as Certified and Private
Sends the recorded message and marks it as certified and private.

Send Recorded Message as Certified and Urgent
Sends the recorded message and marks it as certified and urgent.

Send Recorded Message as Private
Sends the recorded message and marks it as private.

Send Recorded Message as Urgent
Sends the recorded message and marks it as urgent.

Send Recorded Message as Urgent and Private
Sends the recorded message and marks it as urgent and private.

Send Recorded Message as Urgent, Private, and Certified
Sends the recorded message and marks it as urgent, private, and certified.

Send to Tutorial
Sends the user to the tutorial.
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Send to Sub Menu
Sends the user to a defined submenu in the customized TUI with more actions

Field

Function

Next Sub Menu

Indicate the sub menu to proceed
to

Sub Menu Type

Indicate the sub menu type

Set Active Greetings
Allows you to activate what greeting to play in a ring no answer condition

Set Numeric Password
Allows user to set their numeric password with a confirmation of the change or
creation

Set Voice Password
Allows the user to create and set your voice password

Set Wakeup Call
Allows the user to define a time and date as well as snooze intervals so the system
will call you to wake you up

Skip
This function skips the current message to the next
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Skip to Next Message Without Changing Read Status
Skips user to the next message without changing the status of the already read
message.

Skip to Previous Message
Skips user to the previous message.

Skip to Previous Message without Changing Read Status
Skips user to the previous message without changing the status of the already read
message.

Time and Date Stamp
Plays back the time and date information of the current mailbox

Transfer to Mailbox
Transfers the user to the mailbox.

Transfer to Operator
Transfers the user to the operator.

Toggle Certified Flag
Toggles message and flags it as certified.

Toggle Mass Recall
Toggles message and flags it for mass recall.

Toggle Private Flag
Toggles message and flags it as private.

Toggle Urgent Flag
Toggles message and flags it as urgent.

Turn Call Forwarding On/Off
Turns the forwarding action on or off based on the active status

Turn Call Queuing On/Off
Turns Queuing action on or off based on the active status
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Turn Call Screening On/Off
Turns the call screening action on or off based on the active status

Turn Notification Schedule On/Off
Turns the notification schedules on or off based on the active status

Turn Post Paging On/Off
Turns the post paging action on or off based on the active status

Turn Pre Paging On/Off
Turns the pre paging action on or off based on the active status
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Actions
The following actions allow you to adjust and personalize the volume and message
play speed of the system.

Softer
Allows you to use the drop-down list to select a softer volume setting.

Field

Function

Volume Scale

Defines the volume setting

Normal Volume
Allows you reset the volume to its default setting.

Louder
Allows you to use the drop-down list to select a louder volume setting.
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Field

Function

Volume Scale

Defines the volume setting

Slower
Allows you to use the drop-down list to adjust the message play to a slower pace.

Field

Function

Speed Scale

Defines the speed setting

Normal Speed
Allows you to reset the message play speed to its default setting.

Faster
Allows you to use the drop-down list to adjust the message play to a faster pace.

6510 UM Server Configuration Guide

425

Appendix F

Field

Function

Speed Scale

Defines the speed setting

Fast Forward
Allows you to define the speed at which the system should fast forward messages
(in milliseconds).
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Field

Function

Fast Forward Time

Specifies fast forward speed
settings
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Rewind
Allows you to define the speed at which the system should rewind messages (in
milliseconds).

Field

Function

Rewind Time

Specifies rewind speed settings

Pause
Allows you to set the parameters for the pause time of each message (in
milliseconds).

Field

Function

Pause Time

Specifies the pause time
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WORKSHEETS
Before beginning the installation of 6510 UM, ensure that the pre-installation
worksheets provided are completed. These worksheets help to verify telephone
system parameters, prepare the User Directory, identify company business hours,
write scripts for the company greetings, and specify the features for most Users.

A. TRANSFER PARAMETERS
Transfer options are located in properties for the PBX under the Transfer Tab.

Blind Transfer
Protocol:
Default: &,

Supervised
Transfer Protocol:
Default: &,

No Answer
Release
Default: &,

430

Sequence to place caller on Hold and perform a blind
transfer - This parameter instructs 6510 UM on the
sequence it should follow to place a caller on hold
before attempting a transfer to the operator. If this
parameter is left blank, the setting in parameter 162
(sequence to place caller on hold) will be used. The
following Special Characters may be used (& - Flash
Hook and , - Pause).

Enter the Value

Sequence to place caller on Hold and perform a
supervised transfer - This parameter instructs 6510 UM
on the sequence it should follow to place a caller on
hold before attempting a transfer. The following
Special Characters may be used (& - Flash Hook and , Pause).

Enter the Value

Sequence to return to caller in the event of a noanswer. - This parameter instructs 6510 UM on the
sequence it should follow to get a caller back when it
encounters a no-answer condition. The following
Special Characters may be used (& - Flash Hook and , Pause).

Enter the Value
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Busy Release
Default: &,

Handsfree
Announce
Protocol
Default: <blank>
Default Rings

Sequence to get caller back in the event of a busy - This
parameter instructs 6510 UM on the sequence it should
follow to get a caller back when it encounters a busy
condition. The following Special Characters may be
used (& - Flash Hook and , - Pause).

Enter the Value

Sequence to connect a call - If your telephone system
requires a connect code (a code that must be dialed
when connecting a transferred call), here is where you
would define it. The following Special Characters may
be used (& - Flash Hook and , - Pause).

Enter the Value

Number of rings before system returns a no answer.

Enter the Value

Default: 3

here:__________

here:__________

here:__________

B. MESSAGE LIGHT PARAMETERS
Message Light Parameters are located in the PBX properties under the Message
Lights Tab.
Message Light
ON Code

This is the dialing string to activate the message waiting
lamp. Place an E where the Extension number would be
in the string.

Enter the Value

This is the dialing string to deactivate the message
lamp. Place an E where the Extension number would be
in the string.

Enter the Value

here:__________

Example:
#09E
(AT&T Partner II)
Message Light
OFF Code:
Example:
#10E

here:__________

(AT&T Partner II)
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C. PAGING PARAMETERS
Paging Parameters are located in the properties for the Company under the
Advanced Tab.
Paging Access
Code

This is the sequence to place a caller on hold and access
the intercom paging system, if applicable.

Enter the Value

Paging Release
Code

This is the sequence to get the caller back after
performing intercom paging, if applicable.

Enter the Value

Paging Delay

This is the time the system will wait after paging before
the call will be transferred.

Enter the Value

here:__________

here:__________

here:__________

D. CALL OPTIONS PARAMETERS
Call Option Parameters are located in the properties for the Company under the
Call Options Tab.
Minimum
Message Length

Identifies the minimum message length for messages, in
seconds.

Default: 0
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E. FEATURE GROUP PARAMETERS
Ask for Password: When the user accesses their mailbox, a password is
required to access messages and features. This
parameter activates the password protection.

Enter the Value
here:__________

Note: This parameter is also used for SMDI.

F. INBAND SIGNALING PARAMETERS
Inband Parameters are located in the Properties for the PBX under the Inband Tab.
Integration=
Normal

Tells 6510 UM that the telephone switch being
integrated uses inband signaling.

Enter the Value

The time that 6510 UM waits to hear incoming inband
signals. If no signals are heard in this time, 6510 UM
forwards to the Main Greeting. Value is specified in
miliseconds.

Enter the Value

Identifies the maximum number of digits that the phone
switch will send.

Enter the Value

The number of digits sent to identify the incoming C.O.
line.

Enter the Value

here:__________

Default: Normal
Inband Signaling
Delay
Default: 2000

Inband Maximum
Digits

Here:__________

here:__________

Default: 10
C.O. Digits
Length

here:__________

Default: 2
Caller ID Length

The number of digits sent in Caller ID for inband calling. Enter the Value

Default: 10
Login

here:__________
The code sent by the switch to automatically Login to a
mailbox to access messages and features. This is also
known as “Auto Station Login".
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No Answer

Busy

C.O. Call

Invalid

The inband signal sent by the telephone switch to
indicate a no-answer condition on an internal call. This
code will tell 6510 UM to send the caller to the Mailbox
Greeting.

Enter the Value

The inband signal sent by the telephone switch to
indicate a busy condition on an internal call. This code
will tell 6510 UM to send the caller to the Mailbox
Greeting.

Enter the Value

Identifies What C.O. line that an inbound call has come
in on. This code is only used for switches that have C.O.
line identification.

Enter the Value

The code that forces 6510 UM to go on hook. If your
phone switch sends ‘garbage’ codes to 6510 UM to
check line status, you may enter these codes here to
indicate a hang-up condition.

Enter the Value

Not Defined

here:__________

here:__________

here:__________

here:__________

Enter the Value
here:__________

Refresh Message
Lights
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G. USER DIRECTORY

MBX #

EXT

Feature
Group
Last Name

First Name

Department

NOTE: Make photocopies of this page if more Users are required.
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H. BUSINESS HOURS
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I. COMPANY GREETINGS SCRIPT
DESCRIPTION

PROMPT #

WRITTEN SCRIPT
** (Be sure to get all scripts approved before
recording)

Morning Greeting
(Midnight to Noon).

Afternoon Greeting
(Noon to 6PM)

Evening Greeting
(6PM to Midnight)

Closed Greeting
(When Business Hours
= Closed)

NOTE: If the company is only open until 5:00 PM, the Closed Greeting
begins to play at 5:00 PM. The Evening Greeting is never
played.
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J. MAILBOX FEATURE GROUP
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Note: Make photocopies of these pages if required.
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K. VOICE MENU WORKSHEETS
Use the worksheets below to design your voice menus.
Menu #

Option

Password

Next
Menu

Mailbox

Question

Prompt

1
2
3
4
5
6
7
8
9
0
#
*
D

Phrase/Question # ______:
_______________________________________________________________________
_______________________________________________________________________
_______________________________________________________________________
_______________________________________________________________________

Note: Photocopy this page if more sheets are required.
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